
Merumahkan
Linux Knoppix

di Komputer.
Panduan instalasi

yang mudah
dipahami

Membuat
CD-DA dari
Audio-DVD

Video. Bagaimana
melakukannya?
Apa yang perlu

diperhatikan?

Amunisi Siemens
untuk Gelontor

Pasar MMS. Apa
saja andalannya?

Apa saja fitur-
fiturnya?
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Harga Rp. 4.800,- (Pulau Jawa), Rp. 5.300,- (Luar Jawa)
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PCplus
TABLOID KOMPUTER

EDITORIAL ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

CD PCPLUS LENGKAP
Dear Redaksi PCplus,

bagaimana caranya untuk
mendapatkan CD PCplus yang isinya
merupakan kumpulan-kumpulan
edisi PCplus dari edisi awal hingga
yang paling akhir. Berapa biayanya?
Tolong konfirmasi ya, saya sangat
mebutuhkan CD-CD tersebut.
Terima kasih.

Konsumen
cloudstifer@yahoo.com

Red: Silakan hubungi Bagian
Langganan PT Prima Infosarana Media
(penerbit PCplus) di 021-5483008 ext
3773/3704 atau di langganan@
infokomputer.com untuk
mendapatkan apa yang Anda
butuhkan.

WORKSHOP
LINUX+WINDOWS

Dear Redaksi PCplus, kapan ya
diadakan lagi workshop merakit PC
dan menginstal dual operating
system; Linux+Windows di Jakarta?
Soalnya saya tidak sempat
mengikuti satupun workshop-
workshop sebelumnya (nyeseeelll
banget saya..). Apa bulan November
ini or Desember akan diadakan lagi?
Terima kasih & jaya selalu PCplus!!!
Salam.

James S
bagagmen@yahoo.com

Red: Untuk tahun 2003, workshop
sudah tidak ada lagi mengingat tinggal
2 bulan lagi tutup tahun. Untuk tahun
2004, Bagian Promosi PCplus sedang
menyusun jadwal programnya. Apabila
sudah selesai, kami akan beritahukan
kepada pembaca budiman semuanya.

KECEWA CD PCPLUS
Saya atas nama A. Musa W.,

yang telah mengirim uang ke
rekening BCA (PT Prima Infosarana
Media) untuk mendapatkan CD I
dan CD II (sebanyak 2) kurang lebih
2 bulan lalu sampai saat ini belum
menerima kiriman CD tersebut,
yang saya alamatkan ke Jl. Perintis
Kemerdekaan (STMIK
DIPANEGARA).

Saya saat ini sangat kecewa
dengan pelayanan yang diberikan
oleh PCplus  mengenai permintaan
CD lewat rekening, duitnya sudah
terkirim, tetapi belum juga ada
kiriman yang saya terima,
konfirmasi dong....mengenai CD I
dan CD II ke kami supaya kami
tahu? Saya kecewa berat... atau ke
mana lagi saya akan adukan
masalah ini. Tolong secepatnya.

Achmad Musa
STMIK Dipanegara

Makassar

Red: Maaf atas ketidaknyamanannya
Bung Achmad. Sayangnya, Anda tidak
mengirimkan faksimili bukti kiriman itu
ke Bagian Layanan Pelanggan kami.
Anda sudah kami hubungi kembali
supaya permintaan Anda bisa kami
proses. Sekali lagi, kami minta maaf atas
kejadian ini.

PLUSWIRELESS DAN KUPON
PCPLUS

Saya ingin mengucapkan
selamat ulang tahun yang ke-3
untuk PCplus. Selamat juga atas
keputusannya untuk memakai
kertas HVS pada Tabloid PCplus, dan
dengan bijak menengahkan
permintaan pembaca yang pro dan
kontra terhadap rubrik plusPonsel
yang sekarang diubah dengan
nama plusWireless.

Sedikit usulan juga tentang
rubrik plusWireless yang baru
muncul, adakah rencana PCplus
untuk juga mengulas selain
teknologi smartphone, seperti
misalnya handhelds lain (PDA
dengan berbagai kelengkapannya
seperti fitur phone, GPRS,
Bluetooth, WiFi dan lain-lain)
beserta operating system-nya yang
muncul dengan berbagai platform
seperti Palm, Pocket PC, maupun
Symbian. Karena hal tersebut juga
mengarah ke jaringan wireless
dengan segala kecanggihannya.

Dan mudah-mudahan
pembahasan tersebut juga dapat
memicu para developer lokal untuk
ikut mengisi berbagai kontent dan
aplikasi pada perangkat-perangkat
mobile yang sekarang makin marak
karena kemampuannya yang tidak
kalah dengan PC.

Yang kedua ingin saya
tanyakan juga bagaimana cara
mendapat CD PCplus yang berisi
bundel PCplus pada ultah yang
ketiga ini, seperti 2 CD edisi lalu,
saya telah mengumpulkan kupon-
kupon pada 4 edisi sebelumnya dan
telah dikirim ke Redaksi. Namun
apakah dengan mengirim kupon-
kupon tersebut otomatis akan
mendapat CD PCplus yang ketiga
ini? Sebab saya sudah
mengumpulkan 2 CD sebelumnya
untuk mendapat bundel PCplus
dalam format digitalnya agar
gudang di rumah saya dapat sedikit
berkurang kesesakannya.

Terima kasih atas perhatian
rekan-rekan Redaksi. Sekali lagi saya
ucapkan selamat ulang tahun yang
ke-3 untuk PCplus dan semoga
bertambah maju dan lengkap
dalam hal konten serta artikel yang
dibahas. Selamat menunaikan
ibadah puasa kepada rekan-rekan
yang menjalankannya. Salam
sejahtera.

Ricky Venansius
ricky1302@yahoo.com

Red: Terima kasih atas usulannya
tentang rubrik plusWireless. CD PCplus
seri ke-3 ini tidak dapat ditukar dengan
kupon, karena kupon hanya ditujukan
untuk mengikuti kuis gebyar hadiah.
Bila Anda berminat memilikinya, silakan
membelinya di toko buku terdekat di
kota Anda.

KATALOG CD
Iklan yang dimuat di PCplus

beberapa edisi lalu mengenai
penawaran CD Program free/
shareware, edutainment, interaktif,
dan lain-lain yang mana banyaknya

e-mail/SMS telah kami terima dan
telah kami kirim juga katalognya
kepada semua peminat.

Namun dari semua e-mail
yang kami terima ada beberapa e-
mail dari Anda yang belum sempat
kami reply beserta katalognya
karena beberapa hal. Untuk itu,
melalui plusMail ini kami ingin
memberitahukan kepada Anda
yang merasa belum menerima
kiriman katalog CD dari kami
untuk dapat mengirim kembali
alamat e-mail Anda kepada kami
(kecuali yang via SMS), untuk
dapat segera menerima katalog
CD dari kami. Buat PCplus terima
kasih banyak dan selamat ulang
tahun yang ke-3.

Cepi Indra
galeriku@hotmail.com

Red: Thanks ucapan selamat ultahnya.

FREEWARE/SHAREWARE
Tanggal 30 Okt 2003, saya

membaca PCplus edisi 150. Selintas
saya membaca surat pembaca,
saya tertarik dengan komentar
Woro Srikandi (or whoever you
are...). Anda setuju dengan konsep
freeware? Sejauh apa Anda
menyukai freeware? Apakah
untuk coba-coba atau sebagai
pengganti program standar yang
sudah ada di Windows? (all
versions or Linux any release).

Jika Anda memang
menggunakan freeware yang
tersedia banyak sekaleee... di
Internet untuk mengganti
program standar bawaan OS
Anda, maka kami akan dengan
senang hati membantu Anda
memperoleh freeware tersebut
dari Internet gratis! (Ya, gratis!!)
(note: tidak ada embel-embel
biaya apapun or whatever...) Kok
bisa? Ya bisa dong....Kami memiliki
database sekitar 18.000 (!!)
freeware/shareware/demo/full
version/anyware sejak 1997s/d
2003 dalam harddisk kami.
Sekarang menjadi charity project
di kelompok kami. Kalau Anda
butuh program tertentu yang
ukurannya amit-amit besarnya dan
menyebabkan biaya Internet
membengkak, kirim e-mail ke
kami dan kami akan kirimkan ke
Anda freeware tersebut dalam
bentuk CD sekali lagi untuk
dibaca: .....gratis....dan dijamin
bebas virus/trojan/backdoor/
spyware/keylogger....... Hear this:
We share because we care.... Pilih
program mana yang Anda mau di
Internet, versi dan alamatnya
kalau perlu file size-nya (supaya
tidak salah tunjukkan ke kami
alamat website resminya...) OK?
Don't be worried, we are not bad
guys, we just wanna help you
all....This a charity project only,
nothing personal....Greetz,

On behalf of TSRh council ReaL|sTy
copyleft2k3@hotmail.com

Red: Ada yang tertarik?

Proyek Digital dan Lebaran!

Maafkan kami! Lantaran
informasi tentang buku kedua
PCplus, “Langkah Mudah
Optimalisasi Windows” sudah kami
informasikan ketersediaannya di Toko
Buku Gramedia melalui tabloid ini, ada
beberapa pembaca yang kemudian
sepulang kerja di hari Selasa minggu lalu
(11/11) langsung menuju ke Toko Buku
Gramedia di bilangan Matraman, Jakarta.

Singkat cerita, ternyata buku belum
ada dan akhirnya pembaca tersebut
mengungkapkan uneg-unegnya
kepada PCplus! Maafkan kami!
Kami merasa bersalah karena
oleh bagian pemasaran kami,
buku tersebut ternyata baru didistribusikan di
toko-toko buku pada hari Rabu (12/11). Entah berapa puluh orang
yang mengalami hal serupa. Informasi yang terlalu dini kami sampaikan
membuat pembaca kecewa.

Sekarang, buku itu sudah benar-benar bisa Anda peroleh di TB
Gramedia manapun di seluruh Indonesia. Dalam waktu tak lama, toko-
toko buku yang lainnya pun bakal menjual kumpulan trik dan software
terbaik pilihan PCplus tersebut. Mudah-mudahan di beberapa agen koran
pun buku tersebut bisa Anda dapatkan.

Lain lagi soal plusFokus kali ini. Tema “Lebaran Digital” kami pilih
lantaran inilah edisi di mana kami akan terbit dalam jangka waktu cukup
lama, 2 minggu. Selama dua minggu tersebut, tentu Anda disibukkan
dengan urusan mudik dan sungkem ke kerabat dan orang tua, atau
mengunjungi objek-objek wisata. Oleh karenanya, kami sajikan untuk
Anda cerita tentang Lebaran digital. Anda pun bisa mengemas dan
membuatnya sendiri, menjadikan Lebaran kali ini jadi lebih punya arti
ketimbang sebelumnya.

Kalau mau lebih lengkap, plusFokus dua edisi PCplus (152 dan 153)
terakhir sebaiknya Anda simak dan baca baik-baik karena merupakan
suatu rangkaian, supaya Lebaran Anda benar-benar terasa digitalnya.

Di halaman lain, kami tampilkan ulasan tentang Knoppix yang banyak
ditanyakan oleh pembaca, baik melalui telepon, e-mail, milis, maupun
faksimili. Mudah-mudahan Anda benar-benar terpuaskan dengan ulasan
yang satu ini.

Pendek kata, kami ingin membuat Lebaran Anda tidak lagi terbebani
dengan urusan-urusan pertanyaan dan keribetan seputar komputer
Anda. Lebih dari itu, kami berharap panduan yang kami suguhkan
benar-benar membuat Lebaran kali ini terasa lebih istimewa.

Selamat berlebaran, Minal Aidin Wal Faidzin.

        Salam hangat dari Palmerah
Redaksi



Canon Hadirkan Proyektor
Terbaru untuk Kelas Mid End. Ada
tiga anggota baru di jajaran proyektor LCD Canon – Canon LV-
7215, LV-7210 dan LV-5210. Ketiga proyektor ini baru diluncurkan
Canon pada pameran Infocom-Asia, di Singapura, tanggal 29-31
Oktober 2003. Canon LV-7215/7210 merupakan proyektor model
XGA dengan resolusi 1024 x 768 dpi, sementara LV-5210
merupakan model SVGA dengan resolusi 800 x 600 dpi.

Bobot ketiga proyektor ini 2,9 kg, mudah dibawa ke mana
pun. Dengan adanya teknologi 0,8” TFT LCD x 3 panel dan 1,6x
lensa zoom manual, tampilan proyeksi bisa tampak lebih
sempurna. Canon menyediakan DVI-I input terminal dan D-sub
terminal (RGB analog in/out) untuk koneksi ke komputer atau
perangkat lain seperti HDCP dan DVD player, serta kabel DVI-VGA
untuk mendukung proses transfer data. Proyektor-proyektor
ini juga mampu menerima tiga jenis kartu opsional – kartu
memori CompactFlash LV-WN03, kartu Wireless LAN, dan kartu
Wired LAN. (raa)

Intel Akuisisi Produsen Chip
WLAN, Mobilian. Dalam situsnya,
www.mobilian.com, Mobilian mengumumkan bahwa aset-
asetnya telah diakuisi dan untuk seterusnya Mobilian tidak akan
melanjutkan bisnisnya secara independen. Intel telah membeli
aset-aset perusahaan pengembang chip jaringan nirkabel yang
kurang dikenal ini. Orang terakhir yang menjabat sebagai CEO
Mobilian adalah Manpreet Khaira, seorang mantan pegawai Intel.

Mobilian telah menciptakan TrueRadio, chipset yang
menawarkan konektivitas nirkabel 802.11b dan Bluetooth dengan
jangkauan frekuensi 2,4GHz. Chipset ini ditujukan bagi para
pembuat kartu PC dan vendor-vendor komputer atau PDA yang
ingin melengkapi produknya dengan dua teknologi tersebut.
TrueRadio terdiri dari dua chip dengan inti ARM7TDMI.

Masih belum jelas apa yang akan Intel lakukan terhadap aset-
aset Mobilian. Saat ini, platform Intel Centrino telah mendukung
802.11b dan dual-band 802.11a/b, sedangkan Bluetooth masih
belum termasuk sebagai spesifikasi di dalamnya. (raa)

Renesas Siapkan Kartu
CompactFlash 1GB Tercepat. Renesas
Technology, perusahaan semikonduktor hasil joint venture antara
Hitachi dan Mitsubishi Electric, telah membuat sampel kartu
memori CompactFlash (CF) yang menurut mereka memiliki
kecepatan menulis tercepat dibandingkan CF lain yang beredar di
pasaran. Nama kartu ini cukup susah - HB28J1000CCC, memiliki
memori sebesar 1GB dan mendukung kecepatan menulis data
hingga 10MB per detik. Renesas merencanakan peluncuran
CompactFlash ini pada awal pertengahan tahun 2004. Harga yang
ditawarkan bagi end-user adalah sekitar US$310. (raa)

Fedora, Produk Pengganti Red
Hat Linux. Red Hat Inc., perusahaan pengembang
aplikasi Open Source Red Hat, memutuskan untuk melebur produk
gratis Red Hat Linux dengan Fedora Linux. Red Hat memang
mensponsori proyek Fedora, tetapi tidak memberi dukungan
teknis untuk proyek tersebut. Proyek Fedora merupakan proyek
pengembangan Linux yang dilakukan secara terbuka oleh
komunitas.

Produk gratisan Red Hat Linux akan berhenti sampai versi 9.0.
Dukungan Red Hat untuk Red Hat Linux versi 7.1, 7.2, 7.3, dan 8.0
akan dihentikan pada akhir tahun ini, sedangkan dukungan untuk
versi 9.0 baru akan dihentikan bulan April 2004. Untuk selanjutnya,
Red Hat hanya akan mengembangkan Red Hat Enterprise Linux,
versi Red Hat untuk kalangan perusahaan. Tetapi para pengguna
Red Hat Linux tak perlu khawatir, sebab mereka bisa beralih ke
Fedora, yang juga dikembangkan oleh komunitas pendukung Red
Hat. (raa)

KCM Sediakan Layanan Bisnis
Berbasis Internet. Awalnya Kompas Cyber Media
(KCM) hanya merupakan situs yang berisi berita saja. Sekarang
KCM mulai mengembangkan usahanya di bidang multimedia dan
layanan Internet. SMS 5003 merupakan salah satu layanan
berbasis Internet yang baru diluncurkan oleh KCM. Saat ini layanan
ini baru bisa dinikmati oleh para pelanggan Satelindo dan IM3.

Melalui SMS 5003, pengguna bisa memperoleh berita nasional
maupun metropolitan secara aktual dan terpercaya. Pengguna
hanya perlu mengetikkan kode layanan yang dimaksud, kemudian
mengirimnya ke nomor 5003. Sebagai contoh, ketik NAS untuk
memperoleh berita nasional atau MET untuk berita metropolitan.
SMS 5003 juga menyediakan ragam informasi lainnya seperti
olahraga, musik, film dan TV, gaya hidup, serta horoskop. Untuk
layanan ini, para pengguna harus membayar sebesar Rp 700,- per
SMS. (raa)
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Google Tambahkan Desktop Searching bagi
Penggunanya. Mesin pencari raksasa Google mengumumkan penambahan software
gratisan Google Deskbar, yang memungkinkan para pengguna Windows untuk melakukan searching
Web dan aplikasi tanpa perlu membuka browser. Deskbar tampak seperti jendela inset kecil pada
taskbar Windows. Selama komputernya terhubung dengan Internet, user bisa melakukan pencarian
tanpa perlu meninggalkan task pada desktop-nya.

Shortcut keyboard disediakan untuk memudahkan user dalam melakukan lebih dari satu
pencarian. Sebagai contoh, user bisa mengetik “Ctrl+N” untuk Google News, “Ctrl+I” untuk Google
Images, atau “Ctrl+F” untuk Froogle. User juga bisa mengetikkan “Ctrl+Alt+G” untuk mengakses
Google dari aplikasi manapun. Deskbar bisa berjalan di atas sistem operasi Window 98, ME, 2000, atau
XP dan Internet Explorer versi 5.5 ke atas. (raa)

SiS Luncurkan R659. R659 adalah chipset berbasis Rambus
DRAM (RDRAM) kedua yang diproduksi oleh SiS. Sebelumnya, SiS telah
meluncurkan R658 pada bulan Juli 2002. R659 mendukung PC1200 direct
RDRAM dan memiliki bandwidth memori 9,6GB per detik untuk sistem yang
menggunakan memori RDRAM 1.200MHz empat kanal. R659 akan
berpasangan dengan south bridge chip SiS 964 untuk mendukung delapan USB
2.0 port dan arsitektur Serial ATA (SATA). SiS mengharapkan penjualan chipset
ini bisa meraih angka 100.000 unit pada tahun 2004 mendatang.

SiS juga akan memroduksi chip untuk I/O Xbox. Chip ini rencananya akan digunakan untuk
mendukung console Xbox Microsoft. Saat ini, SiS sendiri belum memutuskan siapa yang akan
memroduksi chip ini. (raa)

Teknologi Pendingin “Wise Fan II”
Albatron Hadir dalam FX5950UV. Albatron
Technology Co. LTD. Telah memperkenalkan GeForce FX5950UV, kartu grafis
yang mengusung GPU Nvidia FX 5950 Ultra (NV38). Selain menawarkan memori
256MB DDR 2.2ns berkecepatan 950MHz dan kecepatan clock sebesar 475MHz,
kartu grafis ini juga mengusung teknologi pendingin dengan tiga kipas dari
Albatron – Wise Fan II.

Wise Fan II merupakan versi upgrade dari Wise Fan. Pada Wise Fan, dua
kipas utama selalu aktif sementara kipas ketiga berfungsi sebagai cadangan jika terjadi kerusakan
pada salah satu kipas utama. Sedang pada Wise Fan II, kipas ketiga akan aktif bila suhu GPU mencapai
560C. Albatron menekan noise kipasnya hingga sekitar 25dBA, hampir 10 dBA lebih kecil dibanding
kipas-kipas yang ada di pasaran. Kartu ini juga dilengkapi dengan heat sink tembaga dan aluminium
untuk memaksimalkan penyerapan dan pembuangan panas. (raa)

Office 2003 Dapatkan Critical Update Pertamanya.
Tanggal 5 November, kurang dari satu bulan sejak peluncuran Office 2003, Microsoft mengumumkan
critical update pertama untuk aplikasi tersebut. Update tersebut ditujukan untuk memperbaiki
masalah yang terjadi setiap kali user membuka atau menyimpan file PowerPoint 2003, Word 2003, atau
Excel 2003 yang mengandung elemen “OfficeArt” yang diubah atau disimpan dalam versi Office
sebelumnya. OfficeArt merupakan fitur dalam Office yang memungkinkan user merancang efek tiga
dimensi, bayangan, file dengan banyak warna, tekstur, dan kurva Bezier.

Versi Office sebelumnya bisa melakukan perubahan terhadap file Office 2003. Masalah akan
terjadi bila file yang sudah diubah tadi dibuka pada aplikasi Office 2003. File tersebut bisa tidak
terbuka secara utuh – ada bagian yang hilang, file bisa saja rusak, atau muncul pesan error. Update
tersebut sudah bisa di-download dari situs resmi Microsoft. (raa)

Sony Tunjukkan PlayStation Portabelnya. Untuk pertama
kalinya Sony memperlihatkan konsep rancangan PSP, game portabel dan terminal multimedia yang –
menurut Sony – merupakan “Walkman abad XXI”. Rancangannya berbentuk empat persegi panjang
dengan tampilan layar flat yang mendominasi bagian depannya. Pada sisi kanan display terdapat
empat tombol kontrol untuk bermain game, sedang pada sisi kiri terdapat kontrol navigasi up/down/
left/right. Tombol power juga terdapat di bagian depan.

Rencananya, PSP akan dilengkapi dengan layar lebar TFT LCD 4,5 inci dengan resolusi 480 x 272
pixel, grafik 3D, dukungan terhadap video MPEG4, dan sebuah port USB 2.0. Player ini juga akan
menggunakan format media baru yang disebut UMD (Universal Media Disc). Optical disk 2,4 inchi-nya
mampu menyimpan hingga 1,8GB data. PSP akan diluncurkan pada musim liburan tahun 2004. Detil
mengenai rancangan final perangkat ini akan diberikan menyusul. (raa)

VIA Luncurkan Chipset Dual Kanal untuk Prosesor
Intel Pentium 4. VIA PT880 memanfaatkan teknologi kontroler memori DualStream64,
sistem penyimpanan dan konektivitas yang mendukung Serial ATA dan V-RAID. Chipset ini merupakan
anggota terbaru dari keluarga VIA yang memiliki solusi core-logic berperforma tinggi yang ditujukan
untuk mendukung prosesor Intel Pentium 4.

VIA PT880 sudah dipilih oleh vendor-vendor motherboard terkemuka seperti ASUS, ABIT, Aopen,
Elitegroup (ECS), Gigabyte dan MSI untuk melengkapi produk high-end mereka. VIA juga melengkapi
chipset ini dengan memori dual kanal DDR400, 800MHz FSB, teknologi Hyper-Threading, dan AGP8X.

Kontroler memori DualStream64 sendiri merupakan teknologi VIA yang bertujuan untuk
menyediakan akses cepat bagi memori sistem untuk melakukan tugas paralel, seperti menjalankan
aplikasi 3D atau multimedia. Bandwith memorinya mencapai besar hingga 4.800MB per detik. Jika
dikombinasikan dengan south bridge VIA VT8237, PT880 bisa mencapai fleksibilitas sistem maksimal
dengan cakupan fitur penyimpanan, multimedia dan konektivitas terbaik bagi prosesor Intel Pentium
4. (raa)

SiS Tingkatkan Produksi Chipset K8. SiS akan meningkatkan
produksi chipset K8, chip GbE PHY (physical layer) dan chip jaringan-nya pada perusahaan manufaktur
United Microelectronics Corporation (UMC). Saat ini UMC sedang memroduksi chipset SiS760 dengan
teknologi proses 0,15 mikron bervoltase rendah dan chip GbE PHY SiS dengan teknologi proses 0,13
mikron. (raa)



Bank Niaga
Implementasikan Solusi
SAP. Dalam kerjasama ini, SAP akan mendukung
implementasi solusinya pada Bank Niaga meliputi
Performance Management System (PMS) dan Human
Resources Information System (HRIS) untuk
meningkatkan kinerja dan operasional bisnis bank
tersebut. Hal ini termasuk dalam komitmen Bank Niaga
untuk mencapai Visi Bank Niaga 2007 – menjadi bank
yang masuk dalam urutan lima besar di Indonesia.

Penerapan solusi PMS yang terdiri atas Funds
Transfer Pricing, Cost Allocation, dan Business Planning
& Implementation, diharapkan  bisa memberi value bagi manajemen Bank Niaga dalam proses
pengambilan keputusan. Bank Niaga juga merencanakan untuk mengimplementasikan modul Risk
Management untuk mendukung penerapan Basel II Accord dan modul Customer Relationship Manage-
ment (CRM) untuk memberikan keuntungan lebih besar kepada para nasabah Bank Niaga. Untuk
kerjasama ini, Bank Niaga mengeluarkan investasi sebesar US$2,6 juta. (raa)

Panda EnterpriSecure Antivirus: Total Proteksi
untuk Jaringan Komputer Perusahaan. Produk yang dikeluarkan
Panda Antivirus ini dilengkapi dengan ClientShield sebagai solusi anti-spam untuk workstation,
FileSecure untuk memberi proteksi antivirus untuk file sever Windows dan Novell Netware, dan
CommandlineSecure yang mengijinkan mesin scan Panda bekerja dalam aplikasi-aplikasi third-party.

EnterpriSecure mampu memroteksi sebuah jaringan komputer besar dengan sistem e-mail yang
rumit. Untuk sistem e-mail, EnterpriSecure menawarkan ExchangeSecure – antivirus yang memroteksi
sistem Microsoft Exchange Server mulai dari versi 5.5 sampai Microsoft Exchange Server 2003,
DominoSecure – modul antivirus yang memroteksi sistem groupware Lotus Notes dan Domino IBM,
MIMEsweeperSecure – untuk memberikan sistem sistem filter pada e-mail, serta SendmailSecure,
QmailSecure dan PostfixSecure – solusi Linux EnterpiSecure untuk memroteksi SMTP mail gateway
melalui mesin antivirus Panda.

Untuk memroteksi Internet dan gateway melalui traffic TCP/IP, EnterpriSecure menyediakan modul
CVPSecure untuk melayani Checkpoint Firewall 1 dan semua produk berbasis CVP, ProxySecure
untuk memroteksi Microsoft Proxy 2.0, dan ISASecure untuk memroteksi ISA Server. Produk baru ini
ditambahkan dengan tool manajemen batu, AdminSecure, untuk mendukung instalasi, distribusi dan
update antivirus secara cepat dan efisien. (raa)

IBM Sediakan Layanan Konsultasi dan Riset di
Wilayah ASEAN dan Asia Selatan. Pengumuman mengenai On
Demand Innovation Services (ODIS) disampaikan di Laboratorium Riset IBM di India, 11 November yang
lalu. Sekarang, para pelanggan IBM di kawasan ASEAN dan Asia Selatan bisa mengakses layanan ini.
ODIS merupakan layanan konsultasi dan riset yang mengkhususkan diri pada teknologi dan
transformasi bisnis high-end. Melalui ODIS, para konsultan dan periset bisa bekerjasama dalam
membangun berbagai proyek untuk membantu menemukan solusi atas masalah bisnis para kliennya.

ODIS didukung oleh 200 konsultan IBM Research dari seluruh dunia. IBM Research bekerjasama
dengan IBM Business Consulting Service, akan menyediakan alat pembantu dan pengetahuannya bagi
para pelanggan. Untuk layanan ini, IBM mengeluarkan investasi bernilai lebih dari US$ 1 milyar selama
tiga tahun mendatang. (raa)

IBM – Reuters
Lakukan
Ekspansi
Linux untuk
Dukung
RMDS. Reuter Market
Data System (RMDS) adalah
platform piranti lunak untuk
pengintegrasian data pasar
finansial dari Reuter. Untuk
dukungan terhadap RMDS,
IBM dan Reuters akan
menggunakan IBM eServer
xSeries dan sistem-sistem
BladeCenter yang
memanfaatkan Linux.
Rencana ini bisa menjadi
contoh penting bagi
perusahaan-perusahaan jasa
finansial yang ingin
mengerahkan aplikasi-
aplikasi mission-critical
mereka di atas Linux yang
bersifat terbuka, fleksibel
dan hemat biaya.

Penggunaan IBM
eServer xSeries dan
BladeCenter memungkinkan
para pengguna Reuters
untuk meng-upgrade
aplikasi-aplikasi data pasar
yang sudah mereka miliki ke
RMDS di atas platform Linux,
sekaligus memperoleh keun-
tungan yang ditawarkan
oleh teknologi IBM – daya,
densitas dan kinerja. (raa)

Tren Outsourcing Melanda Dunia
Bisnis. Sekarang adalah jamannya teknologi. Gabungan
antara TI dan Telekomunikasi bisa memberi peluang dan
kesempatan-kesempatan baru dalam industri yang mungkin tidak
pernah terpikirkan sebelumnya. Bagaimana sebuah perusahaan
dengan fokus di luar TI bisa memenuhi kebutuhannya akan sistem
informasi dan teknologi? Bagaimana caranya mereka bisa
memiliki TI yang kuat dan tetap “in”, tetapi masih bisa fokus pada
bisnis intinya? Outsourcing adalah solusi yang tepat untuk
masalah tersebut.

Outsourcing dilakukan dengan memperkerjakan sumber daya
dari luar perusahaan, yang biasanya adalah konsultan atau
penyedia jasa aplikasi, untuk mengoperasikan dan memelihara
sebagian atau seluruh jasa TI perusahaan. Konsultan ini lah yang
akan menyediakan jaringan data, koneksi Internet/Intranet,
database, sistem terdistribusi, data center, aplikasi bisnis, dan
melakukan pemeliharaan terhadap aset-aset TI tersebut.

Industri yang banyak melakukan outsourcing adalah industri
yang bergerak di bidang finansial dan perbankan. Dua industri ini
sangat bergantung pada TI karena membutuhkan pencatatan
transaksi secara online. Sebagai contoh, Bank Bumiputera adalah
salah satu bank yang melakukan outsourcing dengan
mempercayakan penyediaan jasa TI-nya pada PT Sigma Cipta
Caraka. (raa)
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Peluncuran Oracle E-Business Suite Special Edition bagi UKM. Hadir
sebagai pembicara, Mr. Stuart Buttar, Managing Director, PT Oracle
Indonesia;  Lesan Limanardja, President Director, PT Metrodata
Electronics Tbk.; dan Sandeep Pal, Regional Marketing Director,
Oracle ASEAN. Sekarang UKM (Usaha Kecil dan Menengah) tak perlu
bermimpi untuk bisa memperkuat platform bisnisnya dengan Oracle. E-
Business Suite Special Edition bertujuan untuk membantu UKM
menggalang kekuatan proses bisnis yang canggih ke skala dan lingkup
bisnis yang mereka butuhkan. (raa)

ARE/PCplus

ARE/PCplus



| 5

plusBelajar IV • 18 November - 01 Desember 2003
PCplus 153

Alex Pangestu
alex@e-pcplus.com Apa di Balik

Indahnya
Screensaver?

S

Banyak terdapat
screensaver cantik.
Sistem operasi pun

umumnya sudah
menyediakan

screensaver. Tapi
screensaver yang

sangat banyak itu,
biasanya hanya

menampilkan blank
screen alias layar

hitam kosong, grafik
yang meng-

gambarkan desain
tertentu, slideshow

gambar, marquee
atau teks berjalan,

video, dan musik atau
sound effect.

uatu
screensaver
bisa saja merupakan
kombinasi dari

beberapa tampilan.
Screensaver sebenarnya

adalah file yang bisa dieksekusi
(executable file), tidak berbeda
dengan file EXE. File executable
adalah file yang mandiri, bisa
dijalankan tanpa bantuan
software lain. Cuma file untuk
screensaver memiliki extension
SCR.

FUNGSI SCREENSAVER
Screensaver memang cantik.

Fungsinya bukan hanya sebagai
pemanis, tapi juga memberi nilai
guna. Monitor CRT, juga televisi,
menggunakan fosfor untuk
menampilkan gambar. Jika
monitor menampilkan gambar
yang sama pada beberapa saat,
berarti ada fosfor yang menyala
terus-menerus. Ini bisa
menyebabkan monitor
bermasalah. Masalah itu biasanya
berupa gambar-gambar yang
redup. Screensaver yang tampilan-
nya selalu berubah bisa mencegah
monitor dari kerusakan.

Monitor seperti LCD, LED dan
lainnya, dan monitor yang sudah
dilengkapi dengan fitur energy
saving membuat screensaver tidak
lagi terlalu diperlukan untuk
menyelamatkan monitor dari
kerusakan. Oleh karena itu,
screensaver sekarang berubah
fungsinya, walaupun fungsi
lamanya tidak hilang.

Fungsi screensaver yang tidak
berubah adalah sebagai hiburan.
Menonton animasi, slideshow

gambar yang disertai dengan lagu
atau suara, bisa menjadi keasyikan
sendiri untuk beberapa menit
setelah berlama-lama bekerja
dengan PC.

Ada beberapa orang yang
menggunakan screensaver untuk
mendukung keamanan penggu-
naan PC-nya. Screensaver dapat
dikombinasikan dengan proteksi
password. Setelah PC ditinggal
beberapa lama (tergantung
setting si pengguna), screensaver
muncul. Untuk kembali ke layar
terakhir, PC akan meminta
password. Jika password yang
dimasukkan salah, monitor tidak
akan menayangkan layar terakhir
sebelum screensaver muncul.

Beberapa perusahaan
menggunakan screensaver
sebagai sarana beriklan. Seringkali
di pameran-pameran komputer
atau di kios-kios informasi,
berbagai perusahaan
menampilkan screensaver yang
menayangkan logo-logo
perusahaan, marque slogan-

slogan, atau
iklan produk
mereka.

Menampil-
kan informasi
juga menjadi
fungsi
screensaver.
Screensaver bisa
dibuat agar
dapat
menayangkan
informasi seperti
berita,
pergerakan
indeks saham,
atau sebagainya, yang sumbernya
berasal dari sebuah situs Web.

Satu lagi fungsi screensaver
yang menarik, yaitu sebagai
pengelola data dari sumber
tertentu pada saat PC tidak
digunakan. Contohnya adalah
SETI@Home. Screensaver ini
menampilkan grafik berupa
spektrum radio dan proses sinyal
radio yang berasal dari server SETI
(Search for Extraterrestrial

Intelligence). Screensaver ini
akan digunakan untuk
menjalankan proses dari SETI
pada saat screensaver ini aktif.
Hasil proses akan dikirimkan
kembali ke server SETI. Proses
perhitungan akan berhenti
apabila screensaver berhenti.
Dengan cara ini SETI banyak
mengurangi waktu yang
diperlukan untuk menjalankan
suatu proses. PC+

Monitor bisa mengalami kerusakan jika
digunakan untuk menampilkan gambar yang
selalu sama dalam jangka waktu yang panjang.
Screensaver yang tampilannya selalu berubah
mencegah kerusakan itu.

ALEX/PCplus
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Berburu File
di Newsgroups

Y.J. Thurana
thurana@e-pcplus.com

S

Jauh sebelum
masanya Kazaa,
Morpheus, dan

bahkan Napster, masa
ketika Internet masih

seumur bayi yang
baru lahir, anggota

masyarakat dunia
maya yang jumlahnya

masih belum
mencapai separuh

dari jumlah mereka
hari ini

memanfaatkan
Newsgroup dari
Usenet sebagai

jaringan file sharing.
Kemudian ketika

orang-orang mulai
memanfaatkan apa

yang dinamakan
HTTP (Hyper Text

Transfer Protocol) dan
Web browser, ribuan

harta karun digital
masih bisa ditemukan

di Newsgroup.

ekarang,
bertahun-
tahun
kemudian,

teknologi itu masih bertahan
seperti sebuah legenda yang
hanya diketahui oleh para
tetua, tanpa menggembar-
gemborkan dirinya, sementara
masih menawarkan tumpukan
permata terbaik yang bisa
ditemukan di Internet. Kabar
buruknya: karena sebagian
besar Newsgroup tidak memiliki
moderator yang mengurusinya,
sebagian besar isi dari pesar-
pesan yang berseliweran di sana
hanya berupa spam. Seperti
daerah liar tanpa penegak
hukum yang penuh dengan
para penjahat kacangan.

Kabar baiknya: dengan
perangkat yang bagus seperti
Tifny, Anda bisa mengabaikan
teri-teri tersebut dan langsung
mendapatkan harta terbaik
yang dimiliki oleh Newsgroup.
Sebuah perjalanan singkat ke
dunia legenda ini bisa
menghasilkan berbagai file
MP3, Image, Dokumen, Driver,
dan Program yang bisa Anda
bawa pulang dalam peti harta.

MENDAPATKAN
LAYANAN NEWSGROUP

Sebetulnya, apa sih
Newsgroup itu? Mereka yang
mengaku dirinya pakar Internet
pasti akan tertawa mendengar
pertanyaan itu. Masa sih,
Newsgroup saja tidak tahu?
Tetapi itulah kenyataannya.
Sebagian besar pengguna
Internet baru tidak banyak yang
mengetahui Newsgroup.
Apalagi tahu bagaimana
mendapatkan layanan dan
memanfaatkannya.

Secara umum, Newsgroup
adalah semacam forum diskusi
mengenai subjek khusus
tertentu yang dibagi
berdasarkan topik. Bentuknya
adalah catatan singkat yang
dikirimkan ke situs pusat
Internet dan didistribusikan

lewat Usenet, jaringan berita dari
kelompok-kelompok diskusi
seluruh dunia. Protokol yang
digunakan adalah NTTP (Net-
work News Transfer Protocol).
Lebih banyak informasi mengenai
Newsgroup bisa didapatkan
dengan ber-Googling sebentar
menggunakan kata kunci
Newsgroup dan Usenet, atau
dengan langsung mengunjungi
Deja News -search engine
khusus untuk Newsgroup.

Lalu di mana saya bisa
mendapatkan layanan
Newsgroup tersebut? Biasanya
semua ISP memiliki fasilitas akses
ke Newsgroup, meskipun tidak
selalu digembar-gemborkan.
Alamatnya biasanya berbentuk
news.NamaISP. Misalnya Anda
menggunakan ISP dengan nama
Kornet.co.id, maka alamat news
server-nya adalah
news.kornet.co.id. Jika tebakan
ini tidak jitu, Anda bisa dengan
mudah menghubungi ISP Anda
dan menanyakannya langsung.

Kemungkinan terburuk
adalah jika ISP Anda sama sekali
tidak tahu apakah Newsgroup
itu, setiap orang bisa selalu
mendaftarkan diri ke layanan
Newsgroup Service Provider
untuk umum dengan batasan
bandwidth yang lebih besar.
Daftarnya bisa dilihat lewat link
berikut ini: http://
directory.google.com/Top/
Computers/Usenet/
Feed_Services/?tc=1/.

Dan setelah kita memiliki
akses ke Newsgroup? Kita bisa
mulai menggunakan Tifny untuk
berburu harta karun.

PERBURUAN DIMULAI!
Untuk tidak membuang

waktu, mari kita mulai. Pertama-
tama tentu saja kita harus
memiliki programnya. Download
di http://www.tifny2.com/
tifny40.exe Anda akan
mendapatkan file shareware 15
hari sebesar 3,6MB.

Setelah diinstal dan
dijalankan, hal pertama yang
harus dilakukan adalah
mengoneksikannya dengan
server Newsgroup. Untuk
memasukkan informasi server,
gunakan menu
[Option]>[Servers]>[Edit]
(Gambar 1).

Setelah terkoneksi, pilih
Newsgroup dari menu [Op-
tions], lalu pilih [Subscribe].
Tifny akan men-download daftar
Newsgroup yang tersedia dan
didukung oleh ISP Anda.
Meskipun sepertinya tidak akan
semuanya tersedia, jumlahnya
sudah akan mencapai puluhan
ribu group.

Supaya Anda tidak pusing
dan tenggelam dalam daftar
tersebut, gunakan fasilitas
pencarian untuk mempersempit

ruang gerak. Caranya dengan
memasukkan kata kunci ke Word
Field di bagian atas jendela.
Misalnya clip art atau MP3. Itu
pun biasanya masih akan
menyisakan sekian ribu pilihan.
Cobalah untuk lebih spesifik
seperti MP3 classic rock 70
(Gambar 2).

Sekarang yang tersisa
hanyalah group yang
berhubungan dengan kata kunci
yang Anda masukkan. Setelah
Anda menemukan group yang
sesuai dengan keinginan, pilih
ikon bulat di sebelah kiri nama
group untuk mendaftarkan diri,
lalu tambahkan ke daftar
Newsgroup utama yang ada di
bagian paling kiri dari jendela.
Untuk unsubscribe, klik kanan
nama group dari daftar utama
dan pilih [Delete] dari pop-up
menu yang muncul.

Untuk melihat pesan-pesan
yang ada pada Newsgroup
tertentu, klik tombol panah di
sebelah kanan daftar utama. Jika
Anda menemukan file yang ingin
di-download, klik saja pesan
dimana file tersebut berada, dan
file akan secara otomatis di-
download ke komputer Anda di
latar belakang (Gambar 3).

Secara default Tifny akan
men-download semua file yang
bisa ditemukannya di Newsgroup
dimana Anda terdaftar.
Tujuannya adalah untuk
memanfaatkan bandwidth secara
maksimum. Jika Anda tidak mau
hal tersebut terjadi, klik tombol
merah di sebelah kanan dari
setiap nama Newsgroup yang ada
di daftar utama. Untuk
memberikan tanda, Tifny akan
memberi warna abu-abu pada
nama tersebut.

Jika Anda memiliki Internet
dengan kecepatan koneksi yang
aduhai, dalam waktu singkat
Anda akan memiliki koleksi file
yang banyak. Untuk melihat file
apa saja yang telah di-download,
klik ikon bola dan kubus yang
ada di bagian atas jendela utama.
File Anda akan diatur
berdasarkan tipenya, seperti GIF
dan MP3. Anda bisa melakukan
pengaturan lebih lanjut dengan
klik kanan pada file apa saja dan
memilih kategori seperti Author
ataupun Size dari menu
penyortiran (Gambar 4).

Anda juga bisa melakukan
pencarian dari file tersebut
dengan memilih menu
[Edit]>[Find] dan memasukkan
kata kuncinya.

Sedangkan untuk
menyingkirkan file yang tidak
diinginkan, klik kanan di file
tersebut dan pilih [Delete] dari
menu yang muncul, lalu pilih
[File].

Ternyata memang Internet
jauh lebih luas daripada sekedar
WWW (World Wide Web) saja.

Seperti lautan luas yang
menunggu untuk dijelajahi. Pada
prinsipnya, Anda bisa
menemukan dan mendapatkan
hampir apa saja di Internet
selama tahu di mana dan
bagaimana mencarinya.

Hal lain yang perlu diingat
juga adalah tidak semua hal yang

bisa ditemukan di Internet itu
legal dan tidak berbahaya. Jadi
ada baiknya sedikit berhati-hati
sebelum mengklik tombol
download. Salah-salah Anda
dituntut karena dianggap
mencuri atau membajak file
orang.

Selamat berburu! PC+

Gambar 2

Gambar 3

Gambar 4

Gambar 1
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www.groups.or.id
Ajak Milis

untuk Mudik

Alex Pangestu
alex@e-pcplus.com

D

Situs web apa yang
paling sering

digunakan untuk
membuat mailing list
(disingkat jadi milis)?
Jawaban yang paling

sering terlintas adalah
Yahoo! Groups (http:

//groups.yahoo.com).
namun, belum lama
berselang beberapa

aktivis teknologi
informasi di Indonesia

membangun sebuah
situs Web yang

layanannya sama
dengan Yahoo!

Groups. Namanya
adalah Groups.or.id.

i situsnya
tertera
bahwa tujuan
dibuatnya

Groups.or.id adalah untuk
memberdayakan potensi
sumber daya manusia
komunitas teknologi informasi
(TI) di Indonesia dan
menghemat bandwidth ke luar
negeri. Selain itu, milis lokal
seperti ini bisa menjadi salah
satu projek pengembangan
komunitas open source di
Indonesia.

HASIL PATUNGAN
Situs Web ini terbentuk dari

hasil patungan para aktivis TI
seperti Onno W. Purbo, Bona
Simanjuntak (aktivis Jaringan
Informasi Sekolah), David
Sudjiman (pengurus KPLI
Jakarta), Rio Martin (mahasiswa
Itenas), M. Ichsan (administrator
Visionnet), Nies Purwati (sekjen
Mastel), Rusmanto (Pemimpin
Redaksi Infolinux), I Made
Wiryana (Dosen Universitas

Gunadarma), Mas Wigrantoro RS
(Koordinator GIPI Indonesia), Heru
Nugroho (Sekjen APJII), Donny
B.U. (koordinator ICT Watch),
Anton (Pengelola Telematics
Indonesia), dan rekening atas
nama KPLI Jakarta, atas nama
Nona, serta seorang tak dikenal.

Mereka patungan untuk
membeli komputer refurbished
tipe HP Kayak P3-600 seharga Rp
1.695.000,00 di
www.fastncheap.com.
Patungan dibatasi nilai
maksimumnya, yaitu sebesar Rp.
200.000,00. Tertera di Group.or.id
bahwa maksud pembatasan ini
adalah agar pemilikan server itu
dapat ditanggung bersama.

MUDIK
Sebagian besar milis yang

ada di Indonesia dibuat di luar
negeri, dan paling banyak adalah
Yahoo! Groups. Untuk
menghemat bandwidth ke luar
negeri, para aktivis pembangun
Groups.or.id menyarankan agar
para pemilik milis di Yahoo!
Groups memindahkan milis
mereka ke situs Web layanan
milis dalam negeri seperti
Groups.or.id. Mereka juga
menambahkan bahwa dengan
menghemat bandwidth ke luar
negeri, secara tidak langsung

dapat menyelamatkan
devisa negara. Selain
milis, mereka juga
menyarankan agar
orang Indonesia yang
menggunakan web-
based mail luar negeri
mudik ke web-based
mail dalam negeri.

Tertarik untuk
memindahkan milis dari
Yahoo! Groups ke
Groups.or.id? Berikut
ini PCplus berikan
langkah-langkahnya:
1.   Buka
groups.yahoo.com di
browser, kemudian
login.
2.   Di sebelah kiri akan
muncul nama-nama
milis. Pilih milis yang
ingin dipindahkan. Milis
yang bisa dipindahkan
tentu saja hanya milis
yang kita miliki.
3.   Setelah masuk ke
milis milik kita, klik
[Members] yang ada di
menu sebelah kiri.
4.   Klik [Download List]
yang terletak pada
menu sebelah atas.
5.   Browser akan
menampilkan daftar

alamat e-mail yang terdaftar
di milis kita. Copy semua
alamat e-mail tersebut. Paste

di Notepad atau software
pengolah kata lainnya.
Kemudian save file tersebut.

6. Buka Groups.or.id. Kalau
sudah punya milis di sini,
langsung buka alamat milis.
Tapi kalau belum punya,
minta agar milis dibuatkan
oleh administrator
Groups.or.id.

7. Jika sudah punya, klik
[Membership Management].

8. Klik [Mass Subscribtion].
9. Buka file yang tadi berisi

alamat e-mail. Copy isinya
dan paste di tempat yang
sudah disediakan.

10.Klik tombol [Submit Your
Changes].

Setelah itu berarti kita
sudah memindahkan milis dari
Yahoo! Groups ke
Groups.or.id.

DAFTAR BARU
Bagaimana kalau belum

punya milis? Kita bisa meminta
kepada administrator
Groups.or.id agar mereka
membuat milis sesuai dengan
keinginan kita. Kita cukup
menjelaskan apa-apa yang kita
inginkan dari milis. Mereka
akan membuatkannya. Kita

nanti hanya perlu mengundang
orang-orang untuk bergabung
dengan milis kita. PC+

www.groups.or.id. Situs web hasil patungan para aktivis TI Indonesia yang
melayani pembuatan milis. Situs ini diharapkan menjadi salah satu pemicu
perkembangan TI di Indonesia.

Setelah halaman milis terbuka, klik [Members] untuk mengakses
alamat e-mail yang terdaftar pada milis milik kita.

Klik nama milis yang kita miliki. Biasanya milis yang kita miliki diberi
tanda bintang di sampingnya.

Klik [Download List] agar browser menampilkan alamat e-mail dalam
format teks yang dapat di-copy.

Paste alamat e-mail yang tadi di-copy pada halaman ini. Setelah
selesai, klik [Submit Changes].
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MC60, C60, C62:
Amunisi Siemens untuk

Gelontor Pasar MMS

F.X. Bambang Irawan
fbi@e-pcplus.com

MMS akan segera
populer karena keran
lintas operator sudah

dibuka. Kartu truf lain
yang ditunggu-tunggu

konsumen adalah
ponsel MMS yang

murah harganya. Nah,
dengan beberapa line

up terbarunya ini Si-
emens tampak

berusaha mengisi celah
tersebut.

ecara
serentak Siemens
di Indonesia, melalui PT
Dian Graha Elektrika,

mengeluarkan ponsel-ponsel
warna, berkemampuan kamera,
dan berkapabilitas MMS dengan
MC60, C60, dan C62. Melihat
kisaran harga yang ditawarkan,
armada MMS ini memang
menyasar kelas menengah ke
bawah (yang tetap ingin tampil
gaya).

SIEMENS MC60
Pertama kali menatap

Siemens MC60 ini, kesan pertama
kita akan digiring menuju huruf
X. Kesan ini sengaja diciptakan
oleh Siemens melalui highlight
alur belang casing-nya yang
menyilang, dengan titik
pertemuan persilangan terletak
pada pusat keypad, yaitu tombol
untuk angka lima dan huruf J, K,
L, sekaligus tombol shutter untuk
kamera.

Celah yang timbul akibat
persilangan di bagian atas huruf
X tersebut seperti bagian atas
gelas anggur yang menyimpan
keberadaan layar yang sanggup
menampilkan 4096 warna,
dengan resolusi 101x80 pixel, dan
7 baris teks.

Tak heran juga jika
kampanye untuk produk yang
dapat beroperasi secara triple
band pada GSM 900/1800/100
MHz ini juga bernuansa X.
Jargon-jargon untuk
mengidentifikasi segmentasi
produk ini mengandung huruf X,
seperti seXy, eXtreme, relaX, dn
fleXible. Ponsel memang tak lagi
sekadar beradu teknologi dan

kinerja, namun juga harus pintar
ketika bicara soal desain dan
keunikan fitur.

Bak perhiasan emas permata,
pemilik ponsel harus bisa tampil
gaya dan beda dibanding

kebanyakan orang ketika
menenteng perangkat
komunikasi mungil tersebut.
Siemens MC60 juga berdandan

dengan casing yang
futuristik, yaitu Aquama-

rine, Titanium, dan
Grenadine.

Kamera yang
dipasang pada ponsel
ini, seperti pada ponsel
kamera umumnya,
menggunakan
teknologi CIF (Com-
mon Interchange
Format) dengan
resolusi maksimal
352x288 pixel. Kamera
CIF merupakan modul
kamera yang
terintegrasi yang
dipasang pada ponsel-
ponsel ukuran kecil.
Untuk menyimpan
gambar yang
dihasilkan kamera CIF
ini hanya dibutuhkan
memori yang relatif
kecil, namun kualitas
yang ditampilkan pada
layar ponsel lumayan
bagus. Tingkat
sensitivitasnya berada
di antara 20 sampai 20
ribu Lux alias Lumen
per meter per segi.

Hasil jepretan akan
langsung berformat
JPEG dengan ukuran

4KB untuk pilihan
resolusi 160 x 120 pixel

(format QQVGA) dan 15KB
untuk resolusi tertinggi, yaitu

352 x 288 pixel (format CIF).
Pilihan resolusi lainnya adalah
QCIF (176 x 144 pixel) dan
QQVGA (160 x 120 pixel).

Jumbuh dengan kemampuan
jeprat-jepretnya, Siemens MC60
dipersenjatai dengan kapabilitas
Multimedia Messaging Service
(MMS) yang merupakan
fitur yang sedang marak
saat ini. Untuk
keperluan fun ini,
sudah disiapkan
kapabilitas transfer
data dengan
kecepatan tinggi dan
mutakhir pula, yaitu
General Packet Radio
Switch (GPRS) kelas 8.
Ponsel berbobot 86
gram ini juga bisa
merangkap jabatan
sebagai modem GPRS
untuk koneksi dari
perangkat lain seperti
PC, notebook, dan
PDA (Personal Digital
Assistant). Untuk akses
Internet langsung dari
ponsel, dipasang WAP
(Wireless Access
Protocol) versi 1.2.1.

Tradisi kedekatan
Siemens dengan Java
juga dilanjutkan pada
ponsel ber-polyphonic
16 nada ini.

Dengan Java,
berbagai aplikasi dan
game menarik bisa
dijalankan pada pe-
ranti mungil ini, tidak
jauh beda dengan
aplikasi dan game
pada peranti lain
seperti PC atau PDA.

Peranti dengan dimensi
109 x 46 x 21 mm ini menggu-
nakan baterai standar Li-Ion 700
mAh yang mampu bertahan
sampai 250 jam pada kondisi

stand-by dan sampai 300 menit
talk time. Butuh waktu kurang
dari 2 jam untuk men-charge-nya.

Sayang model yang ini tidak
dilengkapi dengan inframerah.
Menurut Farid Manan, Deputy

S

Siemens MC60: Ponsel bernuansa
X untuk perlambang seXy, eXtreme,
relaX, dn fleXible

Siemens C60: Berusaha
ekspresif, namun dengan cara
sesederhana mungkin.
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General Manager PT Dian Graha
Elektrika, MC60 memang
disegmenkan bagi mereka yang
lebih membutuhkan sisi fun dari
ponsel ini. Bagi Siemens,
fasilitas semacam inframerah
umumnya dipasang pada

ponsel-ponsel kelas bisnis
mereka. Demikian juga dengan
layar yang masih hanya
mengusung 4096 warna, belum
mencapai 65 ribuan warna
sebagaimana para
kompetitornya. Menurut Farid
hal ini dikarenakan
segmentasinya yang diarahkan
untuk kelas mid-low. Sebagai
catatan, ponsel yang
mempunyai kapasitas memori
(yang bisa digunakan bagi user)
sebesar 1MB ini, dijual pada
harga sekitar 2,2 jura rupiah.

SIEMENS C60
Satu lagi ponsel MMS dari

Siemens. Hanya saja, tidak
seperti MC60, kamera untuk
ponsel C60 ini dijual terpisah,
opsional. Kamera yang
digunakan adalah QuickPic
yang memang dirancang untuk
ponsel-ponsel kamera dari
Siemens. Keunggulan QuickPic
adalah adanya lampu kilat yang
sudah built in. Ini membuat
ponsel bisa dipasarkan pada
harga yang terjangkau bagi
kelas menengah ke bawah.

Menurut Robby
Darmasetiawan, General
Manager Business Unit Mobile
Device, PT Dian Graha Elektrika,
C60 ini diarahkan bagi mereka
yang menyukai tampilan seder-
hana tetapi juga ingin berko-
munikasi dengan lebih hidup
bersama keluarga dan teman.
Ekspresif, namun dengan cara
sesederhana mungkin.

Selain beroperasi secara tri
band pada jaringan GSM 900/
1800/1900 MHz, ponsel dengan
bobot 85 gram (hanya berselisih
satu gram dibanding MC 60) ini
juga mendukung GPRS kelas 8.
Sama dengan MC60, versi WAP
yang dipasang adalah versi
1.2.1.

Layar display yang tersedia
mampu mengeluarkan 4096
warna juga, dengan resolusi 101
x 80. Hanya saja, ukuran vertikal
layar lebih kecil dibanding MC60,
yaitu hanya mampu menampung
5 baris.

Ponsel polyphonic ini cocok
juga untuk mengekspresikan
diri karena cover-nya bisa
diganti-ganti. Kalau pun tidak
mau ganti-ganti, bisa dipilih
antara tiga pilihan warna yang
tersedia.

Jangan lupa memeriksa daya
tahan baterai ponsel yang dijual
seharga sekitar 1,375 juta rupiah
ini. Untuk standby saja, si baterai
akan kuat diajak sampai 250 jam.
Sedang untuk “cuap-cuap time”
alias talk time daya tahannya bisa
digeber sampai 300 menit.

SIEMENS C62
Andaikan mungkin, mulai

dari kepala, pundak, lutut,
sampai kaki, bakal dimanjakan
oleh satu benda ini saja: ponsel.
Siemens C62 memilih fokus pada
dua di antaranya: mata dan
telinga. Maksudnya apa nih?

Masih dalam rangka hingar
bingar MMS, ponsel ini ikut larut
dalam euforia itu dan
mengunggulkan kapabilitas
MMS-nya. Selain ber-MMS ria
dengan mengambil gambar
secara langsung, nilai lebih yang
ditawarkannya adalah dalam hal
merekam suara.  Jadi, dengan
ponsel seberat 85 gram ini, MMS
menjadi lebih ekspresif berkat
kemampuan menambahkan
suara secara langsung dari sekitar
kita.

Sekilas, tak banyak
perbedaan antara Siemens C60
dengan C62 ini dalam soal fitur.
Namun dalam soal desain akan
terlihat perbedaan yang
signifikan, terutama pada bagian
keypad dan layar display.

Pada keypad, ponsel C60
mengikuti desain tombol yang
bersegi dan bersudut, bukan
yang lonjong dan berpermukaan
bulat. Kemudian, bagian keypad
ini dibalut dengan sentuhan
warna chrome yang
menjadikannya berkesan
modern.

Sedang dari ketiga ponsel
yang dibahas di sini, layar C62
merupakan yang paling tinggi
resolusinya. Kalau yang lain
hanya mengusung 101 x 80
pixel, maka C62 mempunyai

Siemens C62: Memanjakan
mata dan telinga.

resolusi 128 x 128, 4096 warna
dan 7 baris teks. Inilah langkah
yang diambil untuk
memanjakan mata.

Pembedaan juga dilakukan
oleh Siemens dalam soal GPRS.
Ponsel dengan dimensi 101 x 44 x
20 mm ini hanya dipasangi GPRS
kelas 4.

Fitur-fitur lain seperti
triband, kapabilitas MMS/EMS/
long SMS, kapabilitas kamera
dengan QuickPic, WAP, dan
nada dering polyphonic, dan
standby time baterai, sama
dengan yang ditawarkan oleh
C60. Hanya dalam soal talk
time, C62 lebih boros karena
hanya mampu bertahan selama
4,5 jam saja.

Ponsel ini baru akan masuk
pada bulan Desember 2003. PC+
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Menonaktifkan
Klik Kanan di Desktop

Windows XP:
“DIR” ala MS-DOS

SATU LAGI TRIK untuk mengamankan PC Anda. Kali ini kita akan menonaktifkan klik kanan
mouse di desktop. Mungkin Anda akan bertanya-tanya, apa bedanya dengan trik edisi terdahulu yang
menggunakan DWORD value NoDesktop untuk menonaktifkan klik kanan di desktop? Bedanya, jika
Anda menggunakan NoDesktop maka seluruh icon di desktop tidak akan ditampilkan. Sedangkan jika
Anda menggunakan trik ini maka ikon-ikon desktop akan tetap ditampilkan.

Efek lain dari trik ini adalah penonaktifan klik kanan pada ikon-ikon file di Windows Explorer.
Bagaimana? Ingin segera mengaplikasikan trik ini ke PC Anda? Ikuti langkah-langkah berikut:
1. Jalankan Registry Editor dengan mengklik [Start]>[Run...] kemudian ketik regedit.
2. Masuklah ke subkey:

HKEY_LOCAL_MACHINE\Software\Microsoft\Windows\CurrentVersion\Policies\Explorer
3. Pada bagian kanan window, klik kanan mouse kemudian pilih [New]>[DWORD value] untuk

membuat DWORD value baru.
4. Beri nama NoViewContextMenu pada DWORD baru tersebut.
5. Klik dua kali entry yang baru Anda buat tadi kemudian isikan Value data-nya dengan nilai 1.
6. Klik [OK], kemudian tutup Registry Editor dan restart PC.

Setelah me-restart PC, sekarang coba klik kanan mouse di desktop atau pada ikon-ikon di desktop.
Tidak ada menu konteks yang muncul bukan? Sekarang coba buka Windows Explorer. Klik kanan salah
satu ikon di bagian kanan window. Efek yang sama juga akan terjadi.

Steven Andy Pascal
steven@e-pcplus.com

Membuat Wallpaper
Bergantian dengan

Adobe ImageReady
ANDA BOSAN dengan tampilan wallpaper pada desktop
Anda? Atau Anda jenuh setiap kali harus mengganti wallpaper
melalui Properties atau me-refresh desktop supaya wallpaper Anda
dapat berganti? Ada cara yang paling mudah untuk melakukan
pekerjaan di atas, ikuti langkah dibawah ini:
1. Sebelumnya persiapkan dahulu gambar-gambar yang akan

dijadikan wallpaper dan masukkan dalam satu folder tersendiri.
2. Jalankan program Adobe ImageReady, buka menu

[File]>[Import]>[Folder as Frames…], setelah muncul Browse
for Folder dialog, cari folder di mana Anda menyimpan
gambar-gambar tadi.

3. Kemudian atur delay setiap gambar pada tab [Animation]
dengan klik [Delay]

4. Untuk menyimpan dalam format *.gif, buka menu [File]>[Save
Optimized As…]. Beri nama file-nya dan tentukan letak
direktorinya.

5. Untuk menjalankannya klik kanan pada desktop dan masuk ke
Desktop Properties, kemudian ganti background atau wallpa-
per Anda dengan file GIF yang telah Anda buat. Lalu klik
[Apply]. Selamat mencoba.

M. Ali Faiq
a_faiq_2003@yahoo.com

PADA COMMAND PROMPT di Windows XP, ketika kita memasukkan perintah dir untuk
melihat isi sebuah direktori, maka urutan data yang ditampilkan adalah tanggal dan jam pembuatan file
atau folder disusul dengan ukuran file dan nama file atau folder diletakkan paling belakang (Gambar 1).

Posisi ini merupakan kebalikan dari MS-DOS yang menampilkan nama file terlebih dahulu diikuti
dengan ukuran file dan tanggal pembuatan file atau folder seperti yang ditampilkan Gambar 2. Untuk
mengubah tampilan dari perintah dir ini Anda dapat menambahkan parameter /-n dibelakang perintah
dir sehingga menjadi dir /-n.

Apabila Anda lebih menyukai tampilan MS-DOS yang lama dibandingkan tampilan “dir” baru di
Command Prompt, Anda dapat mengikuti langkah-langkah berikut untuk mengubahnya secara
permanen.
1. Klik [Start]>[Control Panel]>[Performance and Maintenance]>[System] untuk membuka System

Properties.
2. Pilih tab [Advanced], kemudian klik tombol [Environment Variables].
3. Ketika window Environment Variables terbuka, klik tombol [New] di bagian User variables for....
4. Pada window New User Variables, isikan dircmd untuk Variable name.
5. Untuk Variable value, Anda dapat mengisi dengan /-n (Gambar 3).
6. Klik [OK], [OK] dan [OK] sekali lagi.

Hasilnya, mulai sekarang perintah dir selalu ditampilkan ala MS-DOS klasik. Anda pun tidak perlu
lagi menambahkan parameter /-n setiap kali menggunakan “dir”.

Steven Andy Pascal
steven@e-pcplus.com

Gambar 2

Gambar 1
Gambar 3
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Disable Source pada IE

Cara Cepat
Membuat Gallery Photo

Berbasis Web

UNTUK MELIHAT cara mendesain suatu halaman Web yang cukup menarik, biasanya kita akan
melihat source-nya melalui menu [View]>[Source]. Anda yang memang senang men-disable sesuatu atau
iseng ke teman, bisa men-disable menu view source ini. Sebenarnya apa tujuannya? Anda sendiri yang
akan menjawabnya, untuk apa kira-kira Anda menggunakan trik ini. Baiklah, diasumsikan Anda sudah
memiliki alasan untuk men-disable-nya. Kemudian kita hanya perlu mengedit registry. Berikut adalah
langkah-langkahnya:
1. Jalankan Registry Editor, yaitu dengan mengetikkan regedit pada [Start]>[Run].
2. Masuklah ke key HKEY_CURRENT_USER\Software\Policies\Microsoft\Internet

Explorer\Restrictions, jika ada key yang belum tersedia, Anda dapat membuatnya melalui menu
[Edit]>[New]>[Key].

3. Pada subkey Restrictions buatlah data DWORD ([Edit]>[New]>[DWORD value]) dengan nama
NoViewSource.

4. Klik ganda data tersebut dan isikan nilainya dengan 1
Untuk melihat hasilnya, cobalah membuka file HTML, kemudian amati pada menu [View] apakah

opsi [Source] masih aktif. Untuk mengembalikannya sangat mudah, Anda cukup mengganti nilai 1
tersebut menjadi 0 atau langsung menghapus data tersebut. Selamat mencoba.

Rizki Kurniawan
some132@myself.com

Disable
Menu History pada
Internet Options

BAGI ANDA YANG INGIN melacak situs-situs yang
pernah dikunjungi oleh rekan, saudara atau anak Anda, ada
beberapa cara yang dapat dilakukan, salah satunya adalah dengan
men-disable menu History yang dapat Anda temukan di [Control
Panel]>[Internet Options]>[General]. Dengan men-disable bagian
ini berarti Anda sudah menghambat orang lain untuk mengganti
setting hari penyimpanan history. Dan yang paling penting Anda
juga men-disable Clear History, sehingga rekan, saudara, atau
Anak Anda tidak dapat menghapus history ini dengan mudah lagi.
Berikut adalah cara men-disable-nya:
1. Jalankan Registry Editor, yaitu dengan mengetikkan regedit

pada [Start]>[Run...].
2. Masuklah ke key

HKEY_CURRENT_USER\Software\Policies\Microsoft\Internet
Explorer\Control Panel

3. Buatlah data
DWORD ([Edit]>
[New]>[DWORD
value]) dengan
nama History

4. Klik ganda data
tersebut, kemudian
isikan nilainya
dengan 1.
Untuk melihat

hasilnya, Anda dapat
menjalankan [Internet
Options]>[General],
amati apa yang terjadi
pada bagian History.
Untuk mengembalikan
ke semula, Anda cukup
mengganti nilai 1
tersebut menjadi 0
atau menghapus data tersebut. Perlu diingat, cara ini tidak 100%
berhasil, terutama jika Anda berhadapan dengan orang yang tahu
bagaimana mengatasi proteksi ini. Selamat mencoba.

Rizki Kurniawan
some132@myself.com

JIKA ANDA
MEMILIKI BANYAK
FILE gambar, suatu ketika
mungkin Anda merasa pusing
saat harus mengatur dan
merancang halaman Web untuk
publikasi file tersebut.
Sementara Anda tidak memiliki
program untuk eksplorasi
khusus gambar di komputer
Anda untuk menampilkan dan
mengatur susunan file-nya.
Secara manual bisa saja kita
merancang sebuah gallery Web
untuk foto tersebut, kemudian
memasukan file gambarnya satu
per satu, namun bagaimana jika
file gambar tersebut jumlahnya
puluhan atau bahkan ratusan
sementara waktu untuk
melakukan itu semua amat
terbatas?

Untuk itulah pada Adobe
Photoshop 7 terdapat fitur yang
berguna untuk secara otomatis
mengemas file gambar Anda ke
dalam bentuk halaman Web
yang apik, menarik dan dinamis
dengan beberapa pilihan
bentuk halaman web gallery.

Kemampuan Adobe
Photoshop dalam mengolah
image memang sudah banyak
dibuktikan, sehingga untuk
urusan mengemas gambar ke
dalam format web page tidak
perlu diragukan.

Adapun keuntungan
membuat web gallery foto
dengan Photoshop 7 antara lain:
• Waktu pembuatan halaman

web yang relatif singkat,
sehingga Anda tidak perlu
membuang waktu banyak.

• Kompresi file gambar yang
baik.

• Pada proses pembuatan
thumbnail dan pengaturan
ukuran file-nya seimbang,
yang bila Anda lakukan secara
manual tentu akan sangat
merepotkan.

• Mampu mendukung seluruh
tipe atau ekstensi file gambar
yang ada.

Proses pembuatnya pun
amat mudah, tanpa perlu banyak
kerja mouse atau keyboard.
Untuk itu ikutilah beberapa
langkah berikut:
1. Tempatkanlah semua file

gambar Anda ke dalam
sebuah folder dan berilah
nama yang spesifik (Contoh:
My Picture).

2. Bukalah program Adobe
Photoshop 7 tanpa perlu
membuka sebuah file gambar
pada program tersebut.

3. Pilih [File]>[Automate]>[Web
Photo Gallery...], kemudian
akan muncul sebuah kotak
dialog Web Photo Gallery

seperti pada gambar, di mana
Anda dapat mengatur setting
tampilan halamannya
(Gambar 1).

4. Pada bagian Site, pilihan
Style: adalah tempat dimana
Anda dapat memilih sesuai
selera Anda, preview bentuk-
bentuk halaman Web dapat
dilihat pada sisi kanan kotak
menu.

5. Pada bagian Folder, dengan
menekan tombol [Browse...] ,
tentukan folder tampat Anda
menyimpan semua file
gambar Anda yang akan
dimasukkan pada halaman
Web Photo Gallery.

6. Masih pada bagian Folder,
tekan tombol [Destination...],
tentukan pula folder tempat
Anda akan menyimpan
halaman Web Photo Gallery.

7. Pada bagian Options Anda
dapat mengatur setting yang
berkaitan dengan identitas
pemilik gambar tersebut.
Nama situs, fotografer,
kontak info, tanggal
pemuatan dalam situs, jenis
huruf, dan ukurannya.

8. Tekan [OK] jika telah selasai
dan Photoshop 7 akan secara
otomatis mengemas semua
file gambar Anda yang
ditempatkan pada folder
yang telah Anda tentukan.

9. Setelah menyelesaikan proses
pembuatan halaman Web
tersebut, secara otomatis
komputer Anda akan
membuka halaman Web yang
baru selesai tadi dengan
browser yang tersedia.

Untuk memasukkan file
gambar baru ke dalam Web
Photo Gallery yang sudah Anda
buat, ikutilah langkah berikut:
1. Tempatkan file gambar baru

tersebut pada folder My
Picture.

2. Bukalah program Adobe
Photoshop 7 tanpa perlu
membuka file gambar

apapun.
3. Kemudian ulangi langkah

nomor 3 di atas tanpa
mengadakan perubahan
setting apapun pada kotak
dialog Web Photo Gallery.
Sekarang Anda telah

mempunyai gallery foto
berbasis Web yang Anda buat
dengan cara yang mudah dan
cepat. Bila diperlukan, Anda
dapat saja melakukan
pengeditan halaman Web
tersebut dengan menggunakan
FrontPage atau program sejenis.
Selamat mencoba.

TC.Kusuma
tckusuma@softhome.net
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Saat ini DVD-Video
sudah cukup banyak

tersedia di Indonesia.
Memang DVD-Video

ini masih belum
mampu untuk

menggeser VCD
sebagai format yang
mendominasi. Meski
begitu, kelihatannya
DVD-Video semakin

hari semakin banyak
peminatnya. Apalagi

dari segi kualitas
DVD-Video ini lebih
baik dibandingkan

VCD.

VD-Video
merupakan generasi
berikutnya dari VCD,
jadi wajar saja

kualitasnya lebih tinggi. Karena
masyarakat lebih banyak
memiliki VCD player dibanding-
kan DVD player, bermunculan-
lah software-software yang bisa
merubah format DVD-Video ini
ke dalam format VCD.

Kadangkala suatu DVD-
Video itu memiliki audio yang
menarik untuk didengar tanpa
perlu melihat video yang
menyertainya.

Bagi pengguna PC mungkin
merubah audio dari DVD-Video
ke MP3 merupakan hal yang
lebih menarik, namun CD-DA
tetaplah lebih universal bagi
player yang dapat
menerima CD.

AC3 DAN CD-DA
Format audio standar yang

tersedia pada DVD-Video
adalah AC3 alias Dolby Digital.
Umumnya software yang bisa
mengubah audio dari DVD-
Video ke format yang lain
memang hanya mendukung
Dolby Digital saja, DTS tidak.
Standar AC3 adalah
menggunakan frekuensi
sampling sebesar 48kHz dengan
resolusi hingga 24 bit.

Sementara itu standar CD-
DA adalah memiliki frekuensi
sampling sebesar 44,1kHz
dengan resolusi sebesar 16 bit.
AC3 yang banyak digunakan
pada DVD-Video memiliki 2
ataupun 5.1 kanal. CD-DA
sendiri standarnya hanya
memiliki 2 kanal sehingga bila
menggunakan sumber yang 5.1
kanal banyak software yang
menawarkan fasilitas downmix.

Ada banyak software yang
bisa mengambil audio dari DVD-
Video dan merubahnya menjadi
wave maupun MP3, namun
tidak semuanya memiliki
fasilitas burning. Oleh karena
itu bila menggunakan software
yang tidak memiliki fasilitas
burning, setelah konversi
selesai, gunakan software
burning yang populer untuk
membuat CD-DA-nya.

Untuk mempercepat
pembacaan, bisa juga DVD-
Video tersebut isinya disalin ke
harddisk. Tersedia banyak
software yang bisa
melakukan ini.

Cakrawala Gintings
cakra@e-pcplus.com Membuat CD-DA dari

Audio DVD-Video
AC3 KE WAVE

Pada rubrik plusUpgrade
edisi PCplus yang ke-148, sudah
pernah dibahas perbedaan an-
tara AC3 dan MP3 untuk bitrate
tertentu, khususnya dalam
frequency response. Pada tulisan
tersebut telah ditunjukkan bah-
wa AC3 menawarkan high fre-
quency response yang lebih baik
(bitrate 192kbps untuk stereo)
dibandingkan dengan MP3.

Oleh karena itu, supaya
jangan sampai terjadi
pemotongan di frekuensi tinggi,
ada baiknya kita menggunakan
format wave sebagai hasil
konversi. Format wave yang
digunakan sebaiknya yang
memiliki frekuensi sampling
44,1kHz dengan resolusi 16 bit,
sama dengan yang dimiliki CD-
DA. Secara standar format wave
yang digunakan harusnya
memang yang memiliki properti
seperti itu.

Bila seandainya software
yang digunakan hanya
menawarkan hasil konversi
berupa MP3, software ini tetap
bisa digunakan meskipun
memang tidak dianjurkan. MP3
yang dihasilkan umumnya bisa
digunakan secara langsung untuk
menghasilkan CD-DA. Ini
disebabkan software burning
yang populer biasanya telah
dilengkapi dengan kemampuan
untuk mengubah MP3 secara
langsung ke format yang
diperlukan untuk CD-DA pada
saat melakukan proses burning.

Bila diinginkan, file wave
atau MP3 yang diperoleh bisa
diolah terlebih dahulu. Banyak
software pengolahan audio yang
tersedia, mulai dari yang ringan
sampai yang berat seperti halnya
Sound Forge. Banyak hal yang
bisa dilakukan dalam pengolahan
audio ini, mulai dari mengurangi
cacat yang ada sampai
menambahkan efek tertentu.
Bunyi click atau desis sering kali
bisa dikurangi dengan
pengolahan seperti ini. Perlu
diperhatikan, pengurangan cacat
seperti ini kadang kala bila ber-
lebihan malah bisa mengurangi
kemiripan data yang akan dijadi-
kan CD-DA terhadap aslinya.

Kali ini PCplus menggunakan
software ImTOO DVD Audio
Ripper 1.0.7 build-1103.
Software ini dapat mengambil
secara langsung audio dari DVD-
Video yang bersangkutan dan
mengubahnya menjadi wave
ataupun MP3. PCplus tentunya
memilih yang wave. Setelah file
wave diperoleh, PCplus kemudian
menggunakan Nero Burning
Rom 6.0.0.11 untuk membakar
CD-DA yang diinginkan.
Langkah lengkapnya bisa dilihat
berikut ini. PC+

D

Pilihlah DVD-Video yang diinginkan lalu kliklah
tombol [OK]

Setelah ImTOO DVD Audio Ripper selesai memindai,
pilihlah sumber audio yang diinginkan. ImTOO DVD
Audio Ripper tidak mendukung DTS

Setelah menjalankan ImTOO DVD Audio Ripper,
kliklah tombol [DVD] untuk memilih sumber yang
diinginkan

Bila diinginkan kliklah tombol [Input Settings] untuk
mengatur beberapa item

Pada Input Settings bisa diatur level volume yang
diinginkan. Item ini bisa digunakan untuk melaku-
kan fine tuning secara manual terhadap volume

Bila sudah siap untuk meng-encode, kliklah tombol
[Encode] yang tersedia

Terakhir, bakarlah CD-DA yang diinginkan
menggunakan software burning yang dimiliki

Bila diinginkan dapat digunakan CD-Text pada CD-
DA tersebut
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Mengatasi Masalah
pada Floppy Drive

Pra Fitria Nugraha
patrianu@yahoo.com

B

Floppy disk drive pada
komputer adalah

salah satu komponen
yang paling sering

bermasalah.
Contohnya adalah
munculnya pesan

bahwa disket yang
kita masukkan perlu

diformat, tidak
terdeteksi, dan lain-

lain. Intinya, kita tidak
bisa melihat isi disket

tersebut.

eruntung
bila kita masih
memiliki garansi
terhadap komputer

atau pada floppy disk drive
tersebut karena dapat dengan
mudah ditukar dengan yang
baru. Tetapi, bagaimana jika
garansinya sudah daluwarsa?

Beberapa cara di bawah ini
dapat membantu mengatasi
masalah pada floppy disk drive.
• Pertama, coba periksa kabel

power floppy disk, sudahkah
terpasang dengan baik?

• Periksa kabel data floppy
disk, mungkin terbalik
pemasangannya. Untuk
kabel ini, sisi yang ada kabel
“dipelintir” dipasangkan ke
floppy disk.

• Periksa juga di BIOS apakah

floppy disk drive sudah dalam
posisi enable  dengan ukuran
yang benar.

Ketiga hal tadi dapat
dilakukan bila Anda baru
memasang floppy disk drive di
komputer dan mengalami
masalah. Jika semua sudah benar
dan proses pembacaan masih
tetap bermasalah, coba lakukan
hal-hal berikut:
• Periksa disketnya.

Kemungkinan disket tersebut
rusak. Coba disket tersebut ke
disk drive lain, atau masukkan
disket lain ke floppy tersebut.
Kalau disket tadi terbaca
dengan baik di floppy disk
lain, artinya floppy disk ini
bermasalah.

• Coba bersihkan floppy drive
tersebut dengan disket
pembersih yang banyak
tersedia di toko komputer.

Bila cara tadi masih belum
mengatasi masalah pada disk
drive, langkah terakhir adalah

dengan membedah floppy disk
drive. Yang Anda butuhkah cuma
sebuah obeng  kecil, cotton buds
(korek kuping), dan cairan
pembersih head.

Tetapi harap diingat,
membongkar floppy disk drive
akan menghilangkan garansinya
(kecuali jika memang garansinya
sudah habis). Jika sudah yakin
dengan apa yang akan Anda
lakukan, langkahnya adalah
sebagai berikut:
• Buka penutup floppy drive

yang berwarna putih berada
di depan. Hati-hati saat
membukanya agar tidak
patah.

• Buka juga bagian atas floppy
drive dengan terlebih dahulu
melepas baut atau pengait
yang mengikatnya.

• Angkat bagian atasnya de-
ngan mencongkel sisinya sedi-
kit, sehingga bagian atas dari
floppy drive dapat terlepas.

• Akan tampak dua buah head
pembaca disket. Bersihkan
dengan korek kuping.

Sekarang coba kembali
floppy disk drive Anda, dengan
masukkan disket yang baru. Jika
masih rusak, kemungkinan posisi
kedua head tersebut kurang atau
tidak rata.

• Buka keping besi yang
berada diatas (keping
ini yang
mengangkat
head
bagian
atas),
dengan
terlebih
dahulu
tombol eject
disket.

• Setelah tombol eject
tersebut lepas, dorong
tombol eject tersebut, lalu
angkat keping besi
tersebut.

• Lihatlah posisi kedua head
tersebut, apakah telah rata
atau sajajar. Jika belum,
sejajarkan dengan
menggunakan obeng kecil.

Patokannya adalah lubang
kecil yang terdapat pada ke-
dua head, baik atas atau ba-
wah. Kedua lubang ini harus
saling bertemu sama rata.

Coba kembali floppy disk
tersebut. Sebelumnya pasang
kabel power dan data pada
drive serta pasang keping
besinya seperti cara semula. Jika
tidak berhasil, kemungkinan
head floppy disk drive tersebut
memang rusak. Jika ini terjadi,
Anda terpaksa harus
menyerahkan floppy disk drive
tersebut ke tempat servis untuk
diperbaiki dengan mengganti

head yang rusak. Selamat
mencoba! PC+

ARE/PCplus
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Ada Google
di Desktop

Google Deskbar

Semua Jadi
Windows XP

XP Style Hacker

Mengakses Google
(www.google.com) kini tidak
lagi memerlukan browser. Goo-
gle menyediakan Google Desk-
bar sehingga pencarian dengan
Google dapat dilakukan lang-
sung dari desktop. Google Desk-
bar ini dapat di-download gratis
dari labs.google.com. Ukuran
file instalasinya adalah 423KB.

Google Deskbar akan
muncul di taskbar setelah dija-
lankan. Posisi ini bisa meng-
ganggu apabila software atau

window yang dibuka banyak.
Taskbar bisa menjadi sempit.
Google Deskbar bisa dipindahkan
posisinya ke posisi lain. Drag saja
Google Deskbar ke posisi yang
diinginkan, misalnya ke desktop.

Apa yang hendak dicari
cukup dimasukkan ke text box.
Setelah [Enter] ditekan, akan
muncul sebuah viewer, yang
disebut mini viewer oleh Google
Deskbar. Hasil pencarian
ditampilkan di sini layaknya
browser biasa.

Seluruh fitur Google dapat
diperoleh di Google Deskbar.
Fitur standar Google sebagai
search engine untuk situs web
sudah pasti ada. Fitur-fitur lain
seperti mencari gambar, groups,
dan berita. Fitur Google sebagai
pencari definisi juga disertakan
juga di software ringan ini.

Google Deskbar juga menye-
diakan shortcut untuk mencari soft-
ware dan review film. Untuk men-
cari software pengguna Google
Deskbar langsung di-direct ke situs
www.download.com. Sedangkan
untuk review film pengguna Goo-
gle Deskbar di-direct ke Rotten To-
matoes (www.rottentomatoes.com).

Google Deskbar menyedia-
kan shortcut untuk mengakses-
nya. Default short cut itu adalah
[Ctrl]+[Alt]+[G]. Shortcut ini bisa
diubah dengan mengakses
[Option] dari ikon di sebelah
text box.

Alex Pangestu
alex@e-pcplus.com

Pengontrol Jaringan
yang Andal

Net Control 2

Bukan beneran jadi Windows XP, tapi cuma tampilannya. Ada
beberapa software lama yang belum mengenali tampilan Windows XP, sehingga
walaupun dijalankan di Windows XP, tampilannya masih seperti di Windows 98. Nah,
XP Style Hacker ini mampu nge-hack tampilan software-software seperti ini
menjadi tampilan Windows XP.

Cara menggunakan XP Style Hacker sangat mudah. Yang perlu dilakukan
hanya mencari file berekstensi. EXE dari software tersebut. Setelah ketemu, klik
[Open]. Selesai sudah.

XP Style Hacker bisa di-download dari berbagai situs web penyedia software
yang bisa di-download gratis. Karena tampaknya situs resmi XP Style Hacker ini sudah
tidak aktif. PCplus men-download dari www.freewarefiles.com. Ukurannya
compact, cuma 150KB. Lisensinya freeware.

Alex Pangestu
alex@e-pcplus.com

Seorang adminis-
trator di suatu jaringan
seperti di rumah, kantor kecil
atau sekolah tentu akan dire-
potkan jika mengurusi PC klien
dengan mendatanginya satu
per satu. Daripada melakukan
hal tersebut, lebih baik Anda
menggunakan tool dari Inter-
net, yang mengkhususkan diri
dalam hal networking ini. Salah
satunya adalah Net Control 2.

Dengan software ini, PC
administrator dapat mengontrol
PC lain di dalam jaringan. Kon-
trol itu di antaranya adalah
menjalankan atau menghenti-
kan proses di PC klien, mence-
gah eksekusi oleh user terhadap
software-software tertentu
yang telah ditentukan,  me-log
semua proses yang dieksekusi

pada PC klien, mentransfer file,
turn off, reboot PC dan fungsi-
fungsi power lainnya,
mengirimkan pesan berupa
tulisan, menampilkan gambar,
chat, mengontrol windows
policies, mengunci keyboard dan
mouse, menerima dan mengirim
snapshot desktop dari dan ke PC
klien, dan masih banyak lagi.

Untuk menggunakan
software ini, tidak diperlukan
spesifikasi PC yang terlalu tinggi,
cukup dengan Pentium II 233Mhz
untuk klien dan 200Mhz untuk
server, dan 16MB/32MB RAM,
Anda sudah dapat menggunakan
software ini. Software ini telah
diuji pada Windows 95 OSR2,
Windows 98 SE, Windows ME,
dan Windows XP.

Sebelum memasang dan

menjalankan program
ini, disarankan agar
Anda mengonfigurasi
semua PC yang
terhubung network agar
menggunakan alamat IP
yang tetap.  Untuk PC
klien, Anda juga perlu
memasang program ini.
Ketika proses instalasi
dan Anda berada pada
[Select component],
maka pilihlah [Install as
Client, will control
remote computer] jika
komputer tersebut ingin
Anda jadikan admin.
Pilih [Install as Server,
will be cointrollable by
Client] jika komputer
tersebut ingin dijadikan
klien. [RealVNC

(WinVNC)] bisa digunakan jika
Anda ingin memasang sebuah
tool eksternal yang berupa third-
party remote control yang
melengkapi fungsi Net Control 2.
Anda juga dapat memilih [NC2
Chat (standalone)] jika Anda
ingin memasang sebuah software
chat eksternal untuk jaringan.

Nah, jika Anda tertarik
untuk mencoba, silakan Anda
mencarinya di situs http://
www.pva.by.ru. Shareware
berukuran 1.26MB ini memiliki
masa percobaan selama 14 hari.
Selamat mencoba.

Rizki Kurniawan
rizki.kurniawan.132@students.itb.ac.id
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Merasakan Jadi
Bintang Muda

New Star Soccer

Membuat File Gif Animasi
UnFREEz 2.1

Anda ingin
mencoba membuat
animasi dari file-file gambar
berekstensi GIF yang  Anda
miliki? Tidak perlu pusing dan
bingung dengan banyaknya
software animasi yang tersedia,
apalagi yang dikemas dengan
menu yang kompleks dan mem-
buatnya susah dipelajari. Untuk
animasi sederhana, Anda bisa
mencoba software UnFREEz 2.1
dari www.whitsoftdev.com.
Berukuran sekitar 20 KB, soft-
ware ini tidak perlu instalasi.

Anda bisa langsung mem-
buat animasi dengan cara men-
drag-and-drop file-file berformat
gif ke dalam kolom berwarna
putih yang tersedia. Anda dapat
menghilangkan file yang tidak

Para maniak
sepakbola pasti sudah
memainkan game Champion-
ship Manager (CM). Game ini
sungguh membuat ketagihan.
Sekali main rasanya susah untuk
menyudahinya. Inginnya main
terus, apalagi kalau klub yang
dimainkan sedang berada di
peak performance.

Nah, sekarang ada
sebuah game ringan yang  mirip
dengan CM, yaitu New Star
Soccer. Namun bedanya kalau
di CM kita berperan sebagai
manajer yang menyusun taktik
dan sebagainya, di New Star
Soccer kita berperan sebagai
pemain. Ceritanya, kita adalah
seorang anak muda yang
sedang naik daun. Kita diakui
sangat berbakat. Kita akan
mendaftar menjadi anggota
sebuah klub dan mengontrol
nasib kita sendiri. Kita harus
mengontrol skill, keuangan, dan
juga kita harus mengambil
berbagai keputusan yang sulit.

Pada awal permainan
kita harus mengisi nama,
tanggal lahir (tanpa tahun),
kebangsaan (sayangnya tidak
ada Indonesia), liga yang ingin
kita ikuti, dan klub. Ada 26 liga
yang dapat kita pilih, dari Liga
Amerika, Inggris, Brasil, Italia
dan lainnya. Klubnya pun
lengkap. Kalau kita pilih Liga
Italia, misalnya, ada semua klub
dari Seri-A dan Seri-B. Setelah
kita menentukan semua itu, kita
tentukan gaji kita apakah akan
dinaikkan atau sesuai dengan
default-nya. Kemudian
tentukan juga jangka waktu
kontraknya (default-nya adalah
5 tahun).

Setelah itu kita harus
menentukan skill. Anda akan
diberi poin skill sebanyak 24 poin,
teknik sebanyak 10 poin, fitness
sebanyak 8 poin, dan taktik
sebanyak 8 poin. Dari ke 24 point
skill, kita harus membaginya ke
set pieces, shooting, heading,
dribbling, passing, dan tackling.
Untuk teknik Anda harus
membaginya ke flair, control, dan
both feet. Untuk fitness Anda
harus membaginya ke pace dan
strength. Dan untuk taktik
bagilah ke positioning dan vision.
Semuanya dapat kita bagi sesuai
keinginan, dan itu merupakan
skill kita di lapangan nantinya.
Semua poin itu dapat kita
naikkan lagi melalui latihan dan
setelah melalui pertandingan-
pertandingan.

Kita dapat melihat jadwal
pertandingan, statistik dan
kontrak, hubungan kita dengan
manajer, teman satu tim,
wartawan, suporter, sponsor,
keluarga, dan pacar. Kalau sudah
kaya, kita bisa mendapatkan
mobil mewah seperti Mercedes
Benz, Audi, Ferrari dan lainnya.
Dan jangan salah dalam
mengambil keputusan, begitu
kita kehilangan uang banyak dan
bangkrut, game over! Hati-hati
dalam membelanjakan uang.

Kita juga akan disuruh
mengambil keputusan, misalnya,
ada teman satu tim kita yang
suka minum alkohol. Apa yang
akan kita lakukan? Apakah
melaporkannya pada bos? Atau
menasehati dia supaya berhenti
minum? Contoh lain adalah,
suatu saat kita diajak teman-
teman untuk pergi ke night club
untuk minum-minum.

Kita dapat menerima ajakan
itu sehingga menaikkan statistik
kita dalam hubungan dengan
teman namun berisiko ketahuan
bos, atau menolaknya dengan
risiko dijauhi teman dan statistik
hubungan dengan teman bisa
menurun.

Dalam pertandingan kita
juga akan disuruh untuk
mengambil keputusan. Misalnya
kita mendapatkan bola, kita
diberikan waktu yang singkat
untuk mengambil keputusan,
apakah akan menggiring,
mengoper ke teman, atau
menembak ke gawang.

Anda inginkan dengan meng-klik
tombol [Remove Frame] atau
[Clear All] untuk menghilangkan
semuanya. Jika Anda menandai
pilihan [Loop Animation], animasi
yang dibuat akan dimainkan seca-
ra terus-menerus, jika tidak, ani-
masi akan dimainkan mulai dari file
GIF urutan pertama sampai terakhir
dan kemudian berhenti. Anda juga
dapat menentukan jeda waktu per-
pindahan frame, dengan mengisi-
kan angka di sebelah [Frame Delay].

Setelah mengatur setting
yang diinginkan, klik tombol
[Make Animated GIF] dan jadi-
lah animasi yang Anda inginkan.
Gampang, kan?

Mukhson Rofi
muxonated@yahoo.com

Tidak ada grafik canggih
dalam game ini. Yang ada
hanya teks dengan sedikit ikon
dan warna-warni. Namun
demikian, game ini tetap asik
untuk dimainkan. Game ini
dapat Anda download di
www.worldcupmanager.co.uk
dengan besar file 649 KB.
Lisensinya shareware.
Pembatasannya adalah kita
hanya bisa memainkan
pertandingkan sebanyak 10 kali.
Selamat bermain!

Jimmy Sundjaja
bintang@rad.net.id
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Mengabadikan Lebaran
Menyimpan Kenangan

Alois Wisnuhardana
wisnu@e-pcplus.com

O

Kalau setiap musim
Lebaran banyak orang
mengeluh soal macet,

capek, letih, repot,
kenapa setiap

tahunnya orang-
orang itu rela

melakukan hal yang
sama dan mau-

maunya menghadapi
masalah-masalah

tersebut? Jawabnya
bisa jadi karena pada
setiap Lebaran orang

selalu disegarkan
kembali, disucikan

lagi, merasa terbasuh
jiwanya dan kembali

menjadi fitri.

leh karena
itu, meski momen
Lebaran senantiasa
berulang setiap tahun,

jutaan orang di  negeri ini tetap
menikmatinya tanpa pernah
merasa bosan meskipun harus
mengulang-ulang ritual
kebudayaan yang sama setiap
tahunnya. Dan karena setiap
Lebaran membawa kesan yang
sedemikian kuat dan membekas
pada ingatan orang-orang yang
menghayati, mengapa kita
tidak mencoba membuat
rekaman kejadiannya,
mengabadikannya, sehingga
suatu saat kita bisa memutarnya

kembali tatkala kita merasa
kangen dan rindu dengan
suasana Lebaran tadi? Atau
memutarnya di saat jiwa kita
letih dan kotor. Siapa tahu
mengenang rekaman Lebaran
menjadikan kita lebih segar.

Kalau Anda belum pernah
membuat rekaman atau
dokumentasi Lebaran Anda,
cobalah membuatnya di Lebaran
tahun ini. Dengan handycam
tentu lebih baik, meskipun
kamera digital atau bahkan
kamera biasa pun cukup. Boleh
jadi, dengan alat yang disebut
terakhir ini, banyak keluarga
sudah melakukannya, jepret sana
jepret sini. Dengan kamera
pocket pun jadi! Sebagian
keluarga yang lain barangkali
juga sudah mempersiapkan
Lebaran dengan kamera
videonya.

BUTUH BAHAN BANYAK
Mengemas hasil

dokumentasi di saat Lebaran
bolehlah kita pikirkan
belakangan pengerjaannya.
Namun, sebaiknya Anda juga
perlu memikirkan sejak awal,
output seperti apakah yang

hendak Anda buat dengan
peralatan yang Anda punya.
Kalau bahannya adalah gambar
video, apakah Anda akan
mengemasnya sesuai dengan
nuansa Lebaran yang Anda
rasakan tahun ini? Atau sekadar
sebuah dokumentasi?

Apabila bekal Anda adalah
kamera biasa atau digital, apakah
output yang Anda inginkan
sekadar gambar yang dicetak di
atas kertas foto, atau Anda ingin
menampilkannya dalam sebuah
slideshow yang bisa dinikmati di
tv melalui VCD/DVD Player Anda?

Tidak ada trik yang paling
baik kecuali bahwa Anda harus
memiliki bahan dasar yang relatif
mencukupi. Dengan bahan yang
banyak, dalam proses editing
Anda akan terbantu untuk
menyusun potongan-potongan
gambar menjadi sebuah cerita
yang menarik ditonton. Oleh
karenanya, persiapkan media
simpan yang cukup banyak,
entah itu berupa miniDV, secure
digital, compact flash, atau Hi8
untuk kamera video, atau SD,
MMC, CF, untuk kamera digital.
Khusus untuk Anda yang hanya
memiliki kamera biasa, untuk

bisa menampilkan di televisi
tentu Anda membutuhkan
scanner untuk memindai gambar-
gambar hasil
jepretan kamera
Anda.

SERBA DIGITAL
Yang tak kalah

penting selain
merekam suasana
Lebaran adalah
membuat jiwa atau
batin Anda tidak
terganggu dengan
suasana kacau dan
ruwet di perjalanan
atau di tempat-
tempat mudik.
Menjaga supaya
batin tetap segar
bisa dilakukan
dengan
mendengarkan
musik-musik favorit
kita.

Yang menjadi masalah, bisa
jadi seluruh lemari CD atau kaset
harus kita boyong karena lagu-
lagu favorit kita berserakan di CD
atau kaset-kaset. Menghindari
hal demikian, alangkah baiknya
bila kita mengompilasi terlebih

dahulu lagu-lagu yang ingin
kita nikmati di perjalanan atau
di kampung, lalu
menyimpannya dalam sekeping
CD dalam format yang relatif
mudah didapat, misalnya CD-
DA. Atau kalau Anda memiliki
player yang portabel, bikinlah
dahulu kompilasi lagu-lagunya,
lalu simpan dalam CD dengan
format yang mendukung player
Anda tersebut.

Repot amat sih! Jangan
khawatir, kami memberikan
langkah-langkah detailnya di
halaman berikutnya. Tak lebih
dari 2 jam, Anda sudah siap
menikmati lebaran digital.
Selamat mencoba! PC+
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Mentransformasi Audio
ke Format MP3

Muhammad Firman
firman@e-pcplus.com

M

OGG, serta WMA dan WAV yang
merupakan standar file audio
milik Windows.

Cara melakukannya sangat
sederhana. Setelah Anda

masukkan CD audio ke CD-ROM
ataupun perangkat optik
lainnya dan menentukan di
drive mana Anda memasukkan
CD tadi, Anda tinggal pilih

track mana yang akan Anda
convert.

Kalau belum pasti, Anda
bisa mencobanya terlebih
dahulu dengan menekan icon

Play. Setelah itu, Anda bisa
mengubah nama file hasil
konversinya kalau perlu.

Saat mengonversi, Anda
dapat menentukan setting bit-

Sejak booming-nya
beberapa tahun lalu,

format file audio MP3
masih merupakan
salah satu format

yang paling populer.
Penyebaran file audio

jenis ini semakin
gencar dengan

bantuan aplikasi peer
to peer yaitu Napster

yang dulu sempat
menghebohkan.

eskipun saat
ini kita tidak lagi
dapat memanfaatkan
Napster secara cuma-

cuma untuk mendapatkan file
MP3, namun kini telah bermun-
culan aplikasi lain yang serupa
dengan Napster. Hal ini membuat
MP3 tetap hidup meskipun cukup
banyak format audio baru.

Faktor lain yang membuat
tetap digunakannya format MP3
adalah banyaknya software yang
dapat mengonversi dari file audio
jenis lain ke MP3. Meskipun dari
sisi kualitas suara musik dalam
format MP3 umumnya masih
di bawah musik
jenis lainnya seperti
CD Audio misalnya,
namun karena
ukuran file-nya yang
lebih kecil hingga mudah
dipindah-pindahkan

membuat MP3 tetap populer.
Di lain pihak, produsen

hardware juga semakin gencar
memproduksi media
penyimpanan yang juga bisa
digunakan untuk memutar file
audio terutama MP3. Bentuk
yang sedang populer saat ini
adalah thumb drive USB yang
juga berfungsi sebagai MP3
player. Vendor-vendor perangkat
rumahan seperti produsen VCD
atau DVD player-pun sudah lama
banyak yang melengkapi
produknya dengan kemampuan
untuk memutar MP3.

Kita akan mengulas cara
mengonversi file audio dari CD
Audio ke format MP3 untuk
kemudian dapat disimpan ke
MP3 player, thumb drive,
ataupun diputar di
VCD/DVD player
tadi.

LANGKAH-LANGKAH
Seperti telah disebutkan di

atas, untuk melakukan konversi
ke MP3 saat ini banyak software
yang bisa kita manfaatkan. Salah
satunya adalah CD to MP3
Ripper yang saat ini sudah
sampai versi 3.50.

Versi trial-nya yang bisa
digunakan untuk mengekstrak
lima lagu pertama dari CD audio
dapat di-download di http://
www.mp3-ripper.net. Selain
dapat digunakan untuk
mengekstrak audio dari CD ke
MP3, software
ini juga
dapat meng-
convert dari
dan ke VQF,

Salah satu thumb drive yang dilengkapi dengan pemutar mp3. Kecil,
multifungsi, dan menyenangkan.

ARE/PCplus
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rate file MP3 yang akan
dihasilkan, apakah
menggunakan CBR (Constant
Bit Rate) ataupun
menggunakan VBR (Variable Bit
Rate). Pada opsi lainnya, Anda
dapat menentukan kualitas
keseluruhan file MP3 nanti
apakah standar-standar saja
atau “sekualitas” studio,
menggunakan kanal stereo,
mono, atau dual channel, serta

Menyimpan Hasil Rekaman
Handycam Digital pada VCD

Cakrawala Gintings
cakra@e-pcplus.com

Menggunakan
handycam pribadi
(non profesional)

untuk mengabadikan
berbagai kegiatan

pribadi rasanya sudah
jamak. Mulai dari

ulang tahun, wisuda,
bahkan acara lebaran
di kampung halaman.

Dengan semakin
terjangkaunya harga

handycam digital,
sudah banyak yang

beralih menggunakan
handycam digital ini.

elebihan
handycam
digital ini antara
lain adalah dalam

urusan mentransfer data.
Handycam digital umumnya
bisa mentransfer data secara
digital, tidak hanya analog
seperti halnya handycam
analog. Memang hasil rekaman
yang dimiliki bisa diputar
langsung pada handycam untuk
kemudian dihubungkan ke TV.
Tentunya lebih fleksibel untuk
menyimpan rekaman tersebut
pada format yang umum
digunakan di rumahan, seperti
halnya VCD ataupun DVD-
Video. Format yang paling
umum tentunya ada VCD.

BEGINILAH CARANYA
Langkah awal dalam

mentransfer data (rekaman)
dari handycam ke PC adalah
melakukan koneksi antara
handycam dan PC.

Pembahasan dalam tulisan
ini lebih ditujukan untuk
koneksi secara digital. Koneksi
secara digital umumnya
dilakukan menggunakan
interface USB ataupun FireWire.

Pada PC masa kini, interface
USB 2.0 sudah menjadi standar
sambungan. Hal ini juga
didukung dengan banyaknya
handycam digital yang

K

menyertakan kabel USB sebagai
peralatan standar dan bukannya
kabel FireWire. Agar koneksi USB
yang dilakukan berhasil,
gunakanlah driver yang

disertakan bersama
handycam bila
memang diperlukan.
Jangan lupa untuk
me-restart sistem bila
memang diminta.
Seringkali driver ini
dianjurkan untuk di-
install terlebih
dahulu sebelum
melakukan koneksi
secara fisik.

Setelah koneksi
terjadi dengan baik
dan benar, langkah
berikutnya adalah
meng-install soft-
ware yang
disertakan bersama
handycam. Bila ada
beberapa jenis
software yang
tersedia dan Anda
memutuskan untuk
tidak meng-install
semuanya, pastikan
software yang bisa

meng-capture video melalui USB
termasuk yang di-install. Jangan
lupa juga untuk kembali me-
restart bila memang diminta.

Setelah itu jalankan software
tersebut dan
pilihlah jenis
koneksi
yang
dilakukan,
dalam hal ini
USB. Bila
langkah-
langkah
yang
dilakukan
sudah benar,
seharusnya
tampilan
pada
software
tersebut
menunjukkan

menentukan kecepatan konversi
kalau Anda menggunakan mode
VBR. Semakin cepat tentunya
kualitas hasil konversi tersebut
semakin menurun.
Semua ini Anda dapat lakukan
lewat menu [Tools]>[Options…]
atau dengan menekan icon
Options.

Setelah selesai menentukan
setting, langkah selanjutnya
adalah menentukan lokasi file

hasil konversi nantinya.
Setelah semua selesai,

langkah terakhir tinggal
mengonversi lewat menu
[File]>[Start Ripping]. Beberapa
saat kemudian, file MP3 hasil
ekstrak dari CD Audio tadi sudah
tersimpan di folder yang Anda
tentukan.

Kecepatan konversi dan
ukuran file MP3 tadi tentunya
tergantung pada setting yang
sudah Anda buat.

Setelah semua file MP3
yang Anda inginkan sudah
selesai, Anda dapat langsung
mengopikannya ke MP3 player
ataupun thumb drive lewat
interface USB yang umumnya
digunakan untuk
menghubungkan ke PC. Bila
ingin dimainkan di VCD player,
Anda tinggal membakar file-file
MP3 tersebut ke CD dengan
software seperti Nero Burning
ROM. PC+

Koneksi fisik sering kali membutuhkan peng-
install-an driver yang disertakan.

Setelah koneksi beres, saatnya meng-install
aplikasi yang tepat.

tanda-tanda
khusus yang
menandakan
koneksi sudah
terjadi dengan
baik dan benar.
Tanda-tanda
ini seharusnya
bisa Anda lihat
pada buku
manual yang
disertakan.
Untuk
memastikan
bisa juga Anda
perintahkan
handycam
Anda tersebut
untuk melakukan playback. Bila
tidak ada masalah, seharusnya
handycam tersebut akan
melakukan hal ini dan pada
tampilan di software yang
bersangkutan Anda bisa melihat
hasil dari playback tersebut.

Setelah memastikan tidak
ada masalah, Anda bisa mulai
melakukan capture. Jangan lupa
untuk memastikan mulai dari
posisi mana yang ingin Anda
capture, misalnya dari awal.
Sering kali terdapat juga

Jangan lupa untuk memilih tingkatan kualitas
MPEG1 yang ingin diperoleh.

Bila sudah tidak ada masalah, saatnya untuk meng-
capture.

beberapa hal yang bisa diatur
seperti misalnya kualitas
gambar dari capture tersebut.
Banyak software yang
disertakan menawarkan fasilitas
konversi ke format MPEG1. Pilih
opsi ini bila memang tersedia

agar file yang
diperoleh
nantinya
sudah
merupakan
file MPEG1.
Bila opsi ini
tidak ada,
jangan lupa
gunakan
software
pihak ketiga
untuk
merubah file
yang
diperoleh
(umumnya
AVI) ke file

MPEG1. File ini kemudian bisa
dibakar menjadi VCD
menggunakan software burning
yang disertakan (bila ada)
ataupun menggunakan soft-
ware burning populer seperti
halnya Nero Burning Rom. PC+
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Merumahkan
Linux Knoppix

diKomputer

D

Willy Sudiarto Raharjo
willy@e-jogja.net

Anda pernah
mendengar nama

distro Linux yang
bernama Knoppix?

Knoppix adalah sebuah
distro Linux (lebih

tepatnya turunan dari
distro Debian), yang

bersifat live CD.
Artinya, distro ini tidak
harus diinstal ke dalam

harddisk untuk bisa
digunakan. Anda

cukup menjalankannya
dari CD sehingga

mudah untuk mencoba
Linux tanpa harus
melakukan proses

instalasi. Proses
instalasi kadang-

kadang cukup
membingungkan dan

menakutkan bagi
mereka yang belum
pernah berkenalan

dengan dunia Linux
sama sekali.

i dalam CD
Knoppix tersebut,
sudah terdapat paket-
paket umum yang biasa

kita jumpai di distro Linux besar,
seperti: OpenOffice, KOffice,
XMMS, GIMP, Konqueror, dan
sebagainya. Namun ada
beberapa pengecualian, yaitu
beberapa paket yang memang
sangat besar dan kiranya tidaklah
umum digunakan oleh home
user, mengingat kapasitas CD
yang terbatas, yaitu sekitar
700MB.

CD LIVE: SEKADAR
NUMPANG JALAN

Kepraktisan itu ada
batasnya. Mungkin ungkapan
itulah yang terbesit di antara
para developer Linux Knoppix,
sehingga mereka merasa bahwa
Linux Knoppix hanya bisa
digunakan sebagai “bahan
demo”, dan bukan sebagai
sebuah distro Linux resmi, karena
selama operasionalnya, Knoppix
tidak mempunyai sebuah tempat
khusus di dalam harddisk.
Knoppix hanya memiliki tempat
di memori utama (RAM),
sehingga setelah di-restart,
semua isi RAM akan
dikosongkan. Dan Knoppix harus
melakukan inisialisasi ulang
untuk mendeteksi semua
perangkat keras yang dimiliki
oleh user.

Selain itu, kinerja dari
Knoppix sendiri juga tidak bisa
maksimal, karena kecepatan
komputer untuk mengakses
harddisk jauh lebih cepat
dibandingkan dengan kecepatan
mengakses CD-ROM, yang
notabene adalah media untuk
menjalankan Knoppix. Dari fakta
ini, kita bisa menyimpulkan
bahwa Knoppix membutuhkan
spesifikasi komputer yang
“cukup” agar bisa digunakan
dengan nyaman. Untuk itu, mulai
versi 3.2, Knoppix sudah
dirancang agar dimungkinkan
untuk menginstal Knoppix ke
dalam harddisk, sehingga

statusnya berubah menjadi
sebuah distro Linux tulen.

Jika Anda sudah terbiasa
dengan Knoppix, maka
menjalankan Knoppix secara
langsung dari CD tampaknya
bukan menjadi sebuah solusi
alternatif yang bagus, karena
berbagai keterbatasan yang
dimilikinya. Untuk itu, sebaiknya
Anda mengopi file Knoppix ke
dalam harddisk. Tujuannya
adalah mempercepat proses kerja
dan juga mereduksi sebagian
keterbatasan yang dihadapi.
Untuk proses tersebut, Anda bisa
menggunakan harddisk yang
sudah ada maupun dengan
menyiapkan harddisk baru
dengan kapasitas yang tidak
terlalu besar. Untuk mengopi
semua file Knoppix, cukup

diperlukan sekitar 3-4GB
(termasuk untuk partisi /swap).

PENGELOLAAN PARTISI
Untuk memudahkan

pengelolaan partisi, Anda bisa
menggunakan software partisi,
seperti Partition Magic (Win-
dows) atau Presizer (gratisan di
Internet, ukurannya 98KB) agar
tidak merusak data-data Anda.
Jika tidak ingin menggunakan
software tersebut, Anda bisa
menggunakan software
pengelola partisi bawaan dari
Knoppix atau distro Linux
lainnya, tetapi diperlukan sedikit
pemahaman teknis tentang
penamaan harddisk di Linux. Hal
ini disebabkan karena Linux

menganut sistem penamaan yang
berbeda dengan Windows. Jika di
Windows kita mengenal partisi C,
D, E, dan seterusnya, maka di
Linux nama-nama partisi tersebut
disesuaikan dengan nomor
harddisk dan jenisnya. Untuk
harddisk pertama, namanya
adalah /dev/hdaX, di mana X
merupakan nilai yang
menunjukkan jenis partisi. Untuk
partisi aktif, nilai X berkisar
mulai dari 1 hingga 4. Sedangkan
untuk partisi logical atau
extended, nilai X dimulai dari 5.
Untuk harddisk kedua,
penamaannya juga sama, yaitu /
dev/hdbX.

PROSES INSTALASI
Setelah Anda siap dengan

partisi baru tersebut, maka

jalankan Knoppix dari CD, tetapi
Anda perlu menentukan option
tambahan, agar Knoppix
dijalankan tanpa mode grafis
(text mode). Bagi Anda yang
sudah mengubah password root
Knoopix, maka Anda bisa
melakukan pengopian dari mode
grafis. Sebagai catatan, Knoppix
tidak menyediakan password
untuk user root dan knoppix,
sehingga Anda harus masuk ke
terminal 1 untuk mengubahnya
terlebih dahulu sebelum bisa
bekerja dengan user root.

Untuk menjalankan dalam
mode text, berikan option init 1
atau init 2 pada saat muncul
layar boot. Setelah Anda login
dengan baik, siapkan sebuah

mount point pada direktori /mnt,
misalnya /mnt/knoppix, dengan
perintah mkdir /mnt/knoppix.
Setelah membuat mount point,
lakukan mounting terhadap
partisi baru yang telah Anda
siapkan (diasumsikan Anda
membuatnya menjadi /dev/hda6)
dengan perintah mount /dev/
hda6 /mnt/knoppix. Lalu kopi
seluruh file yang berada di
bawah direktori /KNOPPIX dari
CD ke dalam direktori /mnt/
knoppix dengan perintah cp /
mnt/cdrom/KNOPPIX/* /mnt/
knoppix. Harap bersabar, karena
besarnya mencapai 695MB.

Setelah proses pengkopian
selesai, langkah selanjutnya
adalah mengedit file /mnt/
knoppix/etc/fstab yang akan
mengatur partisi apa saja yang

akan di-mount pada saat boot
up. Berikan perintah ini pada
baris pertama : /dev/hda6 / ext3
defaults 1 1  (perhatikan,
terdapat jarak sebuah tab di
antara keenam parameter).
Langkah selanjutnya adalah
memberitahu Lilo bahwa lokasi
root ada pada /dev/hda6.
Bukalah file /mnt/knoppix/etc/
lilo.conf dengan editor teks
(misalnya vi) dan ubahlah
menjadi seperti berikut:
lba32
boot=/dev/hda
install=/mnt/knoppix/boot/
boot-menu.b
map=/mnt/knoppix/boot/map
prompt
timeout=100

vga=normal
image=/mnt/knoppix/boot/
vmlinuz
appen=”lang=en”
root=/dev/hda6
label=Knoppix
read-write

Simpan dengan menekan
tombol [Esc], lalu dilanjutkan
dengan :wq. Berikan perintah
lilo -C /mnt/knoppix/etc/
lilo.conf agar Lilo membaca file
konfigurasi yang baru. Jika tidak
ada pesan kesalahan, maka
Knoppix Anda sudah dapat di-
boot dari harddisk. Sebagai tam-
bahan saja, Anda bisa membuat
sebuah direktori home untuk
user knoppix agar Anda bisa
bekerja dengan lebih terorganisir
dengan perintah mkdir /mnt/
knoppix/home/knoppix dan
jangan lupa untuk mengubah
kepemilikannya dengan perintah
chown knoppix.knoppix /mnt/
knoppix/home/knoppix. Jika se-
mua langkah di atas sudah diker-
jakan, Anda bisa mengujinya
dengan me-reboot komputer dan
cobalah untuk login tanpa
menggunakan CD Knoppix.

KONFIGURASI
YANG PERMANEN

Bagaimana dengan file
konfigurasi Anda? Anda bisa
menyimpan file konfigurasi Anda
agar tetap berada pada harddisk
dan tidak akan hilang ketika
proses reboot terjadi. Caranya
adalah dengan memilih menu K
> KNOPPIX – Configure _ Save
KNOPPIX Configuration.
Pilihlah semua file konfigurasi
yang akan Anda simpan, lalu
tekan [OK]. Pilihlah partisi untuk
menyimpan file tersebut, lalu
tekan [OK]. Untuk mengaktifkan
pilihan tersebut, Anda harus
mengetikkan salah satu option
berikut pada saat layar boot
knoppix myconfig=<letak_
konfigurasi_Anda> atau
knoppix myconfig=scan
(Knoppix akan melakukan
pencarian secara otomatis).

Selamat mencoba memberi
sebuah tempat tinggal bagi
Knoppix Anda. PC+
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A Journey to Pa
Bermain Mas

Vincent Bayu Tapa Brata
vincent@e-pcplus.com

Apakah GIMP mampu diajak bermain-main
masking seperti Adobe Photoshop? Jawabannya:

bisa. Dalam latihan kali ini kita akan
memanfaatkan masking untuk

menyembunyikan bagian gambar yang tidak
diperlukan. Selain itu, masking akan digunakan
untuk membuat pinggiran gambar yang halus.

Penyembunyian bagian gambar ini bersifat tidak
tetap. Jadi, dapat ditampilkan kembali jika

diperlukan.

1. Buka gambar Angkasa Luar. Jadikan gambar ini sebagai latar belakang
sekaligus bidang/kanvas kerja.

2. Buka gambar Kapal. Klik kanan di area gambar. Pilih [Select]>[All]. Klik kanan
lagi, pilih [Edit]>[Copy].

3. Aktifkan kanvas kerja (gambar Angkasa Luar). Klik menu [File] pada palet
Toolbox. Pilih [Dialogs]>[Layer, Channels & Path]. Klik ikon [New Layer]. Klik
kanan di kanvas kerja, pilih [Edit]>[Paste]. Klik ganda layer bar baru (floating
selection) untuk menjadikan layer tetap. Bila perlu, ubah nama layer ini dengan
klik kanan pada layer bar dan pilih Edit Layer Properties.

4. Aktifkan layer Kapal.
Sesuaikan ukuran
dengan klik ganda
[Transform Tool] pada
palet [Toolbox]. Pilih
Scaling pada kotak
dialog. Klik pada layer
Kapal. Drag handle
point untuk
menyesuaikan ukuran
kapal. Perhatikan
proporsi X dan Y di
kotak dialog Informasi.
Usahakan agar proporsi
tersebut sama.

5. Jika handle point tidak
tampak, perkecil
tampilan dengan klik
[Zoom Tool] pada palet
Toolbox. Setelah klik di
layer, Anda bisa

mengubah ukuran tampilan tampilan dengan
menekan tombol [+] atau tombol [–] pada keyboard.

6. Letakkan layer Kapal pada posisi yang tepat. Jika kesulitan, turunkan opacity
(transparansi layer) pada palet Layer sehingga gambar latar belakang bisa
terlihat. Geser dengan [Move Tool] pada Toolbox.

7. Aktifkan layer Kapal. Klik
kanan pada layer bar, lalu
pilih [Add Layer Mask].

8. Klik tool Paintbrush pada palet Toolbox. Klik ganda lagi tool Paintbrush
untuk memunculkan [Tool Options] yang berguna untuk mengatur kekuatan
sapuan brush (dengan menggeser slider [Tool opacity]). Klik ganda pada ikon
[Brush] di palet Toolbox untuk mengatur ukuran brush dan pola sapuan
brush.

9. Pilih nada gelap pada palet Foreground color pada  palet Toolbox. Sapukan
tool Paintbrush pada bidang gambar kapal yang tidak diperlukan.Slider layer opacity Move tool

Pilihan scaling

Transform toolRasio X dan Y

Handle point

Layer bar

Ikon new layer

Slider tool/brush
opacity

Klik untuk
aktifkan mask

Nada gelap
Ikon brush size dan pattern Pintbrush tool
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ass Nightmares:
king di GIMP

10. Masukkan gambar-gambar penunjang (mata).
Kemudian beri mask dan haluskan pinggiran gambar
seperti langkah 6, 7, dan 8.

11. Save as pekerjaan kita dalam format default GIMP (.XCF)
yang memuat informasi layer.

Palet-palet dan kotak-kotak dialog di GIMP memang cenderung
tersebar sehingga sering menjadikan kita agak bingung dan repot.
Kelemahan ini patut diakui. Di samping itu, banyak proses yang
tidak menyertakan preview sehingga jika hasilya kurang sesuai
dengan derajad yang kita inginkan, harus diulang dan mengubah
parameter.

Kita tidak ingin terikat oleh satu alat kerja. Jangan sampai satu
software membatasi kreativitas  dan imajinasi. Adobe Photoshop
yang kini menjadi barometer software penyunting citra pada versi-
versi awalnya dulu (versi 3) juga memerlukan banyak penyesuaian
dari pemakainya. Namun demikian, ternyata logika-logika digital
imaging seperti: layer, masking, channel, mode warna, filter, seleksi
tetap sama pada semua software pengolah citra.

Tidak ada jalan lain kecuali banyak berlatih, menemukan
kesulitan dan memecahkannya. Selamat mencoba. Pertanyaan dan
permintaan source file berformat XCF dapat dialamatkan ke e-mail
penulis. PC+

Zoom tool

Paintbrush tool

Palet brush size dan pattern
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Fungsi-fungsi
Filesystem Di PHP

(Bagian 3 - habis)

Yahya Kurniawan
yahya@e-pcplus.com

Kita telah banyak
belajar tentang fungsi
file system dari fungsi-
fungsi yang dijelaskan

pada dua edisi terakhir.
Ternyata masih ada

beberapa fungsi yang
belum sempat dibahas.

ah, kali ini
beberapa fungsi yang
tergolong ke dalam
fungsi file system akan

dibahas. Fungsi-fungsi tersebut
adalah:

Fungsi fgetcsv()
Fungsi ini masih merupakan

bagian dari fungsi-fungsi baca-
tulis seperti yang kita bahas ming-
gu lalu. Fungsi ini digunakan un-
tuk membaca file dengan format
CSV (Comma Separated Value).

File dengan format CSV
adalah file teks biasa yang dapat
diperlakukan seolah-olah sebagai
sebuah database dengan field
yang satu dan yang lain
dipisahkan dengan karakter
koma. Itulah sebabnya disebut
dengan Comma Separated Value
atau nilai yang dipisahkan
dengan koma.

Tanda koma ini bisa juga
diganti sendiri sesuai dengan
kebutuhan Anda karena pada
suatu kasus penggunaan tanda
koma justru bisa
membingungkan, misalnya jika
nilai pada sebuah field diijinkan
mengandung koma sehingga
akan sulit dibedakan mana koma
yang merupakan pemisah suatu
field, mana koma yang
merupakan nilai dari suatu field.

Sintaks dari fungsi ini adalah
sebagai berikut:

fgetcsv(stream, panjang [,
delimiter
[, penutup]])

Seperti telah dibahas tadi,
nilai default parameter
delimiter adalah koma.

Minggu depan PCplus akan
secara spesifik membahas
penggunaan fungsi ini. Namun
mungkin untuk sekadar contoh
dapat diberikan sebagai berikut:

$baris = 1;
$fp = fopen("test.csv","r");
while ($data = fgetcsv ($fp,
1000, ",")) {

$jumlah = count
($data);

print "<p> $jumlah
field pada baris $baris: <BR>";

$baris++;
for ($i=0; $i < $jumlah;

$i++) {
print $data[$i]

. "<BR>";
}
}
fclose ($fp);

Fungsi copy()
Fungsi ini digunakan untuk

menyalin file, baik ke direktori
lain ataupun menjadi file dengan
nama yang lain. Sintaksnya
adalah sebagai berikut:
copy(sumber, tujuan)

Contoh:
copy("/home/user/dir1/
file1.txt","/home/user/dir1/
file1.txt")

Fungsi dirname()
Fungsi ini digunakan untuk

melihat komponen direktori dari
suatu path. Sintaksnya adalah
sebagai berikut:

dirname(path)

Contoh:

$path = "/home/yahya/
test.txt";
$dir = dirname($path);

Isi variabel $dir adalah "/
home/yahya"

Fungsi basename()
Fungsi ini digunakan untuk

melihat komponen nama file dari
suatu path. Sintaksnya adalah
sebagai berikut:

basename(path [,ekstensi])

Jika parameter ekstensi
disertakan, maka jika komponen
nama file dari suatu path
mengandung ekstensi tersebut,
ektensi itu tidak akan disebutkan.
Contoh:

$path = "/home/yahya/
test.txt";
$file1 = basename($path);
$file2 =
basename($path,".txt");

Isi dari $file1 adalah
"test.txt", sedangkan isi dari
$file2 adalah "test".

Fungsi pathinfo()
Fungsi ini digunakan untuk

melihat informasi dari suatu
path. Informasi yang tersedia
adalah informasi mengenai
komponen direktori, nama file,
dan ekstensi file yang disimpan
dalam array. Indeks dari array
tersebut masing-masing adalah
dirname, basename, dan

extension. Sintaks dari fungsi ini
adalah sebagai berikut:

pathinfo(path)

Contoh:
$path = "/home/yahya/
test.txt";
$info = pathinfo($path);

Isi dari $info[dirname]
adalah "/home/yahya".

Isi dari

$info[basename] adalah
"test.txt".

Isi dari
$info[extension] adalah "txt".

Fungsi realpath()
Fungsi ini

digunakan untuk
melihat path
sesungguhnya
dari sebuah file
atau path.
Sintaksnya adalah
sebagai berikut:

realpath(path)

Berikut akan
diberikan
contohnya dalam
bentuk skrip PHP
lengkap:

<HTML>
<HEAD>
<TITLE>Fungsi
Filesystem
</TITLE>
</HEAD>

</BODY>
</HTML>
<?
$path = "filesystem.php";
$real = realpath($path);
?>

Pada browser, Anda
mengakses file ini dengan
nama <BR>
http://namaserver/pcplus/
filesystem.php. <BR>

Pada server, letak
sesungguhnya dari file
filesystem.php <BR>
adalah di <?=$real?>
</FONT>

</BODY>
</HTML>

Jika skrip ini dijalankan,
hasilnya akan nampak seperti
Gambar 1.

Fungsi ini berguna apabila
Anda mengupload aplikasi Anda
ke server dan Anda tidak tahu
dengan pasti path absolut dari
file-file Anda. Umumnya Anda
hanya diberi tahu bahwa letak
file-file Anda dapat diakses di
http://namaserver/namadir/
namafile, tanpa tahu letak path
absolutnya di server. Jika Anda
terbiasa juga menggunakan ASP,
fungsi ini ekivalen dengan
metoda Server.MapPath.

Fungsi
clearstatcache()

Pada penggunaan fungsi-
fungsi tertentu, informasi yang
dihasilkan fungsi-fungsi tersebut
akan tersimpan dalam cache. Ini
akan mempercepat performa dari
fungsi-fungsi tersebut. Hanya saja
kadang-kadang memang
informasi cache tersebut harus

dihapus sebelum fungsi yang lain
dapat dipergunakan, misalnya
jika ada sebuah file yang
diperiksa beberapa kali oleh
fungsi-fungsi berbeda. Fungsi ini
digunakan tanpa parameter.

Fungsi-fungsi File
Yang dimaksud dengan

fungsi-fungsi file adalah fungsi-
fungsi yang digunakan untuk
mengetahui karakteristik sebuah
file. Hasil dari fungsi-fungsi ini

akan disimpan dalam cache.
Fungsi-fungsi tersebut adalah:

fileatime() : mengambil waktu
saat terakhir kali
file diakses.

filectime() : mengambil waktu
saat inode file
berubah.

filegroup() : mengambil nama
group pemilik file.

fileinode() : mengambil nilai
inode file.

filemtime(): mengambil waktu
saat terakhir kali
file dimodifikasi.

fileowner() : mengambil nama
pemilik file.

fileperms() : mengambil nilai
permission file.

filesize() : mengambil
ukuran file,
dalam byte.

filetype() : mengambil tipe
file. Nilai yang
mungkin adalah
fifo, char, dir,
block, link, file,
dan unknown.

Contoh:
<HTML>
<HEAD>
<TITLE>Fungsi-fungsi File
</TITLE>
</HEAD>

<BODY>
<?
$file = "/home/yahya/test.txt";
$file1 = date("d-m-
y",fileatime($file));
$file2 = date("d-m-
y",filectime($file));
$file3 =
posix_getgrgid(filegroup($file));
$file4 = fileinode($file);
$file5 = date("d-m-
y",filemtime($file));
$file6 =
posix_getpwuid(fileowner($file));
$file7 = fileperms($file);
$file8 = filesize($file);
$file9 = filetype($file);
?>
Nama file = <?=$file?> <BR>
Tipe file = <?=$file9?> <BR>
Ukuran file = <?=$file8?>
bytes <BR>
Terakhir kali diakses =
<?=$file1?> <BR>
Terakhir kali dimodifikasi =
<?=$file5?> <BR>
Inode file = <?=$file4?> <BR>
Saat inode berubah =
<?=$file2?> <BR>
Nama pemilik =
<?=$file6["name"]?> <BR>
Nama grup pemilik =
<?=$file3["name"]?> <BR>
Permission file = <?=$file7?>

</BODY>
</HTML>

Jika skrip ini dijalankan,
hasilnya akan seperti Gambar 2.

Sebenarnya masih ada
beberapa fungsi file system yang
lain, akan tetapi rasanya tidak
mungkin jika semua harus
diterangkan.

PCplus telah mencoba
memilih fungsi-fungsi yang
membutuhkan penjelasan khusus
dan itulah yang kami angkat di
tiga edisi belakangan ini. Untuk
fungsi yang lain silakan Anda
merujuk ke PHP manual. PC+

Gambar 1

Gambar 2
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Bagi pembaca yang tertarik untuk berinteraksi di rubrik ini, silakan
mendaftar dengan mengirimkan e-mail  kosong ke mailplus-

subscribe@yahoogroups.com.
Agar keanggotaan Anda segera diaktifkan, balas e-mail konfirmasi yang

dikirimkan oleh Yahoo ke alamat e-mail Anda. Setelah terdaftar, Anda dapat
mengirimkan e-mail pertanyaan ataupun tukar menukar pengalaman

seputar dunia komputer.
Jangan lupa untuk memeriksa account e-mail Anda secara rutin. Jika Anda

tertarik untuk berdiskusi langsung secara online, silakan Anda join ke server
DALnet pada channel #chatplus di mIRC.

PENTING!!!
Kalau Anda ingin menerima dan membaca e-mail secara digest (satu e-
mail berisi beberapa message), kirim e-mail kosong ke mailplus-

digest@yahoogroups.com. Sebagai informasi, setiap hari Jum’at hingga
Minggu adalah hari bebas di milis ini.

Setiap anggota dapat mem-posting e-mail diluar seputar masalah
komputer asalkan tidak mengandung SARA, pornografi, bajak-membajak

software, flamming, dan sebagainya. Jika Anda tidak ingin menerima e-mail
OOT (Out Of Topic), kirim e-mail ke mailplus-nomail@yahoogroups.com, dan
silakan Anda aktifkan kembali ke mode normal dengan mengirim e-mail ke

mailplus-normal@yahoogroups.com.
•Redaksi

Bunyi-bunyian pada
Komputer

Saya punya masalah nih
teman-teman Mailplus. To the
point aja yach. Sekarang ini,
komputerku kalau saat booting
mengeluarkan bunyi
tut...tut...tut... (terus-menerus).
Tetapi biasanya kalau saya boot
ulang dengan menekan
reset....reset...reset... (beberapa
kali sampai bosan) kadang-

kadang mau masuk ke sistem
operasi dan muncul pesan CMOS
ERROR Checksum dan tekan F1
untuk melanjutkan terus sampai
masuk pada sistem operasi.

Tetapi kalau kemudian saya
boot ulang, bunyi-bunyian
tersebut muncul lagi tuh. Sebagai
informasi, spesifikasi komputerku
Pentium-III 600MHz,
motherboard Asus P2BF (slot 1),
SDRAM 64MB, kartu grafis S3
TRIO 3D/2X dan monitor Samsung

551V. Apakah ada yang tidak
kompatibel pada spesifikasi
komputerku ini? Tolong dong
solusinya.

s4h4r_boycomp

Jawab:
Kemungkinan VGA atau me-

mori komputer Anda kendor. Coba
Anda copot VGA card-nya dan me-
morinya sekalian, bersihkan konek-
tornya dari debu pakai penghapus

Pertanyaan Seputar Linux

Cukupkah Celeron 1800MHz?

Para miliser, saya mau
tanya-tanya soal Linux nih.
Sebelumnya, spesifikasi
komputerku sebagai berikut:
• Prosesor Celeron

(Mendocino) 500MHz
• RAM 128MB (Share VGA

8MB)
• Harddisk IDE 5400rpm 4,3GB
• Monitor LG 15”
• Sound Card On Board
• CD-ROM Creative 54X
• Mouse dan Keyboard PS/2

Dengan spesifikasi di atas,
aku pernah meng-install Linux
Mandrake 8.0 dengan lancar
dan gak ada masalah. Sekarang
kan ada salah satu distro Linux
yang bisa booting dari CD-ROM
yaitu Knoppix 3.2 dan saya
tertarik untuk mencobanya.

Saat saya coba, pada saat
loading mode grafis, monitor
tiba-tiba mati. Padahal
sebelumnya sewaktu saya
menggunakan Linux Mandrake

tidak ada masalah. Sebenarnya,
gimana sih langkah-langkah yang
benar mulai dari mempartisi
pakai cfdisk sampai install Linux
Knoppix 3.2? Sebelumnya aku
ucapkan terima kasih kepada
para miliser sekalian.

Arman

Jawab:
Kalo mau belajar Linux

secara instalasi, mendingan
jangan pakai Linux Knoppix dan
turunannya. Pakai saja Linux
yang wajib di-install (gue saranin
coba Mandrake yang enak
pakainya). Knoppix hanya untuk
di-boot dari CD dan pakai dari
sana, meskipun ada cara tertentu
yang bisa membuat Knoppix bisa
diinstalasi ke harddisk.

Kalo buat di-install lebih
bagus yang memang musti di-
install.

Kalo masalah monitor blank,
kayaknya tuh Knoppix gak bisa

menemukan jenis monitor Anda
deh. Atau monitor itu tidak
mendukung resolusi 1024x768.
Soalnya di Linux, biasanya
resolusi tersebut yang banyak
digunakan. Kalo MS Windows
kan default-nya cuma 800x600
untuk Windows XP. Kalo
Windows 9x default-nya malah

Halo semua, saya mau
tanya. Apakah Celeron
1800MHz sudah cukup untuk
menjalankan aplikasi-aplikasi
sederhana seperti: browsing
Internet, bermain game yang
ringan-ringan, dan transfer
VCD? Maksud saya transfer VCD
begini nih. Saya kan ada
handycam yang bisa
dihubungkan ke komputer
lewat USB, nah saya mau
pindahin tuh gambar di kaset
handycam ke CD. Cukup nggak
ya Celeron 1800 untuk
mengerjakan itu? Gitu loh.

Satu lagi, motherboard apa
yang bagus yang dilengkapi
dengan fasilitas kartu grafis dan
sound onboard? Terima kasih
sebelumnya. Salam.

Prihastomo

Jawab:
Kalo sekadar buat aplikasi

sederhana seperti Office,
Internet, game yang ringan
(bukan heavy and full 3D) sih
sudah bisa tuh. Jangankan
Celeron 1,8GHz, gue aja yang
pakai Celeron 800 yang di-
overclock menjadi sedikit di atas
1GHz aja masih lancar untuk
bermain game jaman sekarang.
Browsing internet juga sangat
lancar. Sebagai informasi, gue
langganan Internet pake Centrin.
Ngomong-ngomong, Anda meng-
gunakan memori berapa MB?

Kalo untuk transfer gambar
semacam itu, kayaknya Celeron
1,8GHz Anda sudah cukup. Kalo
mau streaming dan encoding
juga bisa. Cuma masih makan
waktu cukup lama tuh (apalagi
pas nge-render-nya). Mungkin

sebaiknya pakai Pentium-4
Hyper Threading, itu kalo Anda
punya dana berlebih. Kalo bujet
mepet, bisa pilih pakai
AthlonXP yang lebih kenceng
dengan harga yang sama. Yang
penting hubungan kompie
dengan handycam bisa. Untuk
mengopi file tersebut nantinya
ke CD alias untuk bakar-
bakaran, prosesor itu juga dah
cukup.

Untuk motherboard yang
memiliki chip grafis dan sound
onboard, rata-rata produk
motherboard yang saat ini
beredar tidak memiliki
perbedaan yang terlalu jauh
dari sisi kinerjanya. Saran saya,
yang penting perhatikan chipset
yang digunakan pada
motherboard tersebut.

Ronny, mbUdh

pensil, setelah itu coba pasang lagi.
Coba periksa juga baterai CMOS-
nya, mungkin sudah soak.

By the way, Anda yakin Anda
menggunakan prosesor Pentium-
III 600MHz? Atau hasil overclock?
(semula Pentium-III 450MHz jadi
Pentium-III 600MHz).

Soalnya setahu saya gak ada
Pentium-III 600 yang berbentuk
slot, paling tinggi cuma 550MHz
lho. Atau Anda sudah memakai
socket konverter?

Adhitya F. Anggoro, Mat Gemboel

Outlook Express Error
Selalu

Rekan-rekan, gue punya
masalah sama Outlook Express
nih. Di komputer gue ini, kalau
gue mau jalanin Outlook Express
selalu ada pesan error yang
bunyinya kurang lebih seperti ini:

“The connection to the
server has failed. Account:
'Work', Server:
'pop.cbn.net.id', Protocol:
POP3, Port: 100, Secure(SSL):
No, Socket Error: 10061, Error
Number: 0x800CCC0E”

Kira-kira ada masalah apa ya
pada Outlook Express gue ini?

Terima kasih sebelumnya atas
bantuan rekan-rekan. Salam.

Rezki Darhanto

Jawab:
Kayaknya servernya lagi nge-

drop tuh Pak. Saya juga pernah
ngalamin kayak begitu. Biasanya
nanti juga akan normal lagi.
Kemungkinan lain yang bisa
membuat Outlook Express
menampilkan pesan error sepert
itu adalah karena setting account
e-mail yang belum benar, koneksi
yang sangat lambat, dan Internet
yang putus tiba-tiba (biasanya
kalau dalam jaringan). Tetapi
kalau di rumah sih saya gak
pernah mengalami hal seperti itu.
Padahal saya juga menggunakan
ISP yang sama seperti Anda. Atau
jangan-jangan Anda salah mema-
sukkan nomor koneksi ke ISP?

Jadi, sekarang coba Anda
periksa lagi. Setting account-nya
sudah benar belom? Terus
gimana dengan browsing
internet lewat Internet Explorer
apa bisa lancar walaupun OE-nya
ngadat? Kalau bisa browsing,
berarti tinggal periksa setting
account-nya saja.

BeCuS, pramudya_xxx, edy
chandra
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cuma 640x480. Sedangkan kalo di
Linux yang di-install, kita kan bisa
set resolusi-nya menjadi
berapapun pada saat instalasi,
tidak otomatis dijadikan
1024x768.

Kalo masih mau coba
Knoppix dengan resolusi
berbeda, bisa lihat help-nya saat

booting awal. Jangan langsung
pencet [enter], tapi pencet yang
lain mungkin F1, F2 atau yang
lainnya (sori gak hapal, sudah
lama gak pakai Knoppix sih)
dulu pernah sih, cuman coba-
coba aja.

mbUdh



plusProduk IV • 18 November - 01 Desember 2003
PCplus 153

24 |

AudiMax:
Kartu Suara Eksternal,
Lebih Mobile

Kamera Digital Umax AstraPix 660:

Bisa Digeber Hingga 6 Megapixel

Umaxindo Persada
www.umax.co.id
☎ (021) 6122781
Rp. 1.800.000,-

i-Drive:

Pen Drive Sekaligus
Kamera dari Cryptonix

Mostech Gigadonics
www.mostech.web.id

☎ (021) 9253484
Rp. 720.000,-

PT Leapfrog Indonesia
www.leapfrogasia.com

☎ (021) 66604784
± Rp. 475.000 - 600.000

Umax yang baru
sekitar dua tahun
belakangan ini ikut terjun ke
pasar kamera digital kembali
mengeluarkan beberapa tipe
terbarunya yang meramaikan
pasar entry level. Salah satu
produk terbaru yang
dikeluarkannya adalah AstraPix
660 yang berwarna dasar putih
metalik.

Dilihat dari ukurannya yang
mini, kamera digital yang
lensanya mampu menghasilkan
digital zoom sebesar 2 kali ini
memang tergolong kamera saku
dengan fitur yang tidak terlalu
rumit. Selain dilengkapi dengan
layar LCD yang cukup tajam
untuk melihat objek, kamera
yang dilengkapi dengan sebuah

tombol untuk melakukan zoom
ini juga dilengkapi dengan
jendela bidik. Namun, dengan
jendela bidik yang terpisah dari
lensa utamanya, paralaks pasti
timbul bila pengguna
memanfaatkan jendela bidik ini
untuk mengabadikan objek.

Seperti juga tipe AstraPix
terbaru lainnya, AstraPix 660 ini
juga dilengkapi dengan fitur
interpolasi. Adanya fitur semacam
ini memungkinkan adanya
peningkatan resolusi menjadi
lebih maksimal dari resolusi
maksimal sebenarnya yaitu  3,3
megapixel menjadi sebesar 6,6
megapixel. Meskipun demikian
harus diakui kualitasnya tidak
sebaik kamera dengan resolusi 6,6
megapixel murni. Alhasil kamera

ini dapat memotret objek dengan
resolusi gambar sebesar
2976x2240. Adanya fitur semacam
ini tentu cukup membantu bila
penggunanya menginginkan
gambar yang lebih tajam dan
berukuran besar.  Kekhususan lain
dari kamera yang juga dilengkapi
dengan port untuk TV out ini
adalah fasilitas macro mode untuk
mengambil gambar-gambar
sangat dekat dan berukuran kecil.

Fitur lain yang dimiliki
kamera yang memiliki lampu flash
ini juga tergolong cukup banyak.
Pada bagian atas, lima buah
tombol diusung oleh Umax,
masing masing untuk tombol on/
off. Shutter release, tombol fitur,
tombol mode untuk menampilkan
image yang sudah dihasilkan, dan

tombol untuk
mengatur layar LCD.

Selain
dilengkapi dengan
layar LCD, kamera
yang memiliki
build in memory
8MB pada
bagian
belakangnya ini
juga dilengkapi
dengan 5 buah
tombol pengatur plus tombol
zoom. Tak lupa, Umax juga
menyertakan dua buah lampu
indikator yang menyala bila
lampu flash sedang bekerja dan
sistem sedang melakukan proses
pemotretan serta penyimpanan.

Untuk memori tambahan,
produsennya menyertakan sebuah
slot untuk multimedia card
ataupun secure digital yang
berada sejajar dengan tempat
kedudukan baterai AA yang
dipakai. Sementara, untuk
transfer file ke PC, disertakan port

USB dengan kabel
transfernya. Kekurangan dari
kamera ini adalah proses adanya
shutter lag yang cukup lama bila
menggunakan resolusi tinggi
sehingga agak sulit untuk
memotret objek yang bergerak
cepat. (sil)
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Berbagai
macam storage
alias media penyimpan
data sekarang ini memang
banyak bermunculan. Salah
satu jenis storage yang saat ini
cukup fenomenal dan paling
banyak dikembangkan adalah
pen drive alias thumbdrive.
Salah satu brand yang cukup
banyak memiliki jenis pen drive
adalah Cryptonix. Produk
terbarunya yang sangat inovatif
adalah i-Drive.

Secara sepintas, produk ini
memang tidaklah istimewa.
Seperti kebanyakan pen drive
lainnya, i-Drive ini sudah
menggunakan interface jenis

Sudah banyak
kartu suara yang
beredar di pasaran dengan
keunggulan masing-masing.
Namun, rata-rata kartu grafis
yang beredar tersebut adalah
tipe internal yang
memanfaatkan slot PCI pada
motherboard. Akibatnya, bila
PCI yang disediakan terbatas,
banyak yang lebih memilih
kartu suara onboard. Sonic
Gear yang berkecimpung dalam
urusan audio ternyata memiliki
pula kartu suara eksternal
berbasis USB.

Sebagai tipe eksternal,
kartu suara dengan bit resolu-

universal serial bus terbaru yaitu
versi 2.0. Alhasil untuk urusan

transfer data ke PC yang
memiliki port USB 2.0

bukan lagi masalah.
Maklum,
maksimal

kemampuan
transfer file-nya

dapat mencapai
480Mbps.
Seperti juga
pada
kebanyakan

produk sejenis,
interface yang dipakai ini
dilindungi dengan penutup agar
terhindar dari kotoran.

Keunikan dari i-Drive dengan
warna dasar putih metalik ini
adalah adanya kamera mini yang
terintegrasi pada body-nya.
Kamera mini yang secara kasat
mata berwarna merah dan
bentuknya sangat kecil ini
membuat produk ini juga dapat
difungsikan sebagai webcam,
kamera digital, sekaligus video

camera sederhana. Fasilitas ini
dimungkinkan bila penggunanya
menginstal pula software
bawaannya yaitu A&W
CamMagic 1.3.

Menariknya, dengan
menggunakan software yang
ada, kamera yang disertakan bisa
digunakan sebagai kamera
digital dengan resolusi default-
nya sebesar 320x240. Sementara,
bila digunakan sebagai video
capture, kamera ini dapat
menangkap gambar dengan
format .avi. Software bawaannya
juga melengkapi fitur yang
diusung dengan berbagai setting
penting semisal saturasi, kontras,

kecerahan gambar, dan-lain-lain.
Ketika digunakan, PCplus

yang mencicipi i-Drive dengan
kapasitas 128MB, tidak merasa
kesulitan sama sekali. Pada
bagian samping body-nya
terdapat sebuah switch yang
fungsinya untuk mengendalikan
fungsi-fungsi yang ada. Dengan
mengarahkan switch ke huruf
“f”, produk ini akan berfungsi
sebagai pen drive biasa untuk
menampung data. Dalam kondisi
ini lampu indikator berwarna
biru yang ada tepat di bawah
kamera akan menyala jika pen
drive sedang bekerja. Sementara,
bila diarahkan ke switch huruf

“c”, produk uang dilengkapi
dengan kabel USB tambahan
ini akan menjalankan kamera
yang disertakan.

Namun, untuk
menjalankan fungsi kamera,
pengguna harus yakin betul
driver untuk port USB pada
motherboard sudah terinstal
dengan benar. Jika tidak,
jangan harap untuk bisa
menjalankan fungsi ini. (sil)
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tion sebesar 16-bit  ini memang
lebih unggul diri yang lain dari
sisi mobilitasnya. Tanpa perlu
membongkar casing, perangkat
ini sudah bisa diintegrasikan
dalam satu sistem PC. Interface
USB 1.1 yang diusungnya juga
memungkinkan perangkat ini
tidak hanya dipasang hanya pada
PC desktop saja tapi juga pada
notebook yang kualitas suaranya
ingin ditingkatkan.

Produk yang berbasis sistem
tata suara 5.1 ini datang dengan
dua buah port analog input yang
memanfaatkan tipe kabel RCA
dengan impedansi sebesar 10
kiloohm. Sementara, 6 buah port

analog output yang nantinya
dapat disambungkan dengan
speaker berbasis 5.1
memanfaatkan port bebasis RCA
dengan impedansi sebesar 100
ohm.

Selain untuk speaker,
AudiMax yang dibuat di Taiwan
ini juga dilengkapi dengan port
optical input untuk microphone
dan sebuah port mini phone jack
berukuran 3.5 milimeter untuk
headphone.

Menariknya, perangkat ini
punya kompatibilitas yang relatif
tinggi pada PC. Dengan prosesor
minimal Kelas Pentium-III
600MHz atau lebih, produk ini

dapat dipakai pada sistem
operasi berbasis Windows 98SE,
ME, 2000, maupun XP dengan
memori minimum sebesar 128MB.
Sistem ini juga sudah mendukung
untuk standar audio yang umum
semisal DTS, atau pun prologic 2
yang biasa diaplikasikan pada
film-film berbasis DVD.

Pada kemasan jualnya,
SonicGear menyertakan sebuah
CD yang berisi driver serta
keterangan teknis dari kartu
suara ini, sebuah software
MusicMatch Jukebox,  kabel RCA,
dan kabel optik. Sayangnya, pada
paket penjualannya tidak
disertakan buku petunjuk
instalasi sama sekali.

Buat pengguna yang mobile,
produk ini bisa jadi pilihan.
Apalagi proses instalasi yang
cepat dan mudah baik secara
hardware maupun software-nya
jadi keunggulan tersendiri dari
produk yang memiliki casing
tembus pandang ini. (sil)
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Gigabyte GA-8S655TX Ultra:
Varian Terbaru
Chipset SiS655

Nusantara Eradata
www.gigabyte.com.tw

☎ (021) 6018218

SysMark 2002
Rating :331
Internet Content :446
Office Productivity:246

SisoftSandra 2002
ALU :9559 MIPS
FPU :2636 MFLOPS
ISSE2 :5586 MFLOPS

3D Mark 2001
640 x 480  16bit :18211
640 x 480  32bit :17760
800 x 600  16bit :16524
800 x 600  32bit :16039
1024 x 768  16bit :14207
1024 x 768  32bit :13641

Quake III Arena
640 x 480  16bit :422,5fps
640 x 480  32bit :422,3fps
800 x 600  16bit :398,8fps
800 x 600  32bit :388,3fps
1024 x 768  16bit :330,7fps
1024 x 768  32bit :301,7fps
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Tidak lama
setelah melakukan
product update pada chipset
SiS655, Silicon Integrated
Systems kembali merilis versi
terbaru chipset yang
mendukung dual channel
memory untuk prosesor
Pentium-4. Perkenalan perdana
kedua technology update
tersebut malah hanya
berselang dua hari. Namun
untuk peluncuran massalnya,
produk motherboard yang
menggunakan kedua chipset
ini dirilis selang satu bulan.

Produk motherboard yang
menggunakan chipset SiS655FX
sudah tersedia pada bulan
Oktober. Salah satu vendor
yang pertama meluncurkan
motherboard berbasis chipset
ini adalah Gigabyte dengan seri
GA-8S655FX. Versi berikutnya
yang dirilis pada awal bulan
November ini adalah yang
menggunakan chipset SiS versi
655TX, dengan kode produksi
GA-8S65TX.

Dari fisiknya, kedua
produk ini merupakan produk
yang identik. Perbedaan

mendasar dari kedua
motherboard yang sama-
sama diciptakan dengan
form factor ATX berukuran
30,5 x 24,4 ini hanya terletak
pada chip northbridge yang
digunakan saja. Fitur-fitur
pelengkap yang terintegrasi pada
northbridge motherboard
terbaru ini juga tidak ada yang
ditambahkan. Bedanya, chipset
SiS655TX terbaru ini memiliki
teknologi yang disebut Advanced
Hyper Streaming Engine.
Sedangkan pada SiS655FX,
teknologi yang tersedia pada
northbridge adalah Hyper
Streaming Engine.

Sesuai dengan istilah
“Advanced” yang disandang
chipset 655TX, produk ini
memiliki lima teknologi mutakhir
yang dikembangkan oleh SiS.
Kelima teknologi tersebut
semuanya berfungsi untuk
meningkatkan kecepatan transfer
antara prosesor, memori dan
northbridge. Dengan bandwidth
yang lebih tinggi, akhirnya
performa keseluruhan sistem pun
dapat meningkat.

Untuk mendukung prosesor,

chipset yang ditanam pada GA-
8S655TX ini juga masih
mendukung prosesor Intel ber-
FSB 400 dan 533MHz. Untuk
memorinya, dukungan untuk
modul memori adalah yang
menggunakan spesifikasi PC2100,
PC2700, dan PC3200. Fitur
dukungan terhadap Hyper
Threading Technology dan dual
channel memory tentu sudah
tersedia pula.

Dari keempat slot DDR-
DIMM 184-pin yang disediakan,
pengguna GA-8S65TX ini bisa
memasangkan empat buah
modul memori DDR400 hingga
total 4GB pada motherboard.
Pemasangan modul memorinya
pun sangat fleksibel. Asalkan
kapasitas per modul memori
DDR400 tersebut sama, tinggal

tancapkan dua buah modul di
slot 1 dan 3 atau di slot 1 dan 4,
atau di slot 2 dan 3, atau di slot 2
dan 4, mode dual channel
langsung aktif.

Kinerja produk GA-8S655TX
tentu lebih tinggi dari produk
GA-8S655FX yang sempat pula
kita bahas pada edisi 148 lalu.
Dengan kestabilan yang juga
baik serta didukung fitur
kelengkapan yang juga sama,
kinerja produk ini bisa
melampaui kinerja motherboard
ber-chipset Springdale keluaran
Intel.

Seperti biasa, kami menguji
motherboard Gigabyte GA-
8S655TX Ultra ini dengan
prosesor Intel Pentium-4 3GHz
dengan FSB 800MHz, dua keping
memori DDR-SDRAM PC-3200
512MB dari Kingston, dan
harddisk Seagate Barracuda

7200.7 kapasitas 40GB. Untuk
kartu grafisnya, kami
menggunakan karu grafis MSI
GeForce-4 Ti4800SE 128MB. Saat
pengujian, sistem operasi yang
kami pasang adalah Windows
XP Professional dengan
Service Pack 1, sedangkan
software benchmark yang
digunakan adalah
Sysmark2002, Sisoft Sandra
2003, Quake 3 Arena dan
3DMark2001. (fmn)
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Menggagas
Buku
Tentang
E-mail
untuk
Dakwah

Nasrullah Idris
acu@bdg.centrin.net.id

M

Saya hampir tidak
pernah melihat buku
agama Islam dengan

bertema aplikasi e-
mail untuk dakwah di

Indonesia meskipun
judul buku tentang
Agama Islam dalam

beberapa tahun
terakhir ini sangat

meningkat pesat. Apa
karena kebetulan saja

ya?

engapa tak
ada buku
dengan cerita di mana
isinya: Ulama "A"

memberikan nasihat kepada
murid "B" melalui e-mail
tentang cara menghormati
orangtua, Ibu "C" bertanya
kepada Ustadz "D" melalui e-
mail tentang adab dalam
memberikan zakat kepada fakir
miskin, Bapak "E" berkonsultasi
tentang cara memperlakukan
anak yatim piatu kepada
dosen "F" melalui e-mail,
misalnya?

Bisa dibayangkan,
bagaimana sulitnya muslim yang
berada di negeri minoritas
muslim untuk mendapatkan
informasi agama kalau tidak
melalui media elektronik ini.
Apakah mereka harus selalu
langsung menemui pakar agama
Islam? Masih mending kalau
mereka berada di negara seperti
Jerman, Inggeris, AS, Perancis,
dan Belanda. Soalnya di sana
aktivitas Islam untuk cukup
menggema. Akan relatif lebih
mudah menanyakannya. Nah,
bagaimana dengan negara
seperti Brasil, Portugal, atau Afsel
di mana muslimnya di sana
sangat sedikit? Media elektronik
ini tentu akan lebih cepat dalam
mengatasi perolehan informasi
tersebut.

Jika ada seorang pelajar
muslim di Eropa asal Indonesia
agak bingung atau tidak tahu
tentang suatu masalah agama di
mana di sekitarnya tidak ada
orang sebagai tempat bertanya,
maka pemanfaatan teknologi
informasi seperti Internet akan
sangat terasa. Ia bisa
mengirimkan e-mail berisi
beberapa pertanyaan kepada
ulama di tanah air tentang

perbuatan akibat situasi atau
kondisi tertentu dilihat dari
hukum Islam. Sebab adakalanya
pertanyaan muncul ketika sudah
berada di perantauan. Dengan
kata lain, tidak terpikirkan
ketika akan meninggalkan
tanah air.

Siapa tahu dengan adanya
buku dengan tema tersebut akan
semakin memotivasi mereka
untuk menjadikan e-mail sebagai
sarana dakwah. Apakah dalam
kedudukan sebagai penyampai
ilmu atau pencari ilmu, yang
keduanya seputar agama Islam.
Buku itu bisa saja berisi berbagai
model komunikasi antara umat
dan ulama.

Misalkan saja, pada suatu
bab menceritakan seorang Ibu
"A" yang  ingin menanyakan
tentang masalah tertentu kepada
seorang ulama "B". Sayangnya
letak rumah ulama itu sangat
jauh. Untuk meninggalkan rumah
belum bisa karena sibuk
mengurus keluarga. Apalagi ia
baru saja melahirkan. Sedangkan
yang ditanyakan itu sangat
penting untuk segera diketahui
agar bisa segera diambil
keputusan dalam masalah terkait.
Nah, kalau ada Internet kan bisa
lewat e-mail saja.

Sayangnya, belum semua
ummat Islam di Indonesia
mempunyai e-mail account.
Konon di seluruh Indonesia,
pengguna yang mempunyai e-
mail baru sekitar tiga persen saja.
Jadi dari sisi rasio masih jauh
ketinggalan ketimbang Malaysia,
misalnya. Dengan adanya buku
berthema itu diharapkan akan
muncul kesadaran akan besarnya
aplikasi e-mail bagi kegiatan
dakwah.

Saya pernah menghimbau
para pelajar Islam asal Indonesia
yang tersebar di berbagai negara
untuk mempelopori adanya buku
dengan tema e-mail untuk
kegiatan dakwah tersebut di
Indonesia. Himbauan ini saya
lakukan melalui e-mail juga. Ini
tiada lain untuk memberikan
nilai tambah terhadap  ummat
Islam. Apakah itu keimanannya,
kepribadiannya,

pengetahuannya, maupun
peribadatannya.

Terlebih dalam beberapa kali
Ramadhan terakhir di tanah air
ini, sangat banyak mahasiswa
kita berkoresponden lewat e-mail
tentang syiar Islam, baik sesama
mahasiswa di tanah air maupun
mahasiswa yang sedang belajar
di luar negeri. Adanya Internet
dari aspek ajaran Islam bisa
ditarik juga melalui surat Al-Ashr
(waktu) di mana di sana
diisyaratkan tentang
penghematan waktu. Bukankah
kalau suatu peralatan diniatkan
untuk menghemat waktu, maka
penggunaan peralatan itu bisa
bernilai ibadah juga.

Sebagai contoh, seorang
mahasiswa Indonesia di sebuah
kota di Amerika Serikat sekitar
lima jam lagi akan memberikan
ceramah agama Islam dengan
tema pendidikan ditinjau dari
agama Islam. Ia memerlukan data
tentang 6 macam ayat Al-Qur'an
tentang pendidikan dan riwayat
Lukman Hakim (sosok pendidik
yang diabadikan namanya dalam
Al-Qur'an). Tentu kalau ia
menyisir halaman per halaman
Al-Qur'an akan butuh waktu
yang panjang. Sedangkan jika
mau bertanya ke pakar Islam
setempat, ia mengalami kesulitan
teknis transportasi.

Nah, di sinilah e-mail dapat
menjadi media. Sebenarnya
telepon juga bisa, misalnya kalau
pertanyaannya bisa dijawab oleh
kerabatnya yang seorang ulama
di tanah air.  Tetapi Anda tahu
sendiri kan berapa pulsa per
menit untuk SLI?

Apakah melibatkan
teknologi seperti ini tidak justru
membuat urusannya jadi rumit?
Untuk berdakwah dengan
memanfaatkan Internet tidaklah
harus melibatkan ummat ke
urusan jaringan itu. Apalagi
kalau dirasakan belum
waktunya.

Ambil
contoh lagi:

Ulama "A" sudah
berusia 80 tahun berada di

Bandung. Ia sudah nggak bisa
lagi jalan ke luar rumah
sendirian  karena  kakinya
lumpuh total. Untung saja
ingatan masih kuat dalam hal
ajaran Agama Islam.
Sementara ia pun masih ingin
berdakwah. Untuk
berkomunikasi dengan para
dai yunior di berbagai penjuru
Indonesia, yang tiada lain
adalah murid-muridnya juga, ia
menggunakan Internet.

Tentu si murid itu sekali
waktu akan bertanya tentang
metode dakwah yang bisa
diterapkan untuk kondisi/sesial
tertentu?  Maklumlah, dai
adakalanya merasa bingung
untuk mempraktekkan ilmu
berdakwah ketika sudah
berada di lapangan.

Taruhlah sang ulama
belum terampil
mengoperasikan komputer. Itu
pun tidak jadi masalah bila ia
mempunyai asisten. Ia cukup
memberikan input secara lisan.
Sedangkan pengetikkannya
dilakukan oleh asistennya.
Internet akan bisa mengatasi
kendala-kendala seperti ini.

Memang tanpa buku pun
sudah ada yang memanfaatkan
media Internet untuk
berdiskusi soal agama. Ini
ditandai dengan munculnya
berbagai forum diskusi
"mailing list". Tetapi dengan
kehadiran buku tersebut, tentu
gema dan aktivitasnya akan
semakin kuat. Mereka yang
sudah sering memanfaatkan
Internet fisabillah tentu akan
semakin merasakan berbagai
kemudahan teknis. Yang
biasanya mengirimkan e-mail
satu per satu, dalam arti
sebuah e-mail untuk satu
orang, maka setelah membaca
buku itu akan segera diketahui
bahwa ternyata satu e-mail
bisa untuk puluhan, malah
ratusan, orang sekaligus.

Bukankah ini berarti
sedikit-banyak menghemat
pulsa telepon? PC+
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Selalu yang Bermutu
untuk Pemula

T.J. Setyoadi
dino@e-pcplus.com

W

Pada bulan Desember
mendatang, PCplus
kembali menggelar
workshop bermutu

untuk para pemula di
bidang komputer. Kali

ini yang menjadi
fokus utamanya

adalah desain grafis
dan video editing.

Workshop diadakan
pada tanggal 17-18

Desember untuk
video editing dan 19-

20 Desember untuk
seminar dan work-
shop desain grafis.

orkshop
video editing
ini diadakan lagi
atas permintaan para

pembaca yang belum kebagian
tempat pada workshop bulan
Oktober yang lalu. Hanya saja,
pada workshop ini kami akan
memberikan bonus CD tutorial
Adobe Premiere.

Hal ini PCplus lakukan
mengingat workshop video
editing yang kami adakan ini
adalah workshop untuk pemula.
Bagaimana mengedit video
tanpa perlu spesifikasi
komputer yang amat canggih
dan menggunakan software
yang sangat mudah digunakan,
namun hasilnya sudah bisa
dikomersilkan.

Setelah artikel tentang
video editing yang berjudul
“Berterima Kasihlah kepada
Orang Iseng” dimuat, saya
menerima banyak e-mail yang
menanyakan tentang spesifikasi
komputer yang dibutuhkan.
Sebetulnya spesifikasi terendah
yang disarankan adalah

Pentium III – 800 MHz atau yang
sekelas, memori minimal 256 MB,
VGA Card 32 MB, Harddisk 20 GB,
dan capture card untuk kamera
analog atau firewire card untuk
kamera digital.

Dengan peralatan seperti itu,
kita sudah bisa membuat film
VCD sepanjang 1 jam yang
sekualitas film VCD original
hanya dalam waktu kurang lebih
3 jam saja. Perhitungannya
adalah untuk capture diperlukan
waktu 1 jam, 1 jam lagi untuk
mengeditnya, dan 1 jam terakhir
adalah untuk render, membakar
CD, dan membuat cover-nya.

Hasilnya pun cukup bagus,
walau proses editing-nya sendiri
kebanyakan dilakukan dengan
cara drag and drop. Di daerah-
daerah Lamongan, Bojonegoro,
Jember, Banyuwangi, atau di
kota-kota kecil lain di Indonesia,
hampir tidak mungkin untuk
menarik tarif pembuatan VCD
lebih dari 500 ribu, karena
kebanyakan peminatnya adalah
masyarakat yang bukan berasal
dari kalangan ekonomi kuat.
Dengan begitu, tentu saja
investasi yang dibutuhkan tentu
tidak bisa terlalu tinggi. Paling
tidak dengan komputer yang
harganya sekitar 3 juta kalau
baru atau 1,5 juta kalau bekas,
ditambah capture card atau
firewire, dan sebuah kamera, kita
sudah harus bisa membuat film
VCD. Satu syarat utama lagi,
prosesnya harus cepat.

Dengan mengikuti workshop
ini, sebetulnya masalah di atas
sudah terpecahkan. Paling tidak
itu menurut pengakuan
beberapa orang peserta dari
Malang dan Banyuwangi. Mereka
menyatakan bahwa workshop ini
sangat membantu masalah yang
mereka hadapi, tentang hard-
ware apa yang dibutuhkan.
Selama ini mereka mencoba-coba

dan hasilnya masih tetap kurang
memuaskan.

DESAIN GRAFIS UNTUK
PEMULA

Workshop yang kedua
adalah tentang desain
grafis. Kebanyakan orang
awam juga bingung untuk
memulai belajar desain
grafis. Kebanyakan dari
mereka hanya belajar
software untuk desain
grafis, setelah bisa
mengoperasikan mereka
juga bingung, apakah
kemampuan yang mereka
dapat sudah bisa
diandalkan atau belum
untuk mendesain.

Untuk itulah PCplus
mengadakan pendekatan
yang berbeda. Software
yang cukup populer di
bidang desain grafis
adalah PhotoShop.
Software ini rasanya sudah
menjadi kewajiban dari
setiap desainer grafis
untuk menguasainya. Pada
workshop desain grafis ini,

kami mengangkat dua peran
penting PhotoShop dalam desain
grafis, yaitu koreksi warna dan
rahasia seleksi dalam PhotoShop.

Dalam workshop koreksi
warna dengan PhotoShop, kami
akan menularkan pengetahuan
kepada Anda tentang bagaimana
mengoreksi warna pada foto
atau gambar dengan cepat,
tanpa perlu proses yang bertele-
tele. Waktu yang dibutuhkan pun
sangat cepat, hanya dalam
hitungan detik. Trik ini mungkin
tidak akan Anda dapat dalam
kursus desain grafis manapun,
karena setahu saya, kursus desain
grafis hanya menekankan pada
penguasaan software dan
beberapa trik, bukan pada
penggunaan software tersebut
dengan tepat dan efektif.
Mungkin juga ada kursus yang
seperti itu, tapi saya nggak tahu
di mana.

Dengan PhotoShop akan
mengulas seleksi obyek-obyek
yang kita inginkan. Misalnya kita
mempunyai pasfoto, tapi
background-nya akan diganti.
Masalahnya kalau rambutnya

tidak rata dan njeprak-njeprak,
tentu kita akan kerepotan, dan
bahkan mungkin agak mustahil.
Sebetulnya hal tersebut tidaklah
terlalu sulit. PhotoShop sendiri
sudah menyediakan fasilitas
untuk itu. Karena pentingnya
masalah seleksi dalam
PhotoShop, sampai-sampai ada
satu plug-in untuk PhotoShop
yang khusus untuk melakukan
seleksi.

Agar workshop tersebut
tidak hampa, kami juga
mengadakan seminar tentang
estetika dalam desain dan
bagaimana menjadi kreatif.
Pembicara dalam seminar ini
dari SAM Design, sebuah
perusahaan desain yang paling
besar dan progresif di Surabaya
sampai saat ini.

Sedangkan hardware untuk
workshop ini disediakan oleh
motherboard ASUS, harddisk
dari Seagate, monitor dari
Samsung, dan casing dari
Simbadda. Semua hardware
yang disediakan selalu yang
terbaru, untuk menjamin kenya-
manan peserta workshop. PC+

Salah satu kunci sukses dalam menawarkan jasa video editing adalah
proses pengerjaan yang cepat dan biaya yang relatif murah. Stok gambar
sebaiknya cukup banyak sehingga proses editing menjadi lebih leluasa.

ARE/PCplus

Gambar di sebelah kiri yang dihilangkan latar belakangnya membutuhkan waktu kurang dari sepuluh menit
untuk menghasilkan gambar yang diinginkan (kanan).

Koreksi gambar bisa dilakukan secara cepat. Kurang dari satu menit, gambar yang tampak pucat bisa
diperbaiki menjadi lebih cerah.
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Dwinanto
antotheninja@yahoo.com Max Payne 2:

The Fall of Max Payne

P

Para penjahat, harap
ingat baik-baik: Max

Payne kembali
beraksi! Lebih keras

dari sebelumnya.
Setelah sukses besar
dengan game Max
Payne yang dirilis

tahun 2001, Remedy
kini merilis sekuelnya

yang berjudul Max
Payne 2: The Fall of

Max Payne.

ada cerita
sebelumnya,
istri dan anak Max
dibunuh, sahabat

sekaligus mentornya juga tewas
dalam tugas. Sejak saat itu, Max
Payne memulai balas dendam
dan melakukan pembantaian

terhadap para penjahat. Max
telah membunuh hampir semua
musuh. Namun, walaupun
semua dendamnya telah
terbalaskan, hatinya masih
terasa perih. Alur ceritanya
yang sangat bagus dilengkapi
dengan aksi-aksi yang seru.
Game ini mengandalkan fitur
bullet-time, membuat pemain
seolah-olah berada dalam
sebuah adegan slow motion
seperti pada film The Matrix.

Bulan Oktober 2003, Max
Payne 2: The Fall of Max
Payne baru dirilis di Eropa,
lebih cepat dari rencana
sebelumnya yang menyebutkan
kemungkinan game ini baru
dirilis bulan April 2005. Dalam

game ini, penampilan Max
tampak sedikit lebih tua dan
kalem, wajahnya tampak sedikit
letih. Ekspresi wajah yang
ditampilkan lebih luwes. Kita bisa
melihat Max menyeringai dan
alisnya bergerak-gerak sesuai
dengan perubahan mimik wajah.
Animasi wajah yang sinkron dan
natural membuat game ini
tampak hidup. Hal ini juga
tampak pada semua karakter lain
dalam game.

Di sini Max Payne diceritakan
kembali ke kepolisian, mencoba
untuk menjalani kehidupan
barunya. Namun, pembunuhan
terhadap seorang rekannya
memaksa ia untuk beraksi
lagi - khususnya karena ia
dijebak dan dijadikan
tersangka. Anehnya, Max
mengakui pembunuhan itu
karena suatu alasan yang
tak dapat diungkapkan.

Alur cerita Max Payne
2: The Fall of Max Payne
berhubungan dengan kisah
asmara. Kita bisa
berkenalan dengan sosok
Mona Sax, seorang
vigilante yang sangat
berperan dalam kisah ini, baik
sebagai seorang rival, sekutu,
sekaligus wanita yang menarik
perhatian Max – wanita yang
dikiranya sudah meninggal dan

yang menurutnya menjadi
tersangka utama pembunuhan.

"I lied to myself that it was
over. I was still alive, my loved
ones were still dead. It wasn't
over."

"You'd have to be a first-
degree fool to fall for a woman
who returns from the dead only
to put a gun to your face."

Love Hurts...

Kita juga akan menjumpai
orang-orang yang berpihak pada
Max, di antaranya seorang
wanita pembunuh bayaran yang

seksi dan beberapa orang
mafioso. Sesekali dalam aksinya,
Max dibantu oleh orang lain.
Masih ada satu karakter musuh
yang tersisa dari game pertama,

Publisher   : Rockstar
Games

Developer : Remedy
Jenis          : Third-Person

Shooter/Action

Persyaratan Spesifikasi
Sistem Minimal:

• Prosesor PIII/Athlon 1Ghz
atau Celeron/Duron
1,2Ghz

• Kartu grafis AGP 32 MB
• RAM 256MB
• Ruang harddisk 1,5GB
• Windows 98/ME/2000/XP
• DirectX 9.0
• Soundcard 3D

kompatibel
• Speaker atau headset/

headphone
• Keyboard dan mouse

karakter tersebut dimunculkan
kembali dalam seri ini.

Seperti game pertamanya,
beberapa elemen kisah dalam
Max Payne 2: The Fall of Max
Payne ditampilkan dalam bentuk
bingkai-bingkai komik. Dalam
game ini Remedy menambahkan
adegan-adegan in-game scene
untuk menghubungkan kisahnya.
Gerakan bibir yang sinkron dan
animasi wajah sesuai perubahan
ekspresi jelas sangat membantu
dalam membangun identitas dan
karakter-karakter dalam game
ini. Kisahnya berjalan secara real
time dan lebih lama dibanding

dengan game pertama.
Jenis persenjataannya sama
dengan game sebelumnya –
beberapa macam pistol,
uzi, senapan serbu
komando, M4, beberapa
jenis shotgun, granat, dan
beberapa senjata lainnya.

Dari segi teknologi
grafis, game ini bisa
dibilang masih sama
dengan yang dulu, tentu
saja ditambah dengan
sedikit perbaikan. Tampilan
grafisnya indah dan

mampu bersaing dengan game-
game jenis action-shooter masa
kini. Sistem partikel yang baru
juga dikembangkan dalam game
ini untuk menggambarkan

percikan bunga api dan debu
saat butir-butir peluru
menghantam kendaraan dan
tembok. Pencahayaan yang
dinamis juga digunakan untuk
menghasilkan bayangan yang
tampak lebih halus dan
fantastis. Teknik dan engine
grafik tersebut memungkinkan
tampilan grafis yang realistis,
baik pada efek maupun
tampilan cutscene-nya.

Kesimpulannya, game ini
memiliki keunggulan yang
signifikan dari segi tampilan
grafis dan aksi yang seru. Game
ini dibuat dalam versi PC dan
console. Versi untuk platform PC
sudah dirilis di Eropa,
sedangkan untuk versi console
(Xbox dan Playstation2) baru
akan dirilis sekitar tanggal 3
Desember 2003.

Jadi, bagi para gamer,
tunggu saja kehadiran sekuel
game yang seru dan oke ini.
Pesan bagi para penjahat:
Watch out, Bad Guys... Payne is
back! PC+
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Daftar Harga Komputer &
Periferal yang dihimpun dari
berbagai toko & distributor

komputer di Jakarta.
Harga Dalam Dolar AS
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MOTHERBOARD

Asus P4S800, SiS648FX, 5 PCI,
AGP 8X, USB 2.0, HTT 95
Asus P4PE/L 1394, i845PE, AGP4X,
DDR, 6PCI, USB2.0, Hyper-threading 133
Asus P4PE/L , i845PE, AGP4X, DDR,
6PCI, USB2.0, Hyper-threading 100
Asus P4C800 Deluxe, Intel 875,
FSB800, ATA100, RAID, AGP Pro 210
Asus P4P800 Deluxe, i865, FSB 800,
ATA100, 4DDR 158
Asus P4T-CM, i850, soket 423,
FSB400, ATA100, 2RDRAM 63
Asus P4P800, i865, FSB800, 4DDR,
RAID, LAN, audio 137

Asus P4C800, i875, FSB800, 4DDR,
RAID, Audio, Gigabit LAN 189
Asus P4B533, i845E, FSB533,
ATA100, 3DDR, audio 84
Asus P4S533-MX, SiS651 FSB533,
ATA133, 2DDR+ 2SDR, audio,
VGA onboard 74
Asus P4S8X/L 1394, SiS648, FSB533,
3DDR, AGP8x, audio, Serial ATA, 1394 131
Asus P4S8X-X , SiS648, FSB533,
ATA133, AGP8x, 3DDR, audio,
Gigabit LAN 89
Asus P4P800S, i848P, FSB800,
2DDR, audio, S/PDIF 111
Asus A7V8X/L 1394, KT400, ATA133,
AGP8x, FSB266, 3DDR, audio,
LAN, 1394 115
Asus A7V600, VIA KT600, 6 PCI,
3DDR, AGP8x 107
Asus A7N8X-X, NForce2, ATA133,
5 PCI, 3DDR, audio dolby, AGP8x 100
Asus A7V8X/L, VIA KT400, 6 PCI,
3DDR, SATA, ATA133 115

APLUS AP984, i865PE, FSB 800MHz,
4DDR400, ATX, AC97                               93
APLUS AP981,i845GE, FSB 533MHz,
2DDR, ATX, AC’97 76
APLUS AP980, i845PE, ATX,
FSB533,2DDR333 SOUND AC97 70
APLUS AP986 VIA P4X400, ATX,
FSB533, SOUND AC97 6 channel,
3DDR400, AGP8X 54
APLUS AP976E2, VIA P4X266E, FSB
533MHz, 2DDR,M- ATX, AC’97 50
APLUS AP976, VIAP4X266E,
FSB 400MHz, 2DDR, M-ATX, AC’97 48
APLUS AP972A3 VIA P4M266A,
ATX, 533FSB, SOUND AC97, 2DDR 50

APLUS AP982 VIA KT400, ATX,
266FSB, SOUND AC97, 3DDR 62
APLUS AP975 VIA KT333, ATX,
266FSB, SOUND AC97, DDR333 60

MSI 875P Neo FIS2R, i875P, ATX,
FSB800, 2DIMM, ATA100,
AGP8X, 6PCI 200
MSI P4MAM-L, VIAP4M266A, ATX,
FSB533, 2DIMM, ATA133,
AGP4X, 3PCI 65
MSI 651M COMBO-L, SiS 651, m-ATX,
FSB533, 2DIMM, ATA133, AGP4X 71
MSI 648 MAX-V, SiS 648x, ATX,
FSB533, 3DIMM, ATA133, AGP8X, 6PCI 68
MSI 655 MAX FISR, SiS655, ATX,
FSB533, 4DIMM, ATA133,
SATA, AGP8X 160
MSI 655 MAX LS, SiS655, ATX,
FSB533, 4DIMM, ATA133,
SATA, AGP8X 110
MSI 645GLM, I845gl, Matx, FSB400,
2DIMM, ATA100, AGP4X, 3PCI 73
MSI 845PE Max, I845PE, ATX, FSB533,
2DIMM, ATA100, AGP4X, 6PCI 74
MSI 865PE Neo2, I865pe, ATX,
FSB800, 2GBDDR, ATA133,
AGP8X, 5PCI 120
MSI K7N2 Delta-L, nForce2, ATX,
FSB400, 3GB DDR, ATA133,
AGP8X, 5PCI 102
MSI K8T Neo-FIS2R, VIA K800T800,
ATX, FSB800, 3DDR, ATA133,
AGP8X, 5 PCI 180
KT4V, Via KT400, ATX, FSB333,
3GBDDR, ATA133, AGP8X, 6PCI 72

Matsonic 9158E+, VIA P4M266,
FSB533, USB2.0, VGA ONBOARD 49

Matsonic 9127C, VIAP4X400,
FSB533, USB2.0, DDR400, AGP8X 55
Matsonic 9327D+, SIS650, FSB533,
USB2.0, 2DDR, VGA ONBOARD 54
Matsonic 9337C, SIS648, FSB533,
USB2.0, 3DDR400, AGP8X 64
Matsonic 9377C, SIS648FX,
FSB800, 3DDR400, AGP8X, HTT 69
Matsonic 9367E, SIS 650GX, FSB533,
2DDR, VGA ONBOARD +AGP 55
Matsonic 8137C, VIA KT266A,
FSB266, 2DDR, VGA ONBOARD+AGP 49
Matsonic 8157E, VIA KM266, FSB 266,
2DDR, AUDIO, VGA ONBOARD + AGP 58
Matsonic 8167C, VIA KT333, FSB266,
3DDR333, AGP 4X, AUDIO 51
Matsonic 8147C, VIA KT400A, FSB333,
3DDR400, AGP 8X, LAN ONBOARD 59

Gigabyte GA-7VKMP-P, VIA AKM266,
ATX, Soket A, ATA133, LAN 65
Gigabyte GA-7VA, VIA KT400, ATX,
Soket A, ATA133 79
Gigabyte GA-7N400-EL,
nForce2 ultra, ATX, Soket A, ATA133 99
Gigabyte GA-7N400 Pro,
nForce2 ultra, ATX, Soket A 150
Gigabyte GA-7NNXP, nForce2 Ultra,
FSB400, 4DDR, 5 PCI 212
Gigabyte GA-7NNXPV, nForce2,
FSB333, 4DDR, 5PCI 242
Gigabyte GA-S648,  SiS 648, ATX,
FSB533, ATA133, AGP8X, 5PCI 73
Gigabyte GA-S648FX, SiS 648FX,
ATX, FSB800, ATA133, 5PCI 97
Gigabyte GA-SINXP 1392 DDR400,
SiS655, ATX, FSB533, ATA133 167
Gigabyte GA-S648-L, SiS648,ATX,
FSB533, ATA133, 5PCI 75

Gigabyte GA-8IPE1000, i865PE,
ATX, FSB800, 4DDR, 5PCI 127
Gigabyte GA-8PE800Ultra+Raid,
i845PE, ATX, FSB800, ATA133 92
Gigabyte GA-8KNXP+Raid+ SATA,
i875P, ATX, FSB800, ATA133, AGP pro 217
Gigabyte GA-K8N, Nforce3 150,
FSB800, 3DDR, ATA133, AGP8X, 5PCI 132
Gigabyte GA-K8NNXP, Nforce3 150,
FSB800, 3DDR, SATA, AGP8X, 5PCI 217
Gigabyte GA-K8VT800M,
VIAK8T800, FSB800, 3DDR, SATA,
AGP8X, 5PCI 122
Gigabyte GA-K8VNXP, VIAK8T800,
FSB800, 3DDR, SATA, AGP8X, 5PCI 207

DFI LAN Party Pro875, i875P, ATX,
FSB800, AGP8X, 2SATA 195
DFI LAN Party KT400A, VIA KT400A,
ATX, FSB400, AGP8X, 1SATA 130
DFI LAN Party NF II Ultra, nForce 2,
ATX, FSB400, AGP8X, 1SATA 155
DFI PS83-BL, i865PE, ATX, FSB800,
AGP8X, 2SATA 90
DFI 648FX-ALE, i648FX, ATX, FSB800,
AGP8X, DDR 400 75
DFI P4X800-AL, VIA P4X400, ATX,
FSB533, AGP8X, ATA133 57
DFI KT400A Infinity, VIA KT400A,
ATX, FSB333, AGP8X, 1SATA 92

Iwill mP4G2S, i845GL, soket 478,
FSB400, LAN, DDR, 65
Iwill mP4G2, i845GV, soket 478,
FSB533, DDR, 68
Iwill P4G, i865PE, soket 478,
FSB800, LAN, DDR, serial ATA 69
Iwill P4HT2, i845PE, soket 478,
FSB 533, DDR, Audio, 78
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Iwill P4SE, i865PE, soket 478,
FSB 800, DDR, Audio, ATA100,
Serial ATA 110
Iwill DX400-SN, ii860, soket 603,
RDRAM, Dual Pro include casing,
SCSI 999

Soyo K7V Dragon Ultra. VIA KT333,
6ch audio, AGP Pro, LAN10/100 145
Soyo K7V Dragon Lite. VIA KT333,
6ch audio, AGP 4x 85
Soyo P4X400, VIA P4X400, RAID,
6ch audio, AGP PRO, 6 PCI 155
Soyo P4I Fire Dragon, i845D, DDR266,
RAID, 6ch audio, AGP PRO, 6 PCI 120
Soyo P4S Dragon Ultra, Sis645A2+961,
RAID, 6ch audio, AGP PRO, 6 PCI 140
Soyo P4IS2, i845, SDRAM, AC97,
6PCI, AGP4X 60

Abit IC7 Max III  i875P, FSB800MHz,
4 DDR, AGP 8X, 5 PCI 325
Abit BE7, i845PE, FSB 533MHz,
3 DDR, AGP 4X, 5 PCI 102
Abit BH7, i845PE, FSB 800MHz,
3 DDR, AGP 4X, 5 PCI 94
Abit BE7-S, i845PE, FSB 533MHz,
3 DDR, AGP 4X, 5 PCI 117
Abit BD7, i845D, FSB 533MHz,
2DDR, AGP 4X, 5 PCI 85
Abit BD7II, i845D, FSB 533MHz II,
2 DDR, AGP 4X, 5 PCI 90
Abit IC7G i875/ICH5-R, FSB 800MHz,
4 RIMM, AGP 8X, 5 PCI 194
Abit SR7-8X, SiS 648, FSB 533MHz,
3 DDR, AGP 8X, 5 PCI 85
Abit IS7, i865PE, FSB 800MHz,
4 DDR, AGP 8X, 5 PCI 135
Abit BD7E, i845DDX, FSB 533MHz,
2 DDR, AGP 8X,  5 PCI 75
Abit KV7, Via KT600/8235,
FSB 400MHz, 4 DDR, AGP 8x, 6 PCI 94
Abit NF7S, nVidia nForce2,
FSB 333MHz, 3 DDR, AGP 8X, 3 PCI 119
Abit KD7-A, Via KT400, FSB 333MHz,
4DDR, AGP 8X, 6 PCI 86
Abit NF7, nForce 2, FSB 333MHz,
3 DDR, AGP 8X, 3 PCI 97
Abit NF7-SL, nForce 2, FSB 333MHz,
3DDR, AGP 8X, 3 PCI 111

MEMORI

Visipro 128MB (4 IC) PC 133 29
Visipro 128MB (8 IC) PC 133 36
Visipro 256MB (8 IC) PC-133 54
Visipro 256MB (16 IC) PC-133 63
Visipro 512MB PC-133 102
Visipro 128MB (8 IC) PC-2100 28
Visipro 256MB (8 IC) PC2100 49
Visipro 256MB (16 IC) PC2100 Call
Visipro 512MB PC-2100 96
Visipro 128MB (4 IC) PC-2700 30
Visipro 128MB (8 IC) PC-2700 30
Visipro 256MB (8 IC) PC2700 50
Visipro 256MB (16 IC) PC2700 Call
Visipro 512MB PC-2700 96
Visipro 256MB PC3200 (8IC) 52
Visipro 512MB PC3200 99
Visipro 64MB PC800 36
Visipro 128MB PC800 (8IC) 52
Visipro 256MB PC800 (8IC) 105

Nexus SDRAM PC-133 64MB 15.5
Nexus SDRAM PC-133 128MB 20.5
Nexus SDRAM PC-133 256MB 37

Kingston Flash Memory 64MB 25
Kingston Flash Memory 128MB 39

USB FLASH MEMORI/
MP3/PEN DRIVE

Prolink USB Pen Drive, MP3 64MB 85
Prolink USB Pen Drive, MP3 128MB 110
Prolink USB Pen Drive, MP3 256MB 165

NCPRO pen drive 128MB USB 2.0 48
NCPRO pen drive 256MB USB 2.0 74
NCPRO pen drive 512MB USB 2.0 123.5

Magic Star 64, 64MB, 3 in 1 42
Magic Star 128, 128MB, 3 in 1 78
Magic Star 256, 256MB, 3 in 1 140
Magic Star 64 MP3, 64MB, MP3 74
Magic Star 128 MP3, 128MB, MP3 115
DigiSound II, 128MB, multi MP3,
voice recording, display 140
MagicStar 128 Turbo, USB 2.0, 128MB 65

Umax Flash Drive FD-201
64MB, USB 2.0 43
Umax Flash Drive FD-201
128MB, USB 2.0 65
Umax Flash Drive CD-101,
64MB + SD/MMC card reader, USB1,1 45
Umax Flash Drive MP101 64MB +
MP3 player, USB 1.1 73
Umax Flash Drive MP101 128MB +
MP3 player, USB 1.1 100

Nexus UFD-64, USB Flash Drive
64MB ver 1.1 31.5
Nexus UFD-128, USB Flash Drive
128MB ver 1.1 42
Nexus UFD-256, USB Flash Drive
256MB ver 1.1 70.5
Nexus UFD-512, USB Flash Drive
512MB ver 1.1 141

HARDDISK

Maxtor 6L020L 20,4GB 7200rpm
ATA133, 2MB Cache, dual processor 53
Maxtor 6E030L 30GB 7200rpm ATA133,
2MB Cache, dual processor 55
Maxtor6E040L/6E040 40GB 7200rpm
ATA133, 2MB Cache, dual processor 60
Maxtor 6Y060L 60GB 7200rpm ATA133,
8MB Cache, dual processor 73
Maxtor 6Y080L 80GB 7200rpm ATA133,
8mb cache, dual processor 77

Maxtor 6Y120L, 120GB, 7200rpm,
8,5ms, uDMA133, 8MB cache 107
Maxtor 6Y160PO, 160GB, 7200rpm,
ATA 133/serial ATA, 8MB cache 169
Maxtor 6Y200PO, 200GB, 7200rpm,
ATA 133/serial ATA, 8MB cache 235

Seagate Ux/Cuda 5400.1 20GB
ATA 100 53.2
Seagate Ux/Cuda 5400.1 40GB
ATA 100 54.3
Seagate Barracuda 7200.7 40GB
ATA100 58
Seagate Barracuda 7200.7 80GB
ATA100 74
Seagate Barracuda 7200.7 120GB
ATA V/100 103.4
Seagate Barracuda 7200.7 Plus
160GB ATA V/100 (8MB cache) 137.6
Seagate Barracuda SATA 80GB,
ATA100 106
Seagate Barracuda SATA 120GB,
ATA100 129.3

Maxtor 2F020J/L, 20GB 5400rpm,
ATA-133, 2MB cache 52
Maxtor 2F030J/L, 30GB, 5400rpm,
ATA-133, 2MB cache 54
Maxtor 2F040J/L, 40GB, 5400rpm,
ATA-133, 2MB cache 58
Maxtor 4R060J/4D060H, 60GB
5400rpm, ATA-133, 2MB cache 67
Maxtor 4D080H/4K080H, 80GB,
ATA-100, 2MB cache 80
Maxtor 4G120H, 120GB 5400rpm,
ATA-100, 2MB cache Call
Maxtor 4G160H, 160GB,
5400rpm, 9,0ms, ATA100,
2MB cache,
dual processor 165
Maxtor 6YO80MO, 80GB SATA,
7200RPM, 8MB Cache 107
Maxtor 6Y120MO, 120GB SATA,
7200RPM, 8MB Cache 130
Maxtor 6Y160MO, 160GB SATA,
7200RPM, 8MB Cache 175
Maxtor 6Y200MO, 200GB SATA,
7200RPM, 8MB Cache 245

Western Digital WDC 5400rpm
cache 2MB 20GB 53
Western Digital WDC 5400rpm
cache 2MB 40GB 57
Western Digital WDC 7200rpm
cache 2MB 40GB 67
Western Digital WDC 7200rpm
cache 8MB 40GB 79

Western Digital WDC 7200rpm
cache 8MB 80GB 112
Western Digital WDC 7200rpm
cache 2MB 100GB 135
Western Digital WDC 7200rpm
cache 2MB 120GB 160
Western Digital WDC 7200rpm
cache 8MB 160GB 210
Samsung HDD 20GB 5400rpm 56
Samsung HDD 40GB 5400rpm 70

EXTERNAL DRIVE

Maxtor 5000DV 160GB, USB 2.0,
8MB Cache, 7200rpm 299
Maxtor 7000, 120GB, external,
USB 2.0, 2MB cache, 5400rpm 235
Maxtor 7000, 200GB, external,
USB 2.0, 8MB cache, 7200rpm 370
Maxtor 7000, 250GB, external,
1394/USB2.0, 8MB cache, 7200rpm 420

SCSI HARD-DISK 7200RPM &
10K RPM

Maxtor KU018L/J 18 GB Atlas,
68/80 pin, 10 K RPM, SCSI-320,
8 MB cache 145
Maxtor 8B036L/J 36 GB Atlas IV,
68/80 pin, 10 K RPM, SCSI-320,
8 MB cache 185
Maxtor 8B073 73 GB Atlas IV,
68/80 pin, 10 K RPM, SCSI-320,
8 MB cache 42
IBM IC35LO36UWD, 36GB, 68 pin,
10 Krpm, SCSI160, 8MB cache 200
Quantum XC009J, 18GB, 68/80pin,
7200rpm, SCSI160, 4MB cache 80
IBM IC35L009, 9GB, 68pin,
10Krpm, SCSI160,  8MB cache 115
IBM DPSS 9170W, 9,1GB, 68/80pin,
7200rpm, SCSI160, 4MB cache 95

Seagate Medalist Pro 4,5GB U2W,
M Pro, 9,5ms 54
Seagate Cheetah  U320 36,6GB 168
Seagate Cheetah U320  73GB 413

KURSUS

DIKLAT KOMPUTER BERSERTIFIKAT RP.100.000,-
1.Network LAN+EDP+Admin+PC Kloning
2.Teknik Komputer+Mobo+Hardisk+Copy Bios
3.Design Grafis 4. Private 5. Jarak jauh Ok
Gratis:CD-Modul-Sertifikat-Drink-Konsultasi

DIKLAT JARINGAN PC KLONING TANPA HARDISK
Komp lama bisa secepat P.4 - RAM 8 jadi 64
Non Hardisk bisa Windows 2000 - XP - Corell
LPKN EXSYSCOM - BELAJAR JARAK JAUH BISA
021.78889003 - 0813.100.47586 - 0815.997.1234

Terobosan Baru ! Pendd “Murah” Indonesia
Dibuka “Perpustakaan Digital” SabtuJ9–17
180CD Tutorial Multimedia Full AudioVideo
IT and Mgt  (bhs.Indonesia dan Inggris)
VB,Office,Photoshop,CDraw,Premiere,FPage
Director,Flash,AutoCad,Cisco,Oracle,LAN
Linux,Fhand dll bowoastomo 0815.9499.644
www.geocities.com/bowoastomo//Index.htm

LAIN-LAIN

DISTRO LINUX,Menjual CD Linux terbaru.
Mandrake/Redhat/Slackware/Openoffice dll
Murah dan Bergaransi (1 to 1 Replacement)
Kualitas CD dijamin bagus ( LG/BenQ/Sony)
Bisa kirim keseluruh Indonesia. Hubungi:
08121876981 Email: distro_linux@yahoo.com
http://www.geocities.com/distro_linux/

INVESTOR/SPONSOR kami mempunyai tempat
usaha 2 lantai di dalam KAMPUS GUNADARMA
Depok mencari Mitra Bisnis (Investor/Sponsor)
utk Usaha INTERNET GAMES, KURSUS, SOFT-
WARE HOUSE Hub:0813 1000 5777 / 77212866

IKLAN BARIS

Nexus DDR PC-2100 128MB 23
Nexus DDR PC-2100 256MB 42.5
Nexus DDR PC-2700 256MB 44.5
Nexus DDR PC-2700 512MB 90

V-Gen SDRAM PC-133 (8IC) 64MB 16
V-Gen SDRAM PC-133 (4IC) 128MB 25
V-Gen SDRAM PC-133 (8IC) 128MB 31
V-Gen SDRAM PC-133 (8IC) 256MB 48
V-Gen SDRAM PC-133 (16IC) 256MB 61
V-Gen SDRAM PC-133 (16IC) 512MB 92
V-Gen DDR PC-2100  128MB 24
V-Gen DDR PC-2100  256MB 42
V-Gen DDR PC-2700  256MB 43
V-Gen DDR PC-2100  512MB 83
V-Gen DDR PC-2700  512MB 85
V-Gen DDR PC-3200  256MB 44
V-Gen DDR PC-3200  512MB 87
V-Gen RDRAM PC-800 128MB 51
V-Gen RDRAM PC-800 256MB 98

Kingston 128MB DDR PC2100 22.5
Kingston 256MB DDR PC2700 42
Kingston 512MB DDR PC2700 81
Kingston 256MB DDR PC3200 45
Kingston 512MB DDR PC3200 89

NCPRO 512MB DDR PC-3200 88
NCPRO 256MB DDR PC-3200 44.5
NCPRO 512MB DDR PC-2700 87
NCPRO 256MB DDR PC-2700 41.5
NCPRO 128MB DDR PC-2100 21.5

MULTIMEDIA CARD

NCPRO 64MB 23
NCPRO 128MB 36
NCPRO 256MB 71.5

Twinmos MMC 64MB 27.5
Twinmos MMC 128MB 41

Visipro 64MB 26
Visipro 128MB 43
Visipro 256MB 75

COMPACT FLASH

NCPRO Flash memory 32MB 18
NCPRO Flash memory 64MB 22.5
NCPRO Flash memory 128MB 38.5
NCPRO Flash memory 256MB 56

Visipro Flash Memory 64MB 26
Visipro Flash Memory 128MB 42
Visipro Flash Memory 256MB 65
Visipro Flash Memory 512MB 125

Nexus UFD-64, USB 1.1, 64MB 31.5
Nexus UFD-128, USB 1.1, 128MB 43.5
Nexus UFD-256, USB 1.1, 256MB 70.5
Nexus UFD-512, USB 1.1, 512MB 141

Twinmos 64MB 27.5
Twinmos 128MB 36.5
Twinmos 256MB 64
Twinmos 512MB 121

SMART MEDIA CARD

NCPRO Flash Memory 32MB 12
NCPRO Flash Memory 64MB 19.5
NCPRO Flash Memory 128MB  27.5
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KUIS Beberapa waktu lalu, Lala kawan si Ciplus kembali dari Taiwan.
"Ada apa sih di Taiwan?", tanya si Ciplus. "Ada pameran
komputer", jawab Lala. "Pameran komputer,  apa namanya?", pikir

si Ciplus. Tolong dong si Ciplus, sebutkan nama pameran komputer tahunan yang
diadakan di Taiwan? Tuliskan jawaban tersebut di sehelai kartu pos dengan mencantumkan
alamat yang jelas dan sudah dibubuhi Kupon Kuis asli (di pojok kanan). Jangan
menunda-nunda, karena jawaban sudah harus masuk ke meja Redaksi PCplus paling lambat
tanggal 12 Desember 2003. PCplus akan memberikan 5 buah kaos PCplus untuk 5 orang
pemenang yang menjawab dengan benar dan beruntung! Buruan!!!

Para pemenang tidak dibebani pungutan atau biaya apapun atas undian ini
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Seagate Cheetah U320 73.4GB
Fibre channel 525
Seagate Cheetah U320 36,7GB 321

MAGNETIC OPTICAL DRIVE

Fujitsu MCC-3064ATAPI, 640MB,
ATAPI internal, 3,5" 230
Fujitsu MCE-3130AP, 1,3GB,
ATAPI internal, 3,5" 325
Fujitsu MSS-3064S, 640MB,
SCSI internal, 3,5" 250
Fujitsu Dynamo 640/EE,
external firewire 1394 350
Fujitsu Dynamo 1300, 1300MB,
external firewire 450

PROSESOR

Athlon Xp 1800+ (Thoroughbred A) 42.5
Athlon Xp 2000+ (Thoroughbred A) 50.5
Athlon Xp 2100+ (Thoroughbred A) 55
Athlon XP 2200+ (Thoroughbred A)  64
AthlonXP 2400+ fan (Thoroughbred B) 71
AthlonXP 2600+ (FSB333) + fan 87
AthlonXP 2800+ (Barton FSB333) 140
AthlonXP 3000+ (Barton FSB333) 199

AMD ATHLON XP 2000+ (BOX) +
FAN TBRED B FSB 266MHz 69
AMD ATHLON XP 2200+ (BOX) +
FAN TBRED B FSB 266MHz 76
AMD ATHLON XP 2400+ (BOX) +
FAN TBRED B FSB 266MHz 83
AMD ATHLON XP 2600+ (BOX) + FAN
BARTON FSB 333MHz, CACHE 512 105
AMD ATHLON XP 2500+ (BOX) + FAN
BARTON FSB 333MHz CACHE 512 94
AMD ATHLON XP 2800+ (BOX) + FAN
BARTON FSB 333MHz CACHE 512 150
AMD ATHLON XP 3000+ (BOX) + FAN
BARTON FSB 333MHz CACHE 512 229
AMD ATHLON XP 3200+ (BOX) + FAN
BARTON FSB 400MHz CACHE 512 459

Intel Pentium-4 1,8AGHz-478 128
Intel Pentium-4 3,06GHz, box), 478 278
Intel Pentium-4 1,8AGHz,
512KB cache L2, 478 130
Intel Pentium-4 2,0AGHz,
512KB cache L2, 478 133l
Intel Pentium-4 2,4BGHz,
512KB cache L2, FSB 533, 478 171
Intel Pentium-4 2,66GHz,
(512) FSB 533 174
Intel Pentium-4 2,8GHz
(512) FSB 533 210

Tray Pent-4 2,4CGHz, cache 512Kb,
FSB 800 w/o fan 186
Box Pent-4 2,4CGHz, cache 512Kb,
FSB 800 184
Box Pent-4 2,6CGHz, cache512Kb,
FSB800 188
Box Pent-4 2,8CGHz, cache512Kb,
FSB800 230
Box Pent-4 3.0GHz, cahce512Kb,
FSB800 294
Box Pent-4 3,2GHz, cache512Kb,
FSB800 441
Intel Celeron 1,7GHz, c/128 62
Intel Celeron 2.0GHz, c/128 65
Intel Xeon Pentium-4 1,8GHz
512KB cache L2, MPGA 194

Intel Xeon Pentium-4 2,0AGHz,
512KB cache L2, MPGA 239
Intel Xeon Pentium-4 2,4AGHz,
512KB cache L2,FSB 533, MPGA 250
Intel Xeon Pentium-4 3,06
512KB cache L2, 533MHz 756

HEATSINK FAN

Coolermaster HAC-V81 (X-Dream) 21
Coolermaster HSC-V83 30
Coolermaster HHC-001 28
Coolermaster IHC-L71 32

Zalman CNPS-2005 15
Zalman CNPS-3000 18
Zalman CNPS3100 24
Zalman CNPS3100 G 35
Zalman CNPS5001 AL 19
Zalman CNPS 5001CU 26
Zalman CNPS-5700D-CU 32
Zalman CNPS 7000 CU 42
Zalman CNPS 7000 ALCU 35

CASING

Procase ATX PS/2 tipe 477
power supply 350W 23
Procase ATX PS/2 tipe 0207
power supply 350W 24
Procase ATX PS/2 tipe 0208
power supply 350W 26

Enermax ATX CS-5190 AL,
power supply 365W 404
Enermax ATX CS-5190 AL,
power supply 450W 419
Elan Vital S15, big tower, ATX,
power supply 300w 472

VGA CARD

Asus V9280 SuperFast 128MB 221
Asus V9180 Magic/T 64MB MX440-8X 84
Asus V9950 Ultra/ DLX,
GeForceFX 5900, AGP 8x, 128MB DDR 567
Asus V9520 Magic/T GeForceFX 5200,
128MB, AGP8X 84
Asus V9520 Home Theater-128MB 189
Asus V9280 SuperFast/TD,
Ti4200-128MB 173
Asus V9950 Ultra/TVD,
GeForce FX5900, 256MB 546
Asus V9180 SE/T 64MB, MX-440-8X 53

Abit GF3 Ti 200, 64MB DDR 120
Abit GF2 T400, AGP 4X,
64MB SDRAM, TV-out, 64
Abit GF2 MX400, AGP 4X,
64MB SDRAM 59
Abit GF2 T200, AGP4X,
32MB SDRAM, TV-out 56
Abit GF2 MX200, AGP 4X,
32MB SDRAM 49

PixelView GeForce FX 5200 ultra,
128MB DDR 4ns, GPU 250MHz,
RAM Clock 500MHz, TV-out, DVI Port 88
PixelView GeForce FX5600tv,
128MB DDR, 3,6ns, GPU400MHz,
RAM550MHz, TV-out, DVI Port 155
PixelView GeForce FX 5600 Vivo, 128MB
DDR, GPU 400MHz, RAM 550MHz 160

PixelView GeForce 5600 Ultra,
256MB 3,3ns, GPU 325MHz, DVI port 190
PixelView GeForce FX 5900
256MB DDR II, 2,2ns, GPU 400Mhz 460
PixelView FX5800, AGP8X, DDRII,
VIVO, DVI 355
PixelView FX5600H, AGP8X,
DDR 3,5ns, VIVO, DVI 195
PixelView FX5600, AGP8X,
128MB DDR, 3,6ns, DVI, VIVO 175
PixelView FX5200ut, AGP8X,
128MB DDR, TV OUT, DVI 88

MSI G4 MX440SET, AGP4X,
64MB SDR, TV OUT 46
MSI G4MX440 T8X, AGP4X,
64MB SDR, TV OUT 50
MSI MX440-TD8X, AGP8X,
64MB DDR, DVI, TV OUT, DUAL CRT 42
MSI Ti4200-TD8X64, AGP8X,
64MB DDR, DVI 150
MSI FX5200-T128, AGP8X,
128MB DDR, DVI, VIDEO IN, TV OUT 89
MSI FX5200-TDR128, 128MB DDR,
DVI, VIDEO IN, TV OUT 120
MSI FX5600-VTDR256, AGP8X,
256MB DDR, DVI, VIDEO IN, TV OUT 250

Gainward GF4MX440, 64MB,
5.0ns DDR, AGP8X, TV OUT 46
Gainward GeForce FX 5200,
128MB, 4.0ns DDR, AGP8X, TV OUT 72
Gainward GeForce FX 5600, 128MB,
ULTRA FAST DDR, AGP 8X, TV OUT 135
Gainward GeForce FX 5600, 256MB,
ULTRA FAST DDR, AGP 8X, TV OUT 165
Gainward GeForce FX5900, 128MB,
ULTRA FAST DDR, AGP 8X,
TV OUT, VIVO 385
Gainward GeForce FX5900, 256MB,
ULTRA FAST DDR, AGP 8X,
TV OUT, VIVO 450

Elsa Quadro FX2000, 128MB DDR II,
AGP 8X VIVO, DVI-I 1558
Elsa Quadro FX1000, 128MB DDR II,
AGP 8X, DVI-I 1006
Elsa Quadro FX500, 128MB DDR,
AGP8X, DVI-I 335
Elsa Gladiac FX930, GeForce FX5800,
128MB, AGP8X, VIVO, DVI-I 370
Elsa Gladiac FX732, GeForce FX5600,
128MB, AGP8X, VO, DVI-I 178
Elsa Gladiac FX534, GeForce FX5200,
64MB, AGP8X, VO, DVI-I 107
Elsa Gladiac 528 (VIVO), GF4 Ti4200,
AGP8X, 128MB DDR, VIVO 161
Elsa Gladiac 518, GF4 MX440,
AGP8X, 64MB DDR, TVO 62
Elsa Gladiac 517SEP, GF4 MX440,
64MB DDR, TVO 53
Elsa Falcox 980FX-256, Radeon 9800,
256MB VO, DVI 456
Elsa Falcox 980FX-128, Radeon 9800,
128MB VO, DVI 347
Elsa Falcox 960FXPRO-128MB, Radeon
9600, 128MB, VO DVI 211
Elsa Falcox 960FX-128, Radeon 9600,
128MB, VO DVI 150
Elsa Falcox 920FX-128, Radeon 9200,
128MB, VO DVI 100
Elsa Falcox 920SE-64MB, Radeon 9200,
64MB, VO DVI 65

Sapphire Radeon 9200SE-D64,
64MB DDR, TVI, AGP8X 61

Sapphire Radeon 9200 D64, 64MB
DDR,TVO, AGP8X 71
Sapphire Radeon 9200 D128,
128MB DDR, VIVO, AGP8X 109
Sapphire Radeon 9600 D-128,
128MB, DVI, VIVO, AGP8X 145
Sapphire Radeon 9800Pro D-128,
128MB DDR, DVI, AGP8X 470
Sapphire Radeon 9800Pro D256,
256MB DDRII, DVI, AGP8X 551

DigiColor TNT2/M64 nVIDIA,
32 MB SDR, CRT 24
DigiColor GF2 MX400 nVidia,
64 MB SDR, CRT 34
DigiColor GF4 MX440se nVidia LMA II,
64 MB 128-bit DDR 350 Mhz,
CRT+TV out 49
DigiColor GeForce FX5200,
nVidia LMA II, 64 MB 128-bit,
CRT, TV out                               80
DigiColor GeForce FX5600
nVidia LMA II, 128 MB 128-bit DDR,
Tv- out 160
DigiColor GeForce FX5600
nVidia LMA II 256MB 128-bit DDR,
TV-out                                     19

Impact mx440 64mb DDR,
AGP8X tv out 47
Impact Ti4200 64mb, tv out,dvi 130
Impact Ti4200 128mb, AGP 8X,
128ddr tv out,dvi,vivo 155
Impact GeForceFX5200 128MB DDR,
tv out,dvi,vivo, AGP8X 80

Gigabyte R9600 Pro, radeon 9700pro,
TV-out S/RCA, DVI port DVI-I,
twin view 137
Gigabyte R9800 Pro , radeon 9500,
TV-out S/RCA, DVI port DVI-I,
twin view 407
Gigabyte R9000 Pro,
ATI Radeon 9000Pro, 64MB DDR,
TV-out, S-Video, Twin View, DVI Port 97
Gigabyte R9000, ATI Radeon 9000,
64MB,  DDR, TV-out 67
Gigabyte R9600 Pro,
ATI Radeon 9600 Pro, 128MB DDR 192
Gigabyte R-9800 Pro, Radeon 9800Pro,
380MHz/ 680MHz, 256MB 522
Gigabyte R-9200 (VIVO), Radeon 9200,
250MHz/ 400MHz, 128MB 117

Gigacube Radeon 9800 Pro 256MB 550
Gigacube Radeon 9800 Pro 128MB 440
Gigacube Radeon 9700 Pro 128MB 340
Gigacube Radeon 9600 Pro 128MB 185
Gigacube Radeon 9600  128MB 160
Gigacube Radeon 9200  128MB 98
Gigacube Radeon 9100  128MB 85
Gigacube Radeon 9000  64MB 60

CD-RW DRIVE

Samsung CD ROM 52X 18

Aopen CD-ROM 56X OEM 23
Aopen CD-RW3248 32x12x48 50
Aopen CD-RW4850 48x12x50x 80
Aopen CD_RW 40x12x48 box 60
Aopen external
CD-RW 40x12x48 box 135

Gigabyte  CD ROM 52X 26

MSI CD-ROM C-52 20
MSI CR-52M, 52x32x52 48
MSI CRE-52M CD-RW external 120

Mitsumi CD-ROM 54x 22
Mitsumi CD-RW 48x24x48 48

Asus CD-RW external 5224
A-U (USB) 52x24x52 100
Asus external slim combo
SCB 2408-D 210
Asus CRW 5224A, 52x24x48 48

TDK CDRW 52x24x48 D
second edition black 50
TDK CDRW 52x24x48 D
second edition white 48
TDK CDRW 48x16x48 USB
External 2.0 115
TDK CDRW 52x24x52 int
IDE loose pack 65
Gigabyte CD-RW 52x32x52 54

Plextor CD RW 52x32x52 Internal IDE 155
Plextor CD RW 24x10x40
external USB slim 175
Plextor CD RW 24x10x40
external USB 120
Plextor CD RW 12x10x32
SCSI external 245
Plextor CD RW Combo DVD
8x8x24 ext USB 2.0 255

Whale CD ROM 56x 17
Whale CD-RW 52x24x52 46

DVDRW

Gigabyte GO-W404A DVDRW (+/-) 210

Pioneer DVD (+/-) RW A06 225

Plextor PX 504A DVD (+)RW
INT IDE 2,4 X 4 200
Plextor PX504UF DVD+RW EXT
firewire + USB 345
Plextor PX708A DVD +/- RW INT
8X4X12/40X24X40 300
Plextor PX708A DVD +/- RW
INT 8X4X12/40X24X40 SC 385
Plextor PX708A DVD +/- RW
INT 8X4X12/40X24X40 FC 400

Aopen DVD-RW Combo
ultra slim, box 290

Asus DVD-R/RW 4X2X12 247

TDK DVD-RW 440 250

MSI DVD combo X-48 80

DVD-ROM

Pioneer 120T 9 (Trayload) 42
Pioneer 120S (slot in) 49

Samsung DVD 16X 30

Sony DVD 16X white 32
Sony DVD 16X Black 34

Asus DVD 16X 43
MSI DVD-ROM 38
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CRACKER:
Kekacauan Apa yang Bisa

Dibuatnya pada Sistem
Komputer

Restituta Ajeng Arjanti
ajeng@e-pcplus.com

H

Kesalahan pengertian
istilah hacker sebagai
orang yang merusak

sistem komputer
sudah berlangsung

cukup lama.
Kesalahan tersebut

bahkan juga banyak
dilakukan oleh media.

acker
sebenarnya
adalah sebutan bagi
orang-orang kreatif

yang menyukai segala hal
berbau komputer. Mereka suka
mengoprek komputer atau
sistem keamanannya, tetapi
tidak merusaknya. Mereka
melakukannya karena
penasaran. Berbeda dengan
hacker, cracker menyusup ke
dalam sistem komputer untuk
merusak. Cracker bisa juga
disebut sebagai hacker kriminal.

CRACKER DAN ULAHNYA
Komputer yang selalu nyala

dan terhubung ke Internet
melalui kabel adalah sasaran
utama cracker. Cracker bisa
memperoleh informasi
mengenai hardware sistem
sebelum melakukan
serangannya.

Cracker masih jarang
menyerang PC rumahan.
Biasanya, mereka adalah orang

yang obsesif, mereka lebih
senang menangkap
‘umpan’ yang besar, seperti
sistem lembaga
pemerintahan atau
perusahaan komersil.
Tetapi hal ini bukan berarti
para pengguna PC
rumahan bisa lengah.
Cracker selalu mencari
alamat IP dari komputer-
komputer yang terdaftar
dalam Internet Service
Provider (ISP), yang
terhubung ke Internet
melalui kabel, dial-up, atau
DSL (Digital Subscriber
Lines). Beberapa cracker
secara teratur memeriksa
alamat-alamat tersebut
untuk mencari celah-celah
keamanannya.

Apakah cracker bisa
mengakses file internal dari
sebuah komputer? Hal tersebut
mungkin saja terjadi dalam
sistem komputer yang lemah,
atau jika cracker memiliki

password untuk mengakses hard
drive PC tersebut.

CRACKER
DAN TROJAN HORSE

Ada dua macam cracker,
yang aktif dan yang pasif.

Umumnya, cracker yang
aktif adalah yang rajin
‘berburu’ informasi di
Internet.

Sedangkan yang pasif
biasanya sudah memiliki
‘alat’ sendiri untuk
menangkap informasi yang
diincarnya. ‘Alat’ yang
dimaksud di sini adalah
Trojan Horse, aplikasi kecil
yang bisa tinggal dalam
hard drive dan bisa
mengirim ke luar informasi-
informasi di dalamnya
tanpa ijin dari pemilik
komputer.

Trojan seringkali masuk
ke dalam sistem melalui
advertorial yang sering
muncul tiba-tiba saat kita

membuka sebuah situs. Program
jahat ini juga bisa masuk ke
sistem pada saat user men-
download sesuatu dari situs yang
telah korup – contohnya, situs
yang menawarkan software
gratisan atau file-file musik dan

video yang bisa di-share dalam
jaringan P2P (peer-to-peer).

Trojan biasanya sudah
dilengkapi dengan keystroke
loggers – program yang bisa
mencatat apa saja yang telah
diketikkan pada keyboard.
Aplikasi ini biasanya
dimanfaatkan cracker untuk
memperoleh password sistem.

FIREWALL
Walaupun PC rumahan

bukan target utama serangan,
kemungkinan untuk diserang
selalu ada. Karena itu, seperti
biasa, setiap artikel yang
berhubungan dengan
keamanan komputer selalu
diakhiri dengan anjuran
penggunaan firewall. Sebagai
tambahan dari hardware
firewall, yang biasanya sudah
termasuk dalam modem kabel
atau DSL router, pengguna
komputer juga harus menginstal
software firewall.

Firewall juga bisa
melindungi komputer dari
serangan ‘kuda-kuda’ Trojan
yang bisa mengirim ke luar
data-data personal, seperti
spesifikasi hardware, yang ada
di komputer.

Hal terbaik yang bisa
dilakukan untuk melindungi
keamanan komputer kita adalah
dengan rajin meng-update
aplikasi-aplikasi dalam sistem
dan selalu mengaktifkan
software antivirus dan firewall
dalam komputer.  PC+

Hacker dan cracker, sama-sama kreatif dan
suka mengoprek komputer. Cracker mencuri
informasi penting dari sistem dan
menggunakan keahliannya untuk merusak
dengan cara yang tak terduga.
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